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Technická podpora Bio-Rad
Oddělení technické podpory Bio-Rad je v USA k dispozici od pondělí do pátku od 5:00 do 17:00 hodin
(pacifický čas).

Telefon: 1-800-424-6723, volba 2

E-mail: Support@bio-rad.com (pouze USA/Kanada)

Pro technickou pomoc mimo USA a Kanadu se obraťte na místní technickou podporu, nebo klikněte
na odkaz www.bio-rad.com.

Upozornění
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BIO-RAD je ochranná známka společnosti Bio-Rad Laboratories, Inc.

BIO-RAD, HARD-SHELL a MICROSEAL jsou ochranné známky společnosti Bio-Rad Laboratories,
Inc. v určitých jurisdikcích.

SYBR je ochranná známka společnosti Thermo Fisher Scientific Inc. Bio-Rad Laboratories, Inc. je
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Všechny ochranné známky použité v této publikaci jsou majetkem příslušných vlastníků.
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Účel použití

Účel použití
Systémy CFX96 Dx a CFX96 DeepWell Dx se softwarem CFXManager Dx jsou určeny k provádění
fluorescenční PCR pro detekci a kvantifikaci sekvencí nukleové kyseliny. Systémy a software jsou
určeny k diagnostickému použití in vitro vyškolenými laboratorními techniky. Systémy by se měly
používat s diagnostickými testy nukleové kyseliny třetích stran, vyrobenými a označenými k
diagnostickým účelům.

Použité symboly
Důležité: Důležité změny jsou zvýrazněné!

Výrobce Číslo šarže

Spotřebujte do
Pro diagnostické použití in

vitro

Teplotní limit Katalogové číslo

Viz návod k použití Počet testů

Pro použití s Sériové číslo

Pouze na předpis Obsahuje latex
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Označení CE – nařízení (EU) 2017/746 o
diagnostických zdravotnických

prostředcích in vitro

Překlady
Dokumenty k produktu mohou být k dispozici v jiných jazykových mutacích na elektronických médiích.
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Bezpečnost a shoda s předpisy
Pro bezpečný provoz systému CFX96 Dx nebo CFX96 DeepWell Dx se softwarem CFXManager Dx,
označovaného v tomto dokumentu jako systém Systém CFX Dx, společnost Bio-Rad důrazně
doporučuje dodržovat bezpečnostní specifikace uvedené v této kapitole a v celém tomto návodu.

Důležité: Systémy CFX96 Dx a CFX96 DeepWell Dx jsou schváleny pro použití jako in vitro
diagnostické (IVD) zdravotnické prostředky.

Bezpečnostní výstražné štítky
Výstražné štítky umístěné na přístroji a v této příručce vás upozorňují na možné zdroje zranění nebo
poškození. Tabulka 1 popisuje každý bezpečnostní výstražný štítek.

Ikona Význam

Výstražné upozornění na nebezpečí poškození těla nebo zařízení
Provozování systému CFX Dx bez seznámení se s touto příručkou může
představovat nebezpečí úrazu. Z bezpečnostních důvodů tento přístroj nepoužívejte
způsobem, který není uveden v této příručce. Toto zařízení smí obsluhovat pouze
kvalifikovaný laboratorní personál vyškolený k bezpečnému používání elektrických
zařízení. Se všemi částmi systému manipulujte vždy opatrně a vždy mějte čisté,
suché ruce.

Výstražné upozornění na zacházení s biologicky nebezpečnými
materiály
Při manipulaci s biologicky nebezpečnými vzorky dodržujte doporučená
bezpečnostní opatření a pokyny a dodržujte místní předpisy specifické pro vaši
laboratoř a pracoviště.

Výstražné upozornění na nebezpečí popálení
Termocykler vytváří dostatek tepla, aby způsobil vážné popáleniny. Během provozu
vždy používejte ochranné brýle nebo jinou ochranu očí. Před otevřením víka a
vyjmutím vzorků vždy nechte blok vzorku vychladnout. Vždy zachovávejte
maximální vzdálenost, aby nedošlo k náhodnému popálení kůže.

Tabulka 1. Význam bezpečnostních výstražných štítků
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Bezpečnost a shoda s předpisy

Ikona Význam

Výstražné upozornění na nebezpečí výbuchu
Bloky se vzorky mohou být za normálního provozu tak horké, že se kapaliny začnou
vařit a mohou explodovat.

Specifikace pro bezpečné používání a shoda s předpisy
Tabulka 2 obsahuje specifikace pro bezpečné používání systému Bio-Rad CFX Dx pro detekci PCR v
reálném čase. Aby se zajistila shoda s limity FCC pro třídu A, musejí se s těmito přístroji používat
dodávané stíněné kabely.

Aspekty použití Podmínky bezpečného použití

Jmenovitý příkon 100–240 V AC, 50–60 Hz, 850Wmax.

Kategorie přepětí II

Pojistky 10 A, 250 V, 5 × 20 mm, rychlý typ (počet: 2)

Prostředí Pouze pro použití v krytých prostorech

Teplota pro použití 15–31 °C

Skladovací teplota −20 až 60 °C

Relativní vlhkost Až 80 % (nekondenzující)

Nadmořská výška Až 2000 m n. m.

Stupeň znečištění 2

Tabulka 2. Podmínky bezpečného použití

Shoda s předpisy
Systém detekce PCR v reálném čase CFX Dx byl testován a shledán v souladu se všemi příslušnými
požadavky následujících bezpečnostních a elektromagnetických norem:

n IEC 61010-1:2010 (3. vyd.), EN61010-1:2010 (3. vyd.). Elektrické zařízení pro měření, kontrolu a
laboratorní použití – Část 1: Všeobecné požadavky

n IEC 61010-2-010:2014, EN 61010-2-010:2014. Bezpečnostní požadavky na elektrická zařízení
pro měření, regulaci a laboratorní použití. Část 2-010: Zvláštní požadavky na laboratorní
vybavení pro ohřev materiálů
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Rizika

n IEC 61010-2-081:2015, EN 61010-2-081:2015. Bezpečnostní požadavky na elektrická zařízení
pro měření, regulaci a laboratorní použití. Část 2-081: Zvláštní požadavky na automatické a
poloautomatické laboratorní vybavení pro účely analýzy a jiné účely (včetně Dodatku 1)

n IEC 61010-2-101:2015 (2. vyd.). Bezpečnostní požadavky na elektrická zařízení pro měření,
regulaci a laboratorní použití. Zvláštní požadavky na in vitro diagnostické (IVD) zdravotnické
vybavení

n IEC 61326-1:2012 (třída A), EN 61326-1:2013 (třída A). Elektrická zařízení pro měření, kontrolu a
laboratorní použití. Požadavky na EMC, Část 1: Všeobecné požadavky

n IEC 61326-2-6:2012, EN 61326-2-6:2013 (třída A). Elektrická zařízení pro měření, kontrolu a
laboratorní použití. Požadavky EMC. Zvláštní požadavky na in vitro diagnostické (IVD)
zdravotnické vybavení

Důležité: Toto zařízení generuje, používá a může vyzařovat vysokofrekvenční energii, a pokud
není instalováno a používáno v souladu s poskytnutou instruktážní dokumentací, může způsobit
škodlivé rušení rádiové komunikace. Provoz systémů v obytných zónách pravděpodobně způsobí
škodlivé rušení, v takovém případě bude uživatel muset toto rušení na vlastní náklady odstranit.

Rizika
Systém detekce PCR v reálném čase CFX Dx je zkonstruován tak, aby fungoval bezpečně a
efektivně, pokud je používán způsobem předepsaným výrobcem. Pokud se systém detekce PCR v
reálném čase CFX Dx nebo kterékoli z jeho součástí používají jiným způsobem než určeným
výrobcem, jeho ochranné mechanismy nemusí fungovat. Společnost Bio-Rad Laboratories, Inc.,
neodpovídá za žádné zranění ani poškození majetku způsobené použitím tohoto zařízení
nespecifikovaným způsobem nebo úpravou přístroje neprovedenou společností Bio-Rad nebo jejím
zplnomocněným zástupcem. Servis systému detekce PCR v reálném čase CFX Dx smí provádět
pouze kvalifikovaný personál společnosti Bio-Rad.

Biologická rizika
Systém CFX Dx pro detekci PCR v reálném čase je laboratorní výrobek. Pokud se však vyskytnou
biologicky nebezpečné vzorky, dodržujte následující pokyny a postupujte podle místních směrnic
platných pro vaši laboratoř a pracoviště.

Poznámka: Během normálního provozu tohoto přístroje se neuvolňují žádné biologicky
nebezpečné látky.
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Bezpečnost a shoda s předpisy

Všeobecná bezpečnostní opatření

n Vždy používejte laboratorní rukavice, plášť a bezpečnostní brýle s bočními kryty nebo ochranné
brýle.

n Nedotýkejte se rukama úst, nosu a očí.

n Všechny řezné rány a odřeniny zcela zakryjte ještě před zahájením práce s potenciálně
infekčními materiály.

n Po práci s potenciálně infekčními materiály si ještě před odchodem z laboratoře pečlivě umyjte
ruce mýdlem a vodou.

n Před zahájením práce na pracovním stole si sundejte náramkové hodinky a šperky.

n Uchovávejte všechny infekční nebo potenciálně infekční materiály v nerozbitných nepropustných
nádobách.

n Před opuštěním laboratoře si sundejte ochranný oděv.

n V rukavicích nepište, neberte telefony, nerozsvěcejte světla a nedotýkejte se předmětů, kterých
se ostatní lidé mohou dotýkat bez rukavic.

n Rukavice často měňte. Sejměte je okamžitě, pokud jsou viditelně kontaminovány.

n Nevystavujte látky, u kterých nelze provést řádnou dekontaminaci, potenciálně infekčním látkám.

n Po dokončení práce s biologicky nebezpečnýmmateriálem dekontaminujte pracovní plochu
vhodným dezinfekčním prostředkem (např. v domácnosti používaným dezinfekčním přípravkem
naředěným v poměru 1:10).

Specifická bezpečnostní opatření pro IVD

n Všechny pacientské vzorky jsou potenciálním biologickým rizikem a podle toho se s nimi musí
zacházet při dodržování všeobecných bezpečnostních opatření.

n Během normálního provozu tohoto přístroje se neuvolňují žádné biologicky nebezpečné látky.

Povrchová dekontaminace

VÝSTRAHA! Před prováděním postupů dekontaminace přístroj vždy vypněte a
odpojte od elektrické sítě, aby nedošlo k úrazu elektrickým proudem.

Následující oblasti lze čistit jakýmkoli baktericidním, virucidním nebo fungicidním dezinfekčním
prostředkem nemocniční kvality:

n Vnější kryt a podvozek

18 | Systémy CFX96 Dx a CFX96 DeepWell Dx



Rizika

n Vnitřní povrch reakčního bloku a jamky reakčního bloku

n Ovládací panel a displej

Při přípravě a aplikaci dezinfekčního prostředku postupujte podle pokynů poskytnutých výrobcem
produktu. Po použití dezinfekčního prostředku několikrát opláchněte reakční blok a jamky reakčního
bloku vodou. Po opláchnutí vodou důkladně reakční blok a jamky reakčního bloku vysušte.

Důležité: Nepoužívejte abrazivní nebo korozivní čisticí prostředky nebo silné alkalické roztoky.
Tyto prostředky mohou poškrábat povrchy a poškodit reakční blok, což by vedlo ke ztrátě
přesného tepelného řízení.

Likvidace biologicky nebezpečného materiálu

Následující potenciálně kontaminované materiály likvidujte v souladu s místními a státními předpisy
platnými pro laboratoř:

n klinické vzorky;

n reagencie;

n použité reagenční nádobky nebo jiné spotřební materiály, které mohou být kontaminované.

Chemická rizika
Systém CFX Dx detekce PCR v reálném čase neobsahuje žádné potenciálně nebezpečné chemické
materiály.

Rizika spojená s výbušností nebo hořlavostí
Systém CFX Dx pro detekci PCR v reálném čase nepředstavuje žádná neobvyklá nebezpečí z
hlediska hořlavosti nebo výbuchu, pokud je správně používán tak, jak je stanoveno společností Bio-
Rad Laboratories.

Rizika spojená s elektrickým proudem
Při práci se systémem CFX Dx pro detekci PCR v reálném čase nehrozí obsluze žádná mimořádná
rizika spojené s elektrickým proudem, pokud se systém nainstaluje a obsluhuje správně bez
provedení fyzické úpravy a pokud se připojí ke zdroji elektrického proudu o náležité specifikaci.
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Bezpečnost a shoda s předpisy

Doprava
Před přesunutím nebo přepravou systému CFX Dx pro detekci PCR v reálném čase nebo jeho
optického reakčního modulu či základny pro termocykler je nutné provést postupy dekontaminace.
Systém CFX Dx pro detekci PCR v reálném čase a optické reakční moduly vždy přesouvejte nebo
přepravujte v samostatných kontejnerech s dodaným obalovýmmateriálem, který přístroj ochrání před
poškozením. Pokud nemáte vhodné kontejntery k dispozici, obraťte se na místní pobočku společnosti
Bio-Rad.

Baterie
Termocykler Systém CFX Dx používá lithium kovovou knoflíkovou baterii 3 V a nikl metalový
hydridový akumulátor 4,8 V pro zachování nastavení času a provozních dat v případě výpadku
střídavého proudu. Pokud po vypnutí jednotky nezůstane nastaven čas nebo provozní data, může to
znamenat, že baterie jsou již slabé. Pokud k tomu dojde, kontaktujte technickou podporu společnosti
Bio-Rad pro pomoc.

Nepokoušejte se baterie sami vyměnit. Kontaktujte technickou podporu společnosti Bio-Rad.

Likvidace
Systém detekce PCR v reálném čase CFX Dx obsahuje elektrické materiály; ty nesmí být zlikvidovány
jako netříděný odpad a musí být shromažďovány odděleně podle směrnice Evropské unie
2012/19/EU o odpadních elektrických a elektronických zařízeních – směrnice OEEZ. Před likvidací se
obraťte na místního zástupce společnosti Bio-Rad a požádejte o informace o pokynech pro vaši zemi.

Záruka
Na systém detekce PCR v reálném čase CFX Dx a jeho příslušenství se vztahuje standardní záruka
Bio-Rad. Podrobnosti o záruce získáte v místní pobočce společnosti Bio-Rad.
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Kapitola 1 Úvod
Systémy pro amplifikaci PCR v reálném čase CFX Dx společnosti Bio-Rad určené k in vitro
diagnostice (IVD) odpovídají nejnovějšímu technickému pokroku a umožňují kvantifikaci PCR se
standardní křivkou, analýzou exprese genu, alelickou diskriminací a analýzou koncových bodů.

Systémy CFX Dx jsou tvořeny dvěma hardwarovými moduly a softwarem:

n Modul optické reakce CFX96 Dx nebo CFX96 DeepWell Dx (ORM)

n Termocykler C1000 Dx

n Software CFX Manager Dx

Při použití se softwarem CFXManager Dx můžete

n ihned generovat výsledky pomocí Startup Wizard (Průvodce spuštěním);

n zadávat nebo upravovat informace o jamkách před cyklem, během něj i po něm;

n interpretovat komplexní data a udělat si dokonalý obrázek o své studii exprese genu díky
nástrojům, jako například analýza kontrol PrimePCR a nástroj pro výběr referenčního genu;

n sestavovat komplexní hlášení obsahující data PCR v reálném čase.

Systémy detekce PCR CFX Dx
Tabulka 3 obsahuje seznam výrobků pro IVD detekci PCR společnosti Bio-Rad dodávaných s
přístrojem Systém CFX Dx.

Poznámka: Systém CFX Dx je dodáván se softwarem CFXManager Dx, termocyklerem C1000
Dx a modulem optické reakce CFX96 Dx nebo CFX96 DeepWell Dx.

Katalogové číslo Popis

1845097-IVD CFX96 Dx ORM *

1844095-IVD CFX96 DeepWell Dx ORM

1841000-IVD Termocykler C1000 Dx

12007917 Software CFX Manager Dx v3.1

Tabulka 3. Systémy IVD detekce PCR CFX

* Optický reakční modul

Návod k použití | 21



Kapitola 1 Úvod

Určené použití
Systémy CFX96 Dx a CFX96 DeepWell Dx se softwarem CFXManager Dx jsou určeny k provádění
fluorescenční PCR pro detekci a kvantifikaci sekvencí nukleové kyseliny. Systémy a software jsou
určeny k diagnostickému použití in vitro vyškolenými laboratorními techniky. Systémy by se měly
používat s diagnostickými testy nukleové kyseliny třetích stran, vyrobenými a označenými k
diagnostickým účelům.

Kde najít více informací
Tento dokument vysvětluje, jak bezpečně nastavit a používat systémy CFX96 Dx a CFX96
Deep Well Dx pro detekci PCR v reálném čase, které jsou označeny značkou CE-IVD. Tyto systémy
jsou v tomto dokumentu označovány jako Systém CFX Dx. Vedle toho tento dokument vysvětluje, jak
se systémem Systém CFX Dx používat software Software CFX Manager Dx.

Tip: Pro otevření internetových stránek společnosti Bio-Rad klikněte na logo Bio-Rad v pravém
horním rohu libovolného okna Software CFX Manager Dx. Tyto stránky obsahují odkazy na
technické poznámky, návody, informace o výrobcích a technickou podporu. Na stránkách rovněž
najdete mnoho technických zdrojů týkajících se různých metod a aplikací souvisejících s PCR,
PCR v reálném čase a expresí genu.
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Kapitola 2 Nastavení termocykleru C1000 Dx
Tato kapitola vysvětluje, jak nastavit termocykler systémů Systém CFX DxC1000 Dx na vašem
pracovišti.

Tip: Než budete termocykler nastavovat, se seznamte s termocyklerem a jeho optickým
reakčním modulem, porty a příslušenstvím.

Požadavky na pracoviště
Tabulky v této kapitole obsahují seznam požadavků na místnost, prostředí a napájení nezbytných pro
úspěšnou instalaci a používání termocykleru Systém CFX Dx.

Poznámka: Umístěte svůj termocykler Systém CFX Dx na rovný, suchý povrch s dostatečným
prouděním chladného vzduchu, abyste zajistili jeho správný provoz.

Požadavky na stolní prostor

Položka Specifikace

Příkon Maximálně až 850W

Frekvence 50–60 Hz, jedna fáze

USB porty 5 A, 1 B

Rozměry Š: 13"; 33 cm

H: 18"; 46 cm

V: 14"; 36 cm

Hmotnost 47 lb; 21 kg

Tabulka 4. Požadavky na stolní prostor pro termocykler Systém CFX Dx
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Kapitola 2 Nastavení termocykleru C1000 Dx

Požadavky na prostředí

Parametr Rozsah Rozsah vlhkosti

Provozní podmínky 15–31 °C

59–87,8 °F

Relativní vlhkost 0–80 %,
nekondenzující

Skladovací podmínky 15–31 °C

59–87,8 °F

Relativní vlhkost 0–80 %,
nekondenzující

Tabulka 5. Požadavky na prostředí pro termocykler Systém CFX Dx

Požadavky na elektrické napájení
Napájení termocykleru Systém CFX Dx musí být stabilní a musí odpovídat specifikacím, aby byl
zajištěn řádný provoz. Napájecí kabel připojený do napájecího přívodu musí mít jmenovitou hodnotu 7
A nebo více.

Položka Specifikace

Síťové vstupní napětí 100–240 V AC; 50–60 Hz, jedna fáze

Maximální spotřeba energie <850W

Počet napájecích zásuvek Minimálně 2 zásuvky:

n 1 zásuvka pro termocykler

n 1 zásuvka pro počítač se softwarem CFX Manager Dx

Tabulka 6. Požadavky na elektrické napájení Systém CFX Dx
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Přehled systému

Přehled systému
Obrázky v této části zobrazují hlavní komponenty základny termocykleru C1000 Dx.

Čelní pohled

1. Optický reakční modul – obsahuje optický systém pro sběr fluorescenčních dat a bloku
termocykleru. Systémy detekce PCR v reálném čase CFX Dx podporují modul CFX96 Dx
nebo CFX96 DeepWell Dx.

2. Stavová LED kontrolka – signalizuje, že se blok právě používá.

3. Tlačítko víka – otevírá nebo zavírá víko optického reakčního modulu a uzavírá reakční
komoru.

4. Základna termocykleru C1000 Dx –poskytuje systémový výkon a komunikaci a obsahuje
optické reakční moduly CFX96 Dx a CFX96 DeepWell.

5. Displej a tlačítka na předním panelu – umožňuje ovládání systému v samostatném
režimu.

Důležité: Aby byla zajištěna integrita dat studie genů IVD, software CFX Manager Dx
nepodporuje data vygenerovaná termocyklerem v samostatném režimu.

6. Vyhřívané vnitřní víko – udržuje teplotu víka, aby nedocházelo ke kondenzaci a
vypařování.

7. Blok na vzorky/reakční blok – umísťují se do něj reakční nádobky, včetně zkumavek a
mikrodestiček.

LEGENDA
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Kapitola 2 Nastavení termocykleru C1000 Dx

Zadní pohled

1. Eternetový port – připojuje termocykler C1000 Dx k vaší síti.

2. Port USB typu B – připojuje termocykler C1000 Dx k počítači se softwarem CFXManager
Dx.

3. Porty USB typu A – k přenosu dat na jednotku USB flash a z této jednotky.

Důležité: Aby byla zajištěna integrita dat studie genů IVD, software CFX Manager Dx
nepodporuje data vygenerovaná termocyklerem v samostatném režimu.

4. Sériový testovací port – pouze pro servisní testování.

5. Chladicí otvory – chladí termocykler.
Důležité: Nezakrývejte chladicí otvory. Pro optimální provoz zajistěte, aby za
základnou termocykleru mohl cirkulovat vzduch.

6. Vstup napájení – střídavý proud; použijte dodaný napájecí kabel.

7. Vypínač – kolébkový spínač pro zapnutí a vypnutí termocykleru.

8. Pojistky – technické údaje o pojistkách naleznete v části Specifikace pro bezpečné
používání a shoda s předpisy na straně 16.

LEGENDA
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Optické reakční moduly

Optické reakční moduly
Termocykler C1000 Dx je kompatibilní s následujícími optickými reakčními moduly společnosti Bio-
Rad pro detekci PCR v reálném čase.

n Optický reakční modul CFX96 Dx

n Optický reakční modul CFX96 DeepWell Dx

Vybraný optický reakční modul CFX Dx a termocykler jsou dodávány v samostatných baleních.
S optickým reakčním modulem je dodáván i software CFX Manager Dx.

Důležité: Optický reakční modul je kalibrován pro základnu termocykleru, se kterou je dodáván.
Proto nepoužívejte optický reakční modul s jinou základnou termocykleru a naopak základnu
termocykleru s jiným optickým reakčním modulem.

Součástí obou optických reakčních modulů je plně nastavitelné vyhřívané víko, které lze spolehlivě
použít s širokým spektrem reakčních nádobek. Každý optický reakční modul má v sobě chladicí
ventilátory pro rychlý ohřev a chlazení.

Každý optický reakční modul CFX Dx je tvořen těmito komponenty:

n Vyhřívané vnitřní víko – udržuje teplotu víka, aby nedocházelo ke kondenzaci a vypařování.

n Blok na vzorky / reakční blok – umísťují se do něj reakční nádobky, včetně zkumavek a
mikrodestiček.

n Tlačítko víka – otevírá a zavírá víko a utěsňuje reakci.

n Stavová LED kontrolka – pokud svítí, signalizuje, že se blok právě používá.

Doporučené objemy vzorků
Když používáte termocykler C1000 Dx, je maximální objem vzorku určen typem použitého reakčního
modulu. Tabulka 7 uvádí doporučené objemy pro každý reakční modul.

Počet jamek Počet bloků
Doporučené objemy vzorků, µl

(Horní limit)

96jamkový 1 10–50

96jamkový, hluboké 1 10–125

Tabulka 7. Limit velikosti a objemu reakčních modulů
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Kapitola 2 Nastavení termocykleru C1000 Dx

Instalace termocykleru C1000 Dx
Základna termocykleru C1000 Dx se dodává v samostatné krabici oddělené od optického reakčního
modulu. Balení obsahuje:

n Termocykler C1000 Dx se základnou

n Přívodní šňůra

n 1 kabel USB

Instalace termocykleru C1000 Dx:

1. Rozbalte a nastavte termocykler C1000 Dx se základnou.

2. Připojte rekční modul k základně.

3. Odstraňte zajišťovací šroub.

Tato část podrobně vysvětluje tyto úkoly.

Rozbalení a usazení termocykleru C1000 Dx
Důležité: Před použitím termocykleru si přečtěte informace v Bezpečnost a shoda s předpisy na
straně 15 a Bezpečnostní výstražné štítky na straně 15.

Tip: Při usazování se ujistěte, že máte okolo termocykleru dostatek prostoru na počítač, na
kterém poběží software CFX Manager Dx.

Jak rozbalit a usadit termocykler se základnou

1. Najděte krabici se základnou termocykleru.

2. Vyjměte základnu z obalu.

Tip: Uchovejte obal pro budoucí použití. Pokud vám nějaká položka chybí nebo je
poškozena, obraťte se na místní pobočku společnosti Bio-Rad.

3. Umístěte základnu termocykleru na rovný, suchý povrch s dostatečným prouděním chladného
vzduchu, abyste zajistili její správný provoz.

4. Najděte v obalu napájecí šňůru a připojte jeden její konec do napájecí zdířky na zadní straně
termocykleru.

Důležité: V tuto chvíli ještě přístroj nezapínejte.

5. Připojte k základně IVD modul reakce. Přejděte na Připojení optického reakčního modulu na
straně 29.
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Instalace termocykleru C1000 Dx

Připojení optického reakčního modulu
Společnost Bio-Rad dodává optický reakční modul CFX96 Dx nebo CFX96 DeepWell se základnou
termocykleru C1000 Dx (dodává se ve zvláštní bedně). Opatrně rozbalte optický reakční modul a
ověřte, že se napájecí a USB kabely nacházejí uvnitř přepravního kontejneru.

Důležité: Každý optický reakční modul je kalibrován pro základnu termocykleru, se kterou je
dodáván. Proto nepoužívejte optický reakční modul s jinou základnou termocykleru.

Zajistěte, aby základna termocykleru C1000 Dx spočívala na rovném, suchém povrchu s dostatečným
proudem chladného vzduchu, aby mohla správně fungovat.

Připojení reakčního modulu k základně termocykleru

1. Umístěte termocykler C1000 Dx na vhodné místo s aretační lištou dolů.

2. Zvednutím optického reakčního modulu pomocí výřezů po stranách nad boční ventilační otvory a
umístěte modul do oddílu pro reakční modul C1000 Dx a ponechte v prostoru asi 2 cm volného
místa. Po umístění by měl optický modul zakrývat logo Bio-Rad na přední straně oddílu.
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Kapitola 2 Nastavení termocykleru C1000 Dx

3. Táhněte za aretační tyč nahoru, dokud není v jedné rovině se stranami oddílu pro modul. Tato
akce přesune modul dopředu a zamkne jej na místě.

4. Zkontrolujte, zda je modul zcela a v rovné poloze usazen v základně termocykleru C1000 Dx.
Mezi modulem a základnou by neměl být žádný další prostor.

5. Zapojte napájecí šňůru do zadní části základny termocykleru C1000 Dx a do příslušné elektrické
zásuvky a poté stiskněte spínač napájení na zadním panelu termocykleru C1000 Dx a spusťte
systém.

Odstranění zajišťovacího šroubu
Důležité: Optické reakční moduly společnosti Bio-Rad jsou dodávány s červeným zajišťovacím
šroubem ve vnitřním víku, který stabilizuje optický reakční modul během přepravy. Před použitím
optického reakčního modulu je nutné zajišťovací šroub vyjmout.

Jak odstranit zajišťovací šroub

1. Termocykler C1000 Dx rozpozná přítomnost zajišťovacího šroubu v optickém reakčním modulu a
zobrazí hlášení s pokynem k odstranění tohoto šroubu.
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2. Při odstraňování zajišťovacího šroubu postupujte podle pokynů. Následující obrázek ukazuje
polohu zajišťovacího šroubu.

Poznámka: Pokud budete muset z libovolného důvodu reakční modul vrátit, musíte
zajišťovací šroub znovu upevnit na toto místo. Uchovávejte šroub na bezpečném a
přístupnémmístě.

Zakládání destiček se vzorky
Pro zajištění rovnoměrného ohřevu a chlazení vzorků musí být destičky v plném kontaktu s reakčním
blokem. Chcete-li zajistit odpovídající kontakt, postupujte následovně:

n Před vložením vzorků zkontrolujte, zda je blok čistý.

n Jednotlivé zkumavky, proužky se zkumavkami nebo mikrodestičky pevně zatlačte do jamek
bloku.

n Při použití jedné nebo několika zkumavek použijte rám na zkumavky (katalogové č. 1849000
nebo č. 1849001) nebo nasaďte alespoň jednu prázdnou zkumavku do každého rohu bloku,
abyste zajistili rovnoměrný tlak na jednotlivé zkumavky.
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Zakládání destiček do optického reakčního modulu

Důležité: Při spuštění Systém CFX Dx vždy vyvažujte proužky se zkumavkami nebo přidávejte
uzávěry zkumavek do rohových jamek, abyste zajistili rovnoměrný tlak vyhřívaného víka po
celém bloku.

Jak zakládat destičky do optického reakčního modulu

1. Otevřete motorizované víko jedním z následujících způsobů:

n V podokně Detected Instruments (Detekované nástroje) softwaru CFX Manager Dx klikněte
na položku Open Lid (Otevřít víko).

n Na kartě Start Run (Spustit cyklus) softwaru klikněte na položku Open Lid (Otevřít víko).

n Stiskněte tlačítko víka na přední straně přístroje.

2. Umístěte mikrodestičku, jednotlivé zkumavky nebo proužky se zkumavkami s utěsněnými víky do
bloku.

Důležité: Ujistěte se, že jsou zkumavky zcela utěsněné, aby nedošlo k úniku materiálu.

Tip: Pro optimální výsledky založte vzorky o objemu 10–25 µl pro Systém CFX Dx.

3. Pro přesnou analýzu dat ověřte, že orientace reakcí v bloku přesně odpovídá orientaci obsahu
jamek na kartě Plate (Destička) softwaru CFX Manager Dx.

Tip: Obsah jamek můžete upravovat pomocí softwaru CFX Manager Dx před cyklem, během
něho i po něm.

4. Uzavřete motorizované víko jedním z následujících způsobů:

n Stiskněte tlačítko víka na přístroji.

n V podokně Detected Instruments (Detekované nástroje) softwaru klikněte na položku Close
Lid (Zavřít víko).

n Na kartě Start Run (Spustit cyklus) softwaru klikněte na položku Close Lid (Zavřít víko).

Důležité: Dbejte na to, aby při zavírání nebylo víko ničím blokované. Ačkoliv je začleněn
bezpečnostní mechanismus, který při zjištění překážky zabrání zavření víka, nenechávejte
na trase víka před uzavřením žádné předměty.
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Spotřební materiál pro PCR – plastové díly a reagencie

Pokud chcete najít a objednat doporučené plastové díly a spotřební materiály pro systém CFX Dx,
jděte na internetové stránky společnosti Bio-Rad. Na tyto stránky se dostanete z položek nabídky
Help > PCR Plastic Consumables Web Site (Nápověda > Internetové stránky s plasty a spotřebními
materiály pro PCR) v softwaru CFX Manager Dx. Dále vám se snadným výběrem a objednáním
spotřebního materiálu a reagencií pro vaše konkrétní zařízení a potřeby PCR pomůže nástroj pro
výběr plastových dílů a nástroj pro výběr reagencií.

Detekce připojených přístrojů
Při instalaci instalátor softwaru Software CFX Manager Dx automaticky nainstaluje do počítače se
softwarem Software CFX Manager Dx ovladače přístroje. CFX Manager Dx po spuštění softwaru
rozpozná připojené přístroje.

Důležité: Před instalací softwaru musíte od počítače se softwarem CFXManager Dx odpojit
termocykler C1000 Dx. Při instalaci softwaru není nutné vypínat termocykler.

Jak detekovat připojené přístroje

1. Pokud jste tak doposud neučinili, zapojte hranatý (male) konec dodaného kabelu USB typu B do
portu USB typu B na zadní straně základny .

2. Druhý konec zapojte do USB portu počítače se softwarem CFXManager Dx.

3. Pokud ještě není termocykler v provozu, zapněte jej stisknutím vypínače napájení na zadní straně
přístroje.

4. Spusťte software Software CFX Manager Dx.

Software automaticky rozpozná připojený přístroj a zobrazí v podokně Detected Instruments
(Detekované nástroje) okna Home (Domů) jeho název.

Poznámka: Pokud se přístroj v podokně Detected Instruments (Detekované nástroje) neobjeví,
ujistěte se, že je USB kabel správně připojen. Pro opětovnou instalaci ovladačů vyberte v okně
Home (Domů) softwaru Software CFX Manager Dx možnost Tools > Reinstall Instrument Drivers
(Nástroje > Znovu instalovat ovladače přístroje).
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Odpojení reakčního modulu Systém CFX Dx
Důležité: Před odpojením reakčního modulu vypněte termocykler C1000 Dx (viz Vypnutí
termocykleru C1000 Dx na straně 34). Chladicí žebra v reakčním modulu mohou být bezprostředně
po provedení protokolu nebo inkubace horká. Před odpojením reakčního modulu se ujistěte, že
jsou žebra chladná.

Jak odpojit optický reakční modul od základny termocykleru

1. Na zadní straně základny termocykleru zatlačte na pojistnou tyč, abyste odjistili a uvolnili optický
reakční modul.

2. Opatrně vytáhněte optický reakční modul z vyhrazeného prostoru s využitím výřezů po stranách.

3. Položte optický reakční modul na čistý, rovný povrch, kde bude chráněn před nárazy,
poškrábáním a pádem.

Vypnutí termocykleru C1000 Dx
Jak vypnout termocykler

1. Po cyklu stiskněte tlačítko pro otevření víka na přední straně optického reakčního modulu CFX,
abyste získali přístup k vzorkům založeným v bloku.

2. Vyjměte vzorky z bloku a stiskněte tlačítko pro uzavření víka.

3. Pro vypnutí systému stiskněte vypínač napájení na zadním panelu termocykleru C1000 Dx .
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Tato kapitola vysvětluje, jak nainstalovat software CFX Manager Dx.

Software CFX Manager Dx je nezbytný pro analýzu PCR dat ze systémů CFX96 Dx a CFX96 Deep
Well Dx v reálném čase. Tímto softwaremmůžete uvedené systémy rovněž ovládat v režimu
softwarového ovládání.

Informace o instalaci termocykleru Systém CFX Dx a modulu optické reakce jsou uvedeny v kapitole
Nastavení termocykleru C1000 Dx na straně 23.

Návod k použití | 35



Kapitola 3 Instalace softwaru CFX Manager Dx

Požadavky na systém
Tabulka 8 uvádí minimální a doporučené systémové požadavky pro počítač se softwaremSoftware
CFX Manager Dx (označovaný jako počítač CFX Manager Dx).

Systém Minimální Doporučené

Operační systém Microsoft Windows 7 SP1
Pro

Jedna z následujících možností:

n Microsoft Windows 7 SP2 Pro (32- a 64bitový)

n Microsoft Windows 10 Pro (pouze 64bitový)

n Microsoft Windows 10 Enterprise (pouze
64bitový)

Důležité: Zabezpečené spouštění musí být na systémech Microsoft Windows 10 Pro i Enterprise
neaktivní.

Porty 2 vysokorychlostní porty
USB 2.0

2 vysokorychlostní porty USB 2.0

Místo na pevném
disku

128 GB 128 GB

Rychlost
procesoru

2,4 GHz, Dual Core 2,4 GHz, Quad Core

RAM 4 GB RAM 8 GB RAM

Rozlišení
obrazovky

1024 × 768 s režimem true
color

1280 × 1024 s režimem true color

Čtečka PDF Čtečka PDF Adobe nebo čtečka PDFWindows z
některé z podporovaných sad Microsoft Office:

n 2007

n 2010

n 2013

Tabulka 8. Požadavky na počítač pro software Software CFX Manager Dx
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Instalace softwaru CFX Manager Dx
Důležité: Před instalací nebo upgradem softwaru musíte od počítače CFX Manager Dx odpojit
všechny připojené přístroje. Při instalaci softwaru není nutné vypínat termocykler. Ujistěte se, že
jste uložili všechny cykly a že neprobíhají žádné experimenty.

Poznámka: Pokud instalujete software Software CFX Manager Dx na systémuWindows 10, před
zahájením instalace se ujistěte, že je deaktivováno zabezpečené spouštění.

Instalace Software CFX Manager Dx

1. V případě potřeby odpojte od počítače všechny připojené přístroje.

Najděte a odpojte USB kabel přístroje z počítače se softwarem CFXManager Dx. Konec
zapojený do přístroje můžete ponechat na místě.

2. Přihlaste se k počítači se softwarem CFXManager Dx s oprávněními administrátora.

3. Dejte CD softwaru CFX Manager Dx do CD jednotky počítače.

4. Automaticky by se měla objevit spouštěcí stránka softwaru. Na spouštěcí stránce dvakrát klikněte
na možnost Install Software (Instalovat software).

Poznámka: Pokud se spouštěcí stránka neotevře automaticky, přejděte na CD jednotku,
otevřete složku CFX_Manager a dvakrát klikněte na soubor setup.exe pro spuštění průvodce
instalací softwaru.

Tip: V průvodci instalací klikněte na tlačítko Documentation (Dokumentace) pro vyhledání
dohledatelných kopií poznámek k vydání, návodů pro přístroje a další dokumentace.

5. Pro dokončení instalace postupujte podle pokynů na obrazovce. Po dokončení se na pracovní
ploše počítače objeví ikona softwaru CFX Manager.

6. Po dokončení instalace můžete CD disk bezpečně vysunout.

Detekce připojených přístrojů
Během instalace instalátor softwaru CFX Manager Dx automaticky nainstaluje ovladače nástroje do
počítače se softwarem CFXManager Dx. CFX Manager Dx po spuštění softwaru rozpozná připojené
přístroje.

Jak detekovat připojené přístroje

1. Pokud jste tak doposud neučinili, zapojte hranatý (male) konec dodaného kabelu USB typu B do
portu USB typu B na zadní straně základny přístroje.

2. Druhý konec (port) zapojte do USB portu počítače se softwarem CFXManager Dx.
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3. Pokud ještě není přístroj v provozu, zapněte jej stiskem vypínače napájení na zadní straně
přístroje.

4. Spusťte software CFX Manager Dx.

Software automaticky rozpozná připojený přístroj a zobrazí v podokně Detected Instruments
(Detekované nástroje) okna Home (Domů) jeho název.

Poznámka: Pokud se přístroj v podokně Detected Instruments (Detekované nástroje) neobjeví,
ujistěte se, že je USB kabel správně připojen. Pro přeinstalování ovladačů vyberte v okně Home
(Domů) softwaru CFX Manager Dx položky Tools > Reinstall Instrument Drivers (Nástroje >
Znovu instalovat ovladače přístroje).

Softwarové soubory
Tabulka 9 uvádí typy souborů softwaru Software CFX Manager Dx.

Typ souboru Koncovka Podrobnosti

Protokol .prcl Obsahuje podrobnosti o nastavení protokolu pro
provedení cyklu PCR.

Destička .pltd Obsahuje podrobnosti o nastavení destičky pro
provedení cyklu PCR.

Data .pcrd Obsahuje výsledky experimentu a analýzy PCR.

Cyklus PrimePCR .csv Obsahuje protokol a uspořádání destičky pro destičky
PrimePCR.

Genová studie .mgxd Obsahuje výsledky více cyklů PCR a analýzy exprese
genu.

LIMS .plrn Obsahuje informace o nastavení destičky a protokolu,
které jsou nezbytné pro provedení LIMS kompatibilního
cyklu.

Tabulka 9. Typy souborů softwaru Software CFX Manager Dx
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Doporučená opatření pro síťové zabezpečení
Společnost Bio-Rad doporučuje, abyste při realizaci opatření v rámci síťového zabezpečení počítače
používaného se systémem CFX96 Dx spolupracovali s vlastním oddělením IT. Například:

n Nainstalujte a nakonfigurujte vhodné aplikace pro antivirovou ochranu a firewall.

Důležité: Nakonfigurujte antivirový program tak, aby skenování počítače probíhalo mimo
pracovní dobu nebo ve chvíli, kdy přístroj není v aktivním provozu. Pokud se skenování
antivirového programu spustí, zatímco software CFX Manager Dx pracuje na experimentu,
může dojít k zrušení pracovního cyklu a ke ztrátě dat.

n Software CFX Manager Dx nemá funkci přerušení relace uživatele v případě neaktivity. Využijte
opatření pro zabezpečení přístupu, které obsahuje systémWindows nebo aplikace třetích stran
(například dle potřeby využívejte spořič obrazovky s nutností přihlášení).

n Zabezpečení přenosných médií:

o Na ochranu dat používejte na svém USB zařízení hesla a šifrování.

o Pro všechna přenosná média deaktivujte funkce automatického spuštění a přehrávání.

o Při každém připojení USB paměti aktivujte USB skenování.

n Používejte zálohovací nástroj, který usnadní obnovu dat.
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Kapitola 4 Pracovní plocha
CFXManager Dx poskytuje rozhraní pro nastavení destiček, přípravu protokolů PCR, jejich spouštění
na přístrojích CFX Dx a analýzu dat z cyklů PCR.

Software CFX Manager Dx obsahuje pět primárních pracovních ploch:

n Okno Home (Domů)

n Startup Wizard (Průvodce spuštěním)

n Okno Protocol Editor (Editor protokolu)

n Okno Plate Editor (Editor destiček)

n Okno Data Analysis (Analýza dat)

Každá pracovní plocha je zobrazena a stručně popsána v této kapitole.
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Okno Home (Domů)
Software CFX Manager Dx se otevře v okně Home (Domů) a zobrazí se nástroj Startup Wizard
(Průvodce spuštěním), ze kterého můžete nastavit experiment, provést nebo zopakovat cyklus nebo
analyzovat stávající cyklus. Z okna Home (Domů) můžete také prohlížet protokoly aplikací a přístrojů,
vytvářet a spravovat uživatele a získat přístup k různým užitečným nástrojům. Více informací
naleznete v Kapitola 5, Okno Home (Domů).
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Startup Wizard (Průvodce spuštěním)
Pomocí nástroje Startup Wizard (Průvodce spouštěním) můžete rychle nastavit a provádět uživatelem
definované experimenty nebo vybrat a provést experiment PrimePCR. Rovněž je možné přes tohoto
průvodce zopakovat cyklus nebo analyzovat data cyklu.
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Okno Protocol Editor (Editor protokolu)
V nástroji Protocol Editor (Editor protokolu) můžete vytvářet, otevírat, kontrolovat a upravovat
protokol. Můžete také změnit teplotu víka pro otevřený protokol. Funkce Protocol Editor (Editor
protokol) je podrobně popsána v Kapitola 6, Vytváření protokolů.
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Okno Plate Editor (Editor destiček)
V nástroji Plate Editor (Editor destiček) můžete vytvářet, otevírat, kontrolovat a upravovat destičky.
Funkce nástroje Plate Editor (Editor destiček) jsou podrobně popsány v Kapitola 7, Příprava destiček.
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Okno Data Analysis (Analýza dat)
V okně Data Analysis (Analýza dat) můžete prohlížet a porovnávat data cyklu, provádět statistické
analýzy, exportovat data a vytvářet hlášení připravená k publikování. Podrobné informace k položce
Data Analysis (Analýza dat) naleznete v Kapitola 9, Přehled analýzy dat. A také v Kapitola 10,
Podrobnosti o analýze dat.
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Kapitola 5 Okno Home (Domů)
Software CFX Manager Dx poskytuje rozhraní pro vytváření protokolů PCR, jejich provádění na
systémech CFX Dx a analýzu dat cyklu PCR.

Tato kapitola představuje software Software CFX Manager Dx a popisuje funkce přístupné z okna
Home (Domů).
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Okno Home (Domů)
Software CFX Manager Dx se otevře v okně Home (Domů) a zobrazí se nástroj Startup Wizard
(Průvodce spuštěním), ze kterého můžete nastavit, provést nebo zopakovat cyklus nebo analyzovat
stávající cyklus. Z okna Home (Domů) můžete také prohlížet protokoly aplikací a přístrojů, vytvářet a
spravovat uživatele a získat přístup k různým užitečným nástrojům.

1. Záhlaví softwaru obsahuje název softwaru a přihlášeného uživatele.

2. Panel nabídek umožňuje rychlý přístup k příkazům nabídek File (Soubor), View (Zobrazit),
Users (Uživatelé), Run (Cyklus), Tools (Nástroje), Window (Okno) a Help (Nápověda).

3. Příkazy na panelu nástrojů umožňují rychlý přístup k možnostem nabídek.

4. Levý panel ukazuje přístroje připojené k počítači se softwarem CFX Manager Dx a
obsahuje tlačítka, kterými můžete ovládat víko a zobrazovat stav přístrojů.

5. Hlavní panel obsahuje pracovní okno. Výchozím pracovním oknem na obrazovce Home
(Domů) je Startup Wizard (Průvodce spuštěním).

6. Na stavovém řádku jsou uvedeny názvy připojených přístrojů a přihlášený uživatel.

LEGENDA
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Příkazy nabídky File (Soubor)
New (Nový) – otevře dialogové okno, ze kterého můžete zvolit vytvoření nového protokolu, tabulky nebo
genové studie.

Open (Otevřít) – otevře dialogové okno, ze kterého můžete zvolit navigaci a otevření existujícího
protokolu, destičky, datového souboru, genové studie, souboru LIMS, nebo soubor cyklu PrimePCR.

Recent Data Files (Poslední datové soubory) – zobrazí seznam naposledy otevřených souborů
PCR.

Repeat a Run (Opakovat cyklus) – otevře Průzkumníka Windows do umístění uložených souborů
PCR, ve kterémmůžete vyhledat cyklus, který se má opakovat.

Exit (Odejít) – zavře CFX Manager Dx.

Příkazy nabídky View (Zobrazit)
Application Log (Protokol aplikací) – zobrazuje protokol o použití softwaru od počáteční instalace
až po aktuální den.

Run Reports (Hlášení o cyklu) – zobrazí seznam hlášení o cyklu.

Startup Wizard (Průvodce spuštěním) – zobrazí v hlavním panelu Startup Wizard (Průvodce
spuštěním).

Run Setup (Nastavení cyklu) – zobrazí v hlavním panelu okno Run Setup (Nastavení cyklu).

Instrument Summary (Souhrn nástrojů) – zobrazí v hlavním panelu okno Instrument Summary
(Souhrn nástrojů).

Detected Instruments (Detekované nástroje) – přepíná mezi zobrazením a nezobrazováním
připojených nástrojů v levém podokně. Ve výchozím nastavení software zobrazuje v levém podokně
připojené nástroje.

Toolbar (Panel nástrojů) – přepíná mezi zobrazením a nezobrazováním panelu nástrojů v horní
části obrazovky. Ve výchozím nastavení software zobrazuje panel nástrojů.

Status Bar (Stavový řádek) – přepíná mezi zobrazením a nezobrazením stavového řádku ve spodní
části obrazovky. Ve výchozím nastavení software zobrazuje stavový řádek.

Show (Zobrazit) – otevře dialogové okno, ze kterého můžete

n Zobrazit nebo blokovat zobrazení protokolu Status (Stav).

n Otevřít a zobrazit datovou složku CFX Manager Dx.

n Otevřít a zobrazit datovou složku uživatele.

n Otevřít a zobrazit složku se soubory LIMS.
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n Otevřít a zobrazit složku PrimePCR.

n Zobrazit historii cyklu.

n Zobrazit vlastnosti všech připojených nástrojů.

Příkazy nabídkyUser (Uživatel)
Select User (Vybrat uživatele) – otevře obrazovku Login (Přihlášení), na které můžete vybrat
uživatele z rozevíracího seznamu User Name (Uživatelské jméno) a přihlásit se do aplikace.

Change Password (Změnit heslo) – otevře dialogové okno Change Password (Změnit heslo), ve
kterémmohou uživatelé své heslo do softwaru Software CFX Manager Dx.

User Preferences (Uživatelské předvolby) – otevře dialogové okno User Preferences (Uživatelské
předvolby), ve kterémmohou uživatelé měnit výchozí nastavení pro

n odesílání a příjem e-mailových oznámení při dokončení cyklu,

n ukládání datových souborů,

n vytváření protokolů pomocí nástroje Protocol Editor (Editor protokolu) nebo Protocol
AutoWriter (Automatický generátor protokolu),

n vytváření destiček,

n analýzu dat,

n provádění analýzy exprese genu,

n stanovení kvality dat,

n export dat pro přístroj CFX Dx.

User Administration (Správa uživatelů) – otevře dialogové okno User Administration (Správa
uživatelů), ve kterémmohou administrátoři vytvářet uživatele, měnit povolení rolí a přiřazovat role
uživatelům.

Bio-Rad Service Login (Servisní přihlášení Bio-Rad) – pouze pro použití pracovníky technického
servisu Bio-Rad. Tento příkaz nepoužívejte.
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Příkazy nabídky Run (Cyklus)
User-defined Run (Cyklus definovaný uživatelem) – otevře okno Run Setup (Nastavení cyklu), ve
kterémmůžete nastavit uživatelem definovaný protokol a destičku a následně provést experiment s
PCR na vybraných přístrojích.

PrimePCR Run (Cyklus PrimePCR) – otevře kartu Start Run (Spustit cyklus) v okně Run Setup
(Nastavení cyklu) s načteným výchozím protokolem PrimePCR a rozložením destičky na základě
vybraného přístroje.

End-Point Only Run (Cyklus pouze s koncovými body) – otevře kartu Start Run (Spustit cyklus) v
okně Run Setup (Nastavení cyklu) s načteným výchozím protokolem koncových bodů a rozložením
destičky na základě vybraného přístroje.

Qualification Run (Cyklus kvalifikace) – otevře kartu Start Run (Spustit cyklus) v okně Run Setup
(Nastavení cyklu) s načteným výchozím protokolem kvalifikace Bio-Rad a rozložením destičky pro
vybraný přístroj.

Příkazy nabídky Tools (Nástroje)
Master Mix Calculator (Kalkulačka Master Mix) – otevře Master Mix Calculator (Kalkulačka Master
Mix), ve které můžete vytvořit reakční směs a tisknout výpočty.

Protocol AutoWriter (Automatický generátor protokolu) – otevře dialogové okno Protocol
AutoWriter (Automatický generátor protokolu), ve kterémmůžete snadno vytvořit nový protokol.

Ta Calculator (Kalkulačka Ta) – otevře nástroj Ta Calculator (Kalkulačka Ta), ve kterémmůžete
snadno spočítat teplotu hybridizace primerů.

Dye Calibration Wizard (Průvodce kalibrací barviva) – otevře nástroj Dye Calibration (Průvodce
kalibrací barviva), ve kterémmůžete kalibrovat přístroj pro nový fluorofor.

Reinstall Instrument Drivers (Přeinstalovat ovladače přístroje) – přeinstaluje ovladače, které řídí
komunikaci se systémy Bio-Rad PCR v reálném čase.

Zip Data and Log Files (Zip Data a soubory protokolu) – otevře dialogové okno, ve kterémmůžete
vybrat soubory, které chcete komprimovat a uložit do zazipovaného souboru pro uložení nebo
odeslání e-mailem.

Batch Analysis (Analýza dávek) – otevře dialogové okno Batch Analysis (Analýza dávek), ve
kterémmůžete nastavit parametry pro analýzu více než jednoho datového souboru najednou.

Options (Možnosti) – otevře dialogové okno, ve kterémmůžete

n Konfigurovat nastavení e-mailového serveru.

n Konfigurovat nastavení exportu pro LIMS a další datové soubory.
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Příkazy nabídky Help (Nápověda)
Tip: Nabídka Help (Nápověda) je k dispozici na panelu nástrojů ve všech oknech Software CFX
Manager Dx.

Open Operation Manual (Otevřít návod k použití) – otevře PDF soubor tohoto návodu.

Gene Expression Gateway Web Site (Výchozí internetové stránky pro expresi genu) – otevře
domovské stránky společnosti Bio-Rad pro Systém CFX Dx.

PCR Reagents Web Site (Internetové stránky pro PCR reagencie) – otevře internetové stránky
společnosti Bio-Rad pro PCR reagencie, na kterých si můžete objednat PCR reagencie, supermixy,
barviva a soupravy.

PCR Plastic Consumables Web Site (Internetové stránky s plasty a spotřebními materiály pro
PCR) – otevře internetové stránky společnosti Bio-Rad s plastovými díly a spotřebními materiály pro
PCR, na kterých si můžete objednat destičky, těsnění destiček, zkumavky, uzávěry a další plastové
příslušenství pro PCR.

Software Web Site (Internetové stránky softwaru) – otevře internetové stránky společnosti Bio-
Rad pro software pro analýzu PCR, na kterých si můžete objednat aktualizované verze softwaru
Software CFX Manager Dx této společnosti.

About (O softwaru) – zobrazí informace o autorských právech a verzi softwaru CFX Manager Dx.

Příkazy panelu nástrojů

– otevře Průzkumníka Windows, ve kterémmůžete procházet a otevírat datový soubor nebo
soubor studovaného genu.

– otevře Master Mix Calculator (Kalkulačka Master Mix).

– otevře okno Run Setup (Nastavení cyklu).

– otevře okno Run Setup (Nastavení cyklu) s výchozím protokolem PrimePCR a rozložením
destičky na základě vybraného přístroje.

– otevře Startup Wizard (Průvodce spuštěním).
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Startup Wizard (Průvodce spuštěním)
Když se spustí software CFX Manager Dx, pracovní podokno zobrazí průvodce Startup Wizard
(Průvodce spuštěním). Z dialogového okna Startup Wizard (Průvodce spuštěním) můžete

n Vybrat nástroj z detekovaných přístrojů a nastavit uživatelem definovaný cyklus nebo cyklus
PrimePCR.

n Otevřít a opakovat cyklus.

n Otevřít soubor s daty pro analyzování výsledků z jednoho cyklu nebo souboru studovaného genu
pro získání výsledků z několika cyklů exprese genu.

Tyto úkoly jsou podrobně vysvětleny v dalších kapitolách.

Stavový řádek
V levé části stavového řádku ve spodní části hlavního okna softwaru je zobrazen aktuální stav
detekovaných přístrojů. Na pravé straně stavového řádku je vidět jméno aktuálního uživatele a datum
a čas.
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Panel Detected Instruments (Detekované nástroje)
Podokno Detected Instruments (Detekované nástroje) zobrazuje každý přístroj, který je připojen k počítači
CFX Manager Dx. Ve výchozím nastavení se každý nástroj zobrazí jako ikona a jeho sériové číslo se
zobrazí jako jeho název.

Následující obrázek například zobrazuje čtyři detekované nástroje:

n Dva termocyklery C1000 s reakčními moduly CFX96 DeepWell (CFX96DW1 a CFX96DW2)

n Dva termocyklery C1000 s reakčními moduly CFX96 (CFX96l01 a CFX96l02)

V tomto podokně můžete provádět následující akce:

n Zobrazit vlastnosti a kalibrovaná barviva pro vybraný přístroj.

Další informace o vlastnostech přístroje naleznete v části Zobrazení vlastností nástroje na straně
59.

n Zobrazit stav připojeného přístroje.

n Otevřít motorizované víko na vybraném přístroji.

n Zavřít motorizované víko na vybraném přístroji.

n Zobrazit stav všech připojených přístrojů.
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Zobrazení stavu připojeného přístroje

u V podokně Detected Instruments (Detekované nástroje) vyberte cílový nástroj a postupujte
následovně:

n Klikněte na položku View Status (Zobrazit stav) v části Selected Instrument (Vybrané
přístroje).

n Klikněte pravým tlačítkemmyši a v zobrazené nabídce vyberte příkaz View Status (Zobrazit
stav).

Objeví se dialogové okno Run Details (Podrobnosti o cyklu) zobrazující kartu Run Status (Stav
cyklu). Stav vybraného přístroje se zobrazí pod podoknem stavu spuštění, například:

Otevření nebo uzavření víka přístroje

u V podokně Detected Instruments (Detekované nástroje) vyberte cílový přístroj a postupujte
následovně:

n Klikněte na položku Open Lid (Otevřít víko) nebo Close Lid (Zavřít víko) v části Selected
Instrument (Vybrané přístroje).

n Klikněte pravým tlačítkemmyši a vyberte příslušnou akci v zobrazené nabídce.

n Otevřete dialogové okno Run Details (Podrobnosti o cyklu) a vyberte kartu Run Status (Stav
cyklu) a klikněte na Open Lid (Otevřít víko) nebo Close Lid (Zavřít víko).
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Zobrazení stavu všech připojených přístrojů

u Postupujte následovně:

n V části All Instruments (Všechny nástroje) v podokně Detected Instruments (Detekované
nástroje) klikněte na položku View Summary (Zobrazit souhrn).

n V panelu nabídky vyberte položky View > Instrument Summary (Zobrazit > Souhrn nástrojů).

Zobrazí se dialogové okno Instrument Summary (Souhrn nástrojů):

Tip: Pokud systém detekuje pouze jeden připojený přístroj, část All Instruments (Všechny
nástroje) se na panelu Detected Instruments (Detekované nástroje) neobjeví. Chcete-li
zobrazit souhrn nástroje pro jeden nástroj, vyberte položky View > Instrument Summary
(Zobrazit > Souhrn nástrojů).
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Ovládací prvky panelu nástrojů Instrument Summary (Souhrn nástrojů)

Tabulka 10 uvádí seznam ovládacích prvků a funkcí na panelu nástrojů Instrument Summary (Souhr
nástrojů).

Tlačítko Název tlačítka Funkce

Vytvořit nový cyklus Vytvoří cyklus na vybraném bloku
otevřením okna Run Setup (Nastavení
cyklu).

Zastavit Zastaví aktuální cyklus na vybraných
blocích.

Pozastavit Pozastaví aktuální cyklus na
vybraných blocích.

Pokračovat Obnoví aktuální cyklus na vybraných
blocích.

Indikátor Flash Block Bliká indikátor LED na víku vybraných
bloků.

Otevřít víko Otevře motorizované víko na
vybraném přístroji.

Zavřít víko Zavře motorizované víko na vybraném
přístroji.

Skrýt vybrané bloky Skryje vybrané bloky v seznamu
Instrument Summary (Souhrn
nástrojů).

Zobrazit všechny bloky Zobrazí vybrané bloky v seznamu
Instrument Summary (Souhrn
nástrojů).

Tabulka 10. Ovládací prvky panelu nástrojů Instrument Summary (Souhrn nástrojů)
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Tlačítko Název tlačítka Funkce

Zobrazit Vyberte bloky, které chcete zobrazit v
seznamu. Vyberte jednu z možností
pro zobrazení všech zjištěných bloků,
všech nečinných bloků, všech bloků,
které jsou spuštěny aktuálním
uživatelem, nebo všech běžících
bloků.
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Zobrazení vlastností nástroje
Na panelu Detected Instruments (Detekované nástroje) můžete zobrazit podrobnosti o vybraném
nástroji, včetně jeho vlastností, stavu jeho přepravního šroubu a seznamu jeho kalibrovaných barviv
(fluoroforů).

Zobrazení vlastností nástroje

u V podokně Detected Instruments (Detekované nástroje) klikněte pravým tlačítkemmyši na cílový
přístroj a v zobrazené nabídce vyberte položku Properties (Vlastnosti).
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Karta Properties (Vlastnosti)

Karta Properties (Vlastnosti) obsahuje technické podrobnosti o vybraném nástroji včetně modelu,
sériových čísel jeho součástí a verzí firmwaru. Výchozí název nástroje (jeho sériové číslo) se objeví na
mnoha místech, včetně podokna Detected Instruments (Detekované nástroje) a v záhlaví dialogového
okna Instrument Properties (Vlastnosti nástroje). Nástroj můžete přejmenovat, abyste ho mohli
snadněji identifikovat.

Přejmenování nástroje

u Na kartě Instrument Properties (Vlastnosti nástroje) zadejte název do pole Rename
(Přejmenovat) v horní části karty Properties (Vlastnosti) a klikněte na Rename (Přejmenovat).

Nový název se objeví v řádku Nickname (Přezdívka) na kartě Properties (Vlastnosti) stejně jako v
záhlaví panelu Instrument Properties (Vlastnosti nástroje) a v podokně Detected Instruments
(Detekované nástroje).

Karta Shipping Screw (Šroub pro přepravu)

Karta Shipping Screw (Šroub pro přepravu) zobrazuje aktuální stav přepravního šroubu pro vybraný
nástroj (odstraněný nebo instalovaný). Karta obsahuje také pokyny pro instalaci nebo demontáž
červeného šroubu pro přepravu.

Tip: Pokud software detekuje šroub pro přepravu, zobrazí se v dialogovém okně Instrument
Properties (Vlastnosti nástroje) automaticky karta Shipping Screw (Šroub pro přepravu). Při
odstraňování šroubu pro přepravu postupujte podle pokynů.

Poznámka: Před použitím nástroje je nutné šroub pro přepravu odstranit. Další informace
naleznete v části Odstranění zajišťovacího šroubu na straně 30.
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Karta Calibrated Dyes (Kalibrovaná barviva)

Karta Calibrated Dyes (Kalibrovaná barviva) zobrazuje kalibrované fluorofory a destičky pro vybraný
nástroj.

Chcete-li zobrazit podrobné informace o kalibraci, klepněte na tlačítko Informace ve sloupci Detail
(Podrobnosti).
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Než začnete

Nastavení uživatelských předvoleb
Tip: Pro použití softwaru Software CFX Manager Dx není nutné tyto úkony provádět. Tuto část
můžete klidně přeskočit nebo tyto úkony provést kdykoliv jindy.

V softwaru CFX Manager Dx můžete přizpůsobit své pracovní prostředí. Pokud váš správce vytvořil
uživatele softwaru, může si každý uživatel přizpůsobit své vlastní pracovní prostředí. Jestliže váš
administrátor žádné uživatele nevytvořil, platí změny předvoleb pro každého, kdo se přihlásí do
softwaru CFX Manager Dx. (Informace o tvorbě uživatelů CFX Manager Dx jsou uvedeny v Příloha B,
Správa uživatelů a rolí CFX Manager Dx.)

Například v nabídce Users > User Preferences (Uživatelé > Uživatelské předvolby) můžete provádět
následující:

n Nastavit e-mailové oznámení o dokončení cyklu.

n Změnit výchozí nastavení

o umístění pro ukládání souborů

o souborů nastavení cyklu

o předpony názvu souboru

n Nastavit výchozí parametry použité při tvorbě nového protokolu a destičky.

n Nastavit výchozí parametry analýzy dat a exprese genu.

n Přizpůsobit výchozí parametry kontroly kvality.

n Přizpůsobit parametry dat pro export dat.

V nabídce Tools (Nástroje) můžete provádět následující:

n Vytvořit Master Mix.

n Kalibrovat barviva pro konkrétní přístroj.

Poznámka: Tvorba Master Mixu a kalibrace barviva jsou k dispozici každému, kdo se přihlásí do
softwaru CFX Manager Dx.

Tato část podrobně vysvětluje, jak tyto úkony provádět.
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Nastavení e-mailových oznámení

Můžete software CFX Manager Dx připojit ke svému serveru odchozí pošty, aby mohl odesílat e-
mailová oznámení o dokončení cyklu na seznam uživatelů. K seznamu uživatelů můžete rovněž
připojit datový soubor a hlášení z analýzy. Pokud jde o nastavení připojení mezi softwarem CFX
Manager Dx a vaším SMTP serverem, viz část Připojení CFX Manager Dx na SMTP Server na straně
64.

Poznámka: Možnosti přístupu uživatele k funkcím nastavení e-mailu závisejí na uživatelské
skupině a povoleních přiřazených správcem. Podrobnosti o správě uživatelů a jejich rolích jsou
uvedeny v části Správa uživatelů na straně 261.

Jak nastavit e-mailová oznámení

1. Vyberte možnosti Users > User Preferences (Uživatelé > Uživatelské předvolby) a otevře se
dialogové okno User Preferences (Uživatelské předvolby).

Otevře se dialogové okno User Preferences (Uživatelské předvolby) s kartou Email (E-mail).

Poznámka: Jestliže systém zjistí, že jste nenastavili platný SMTP server pro software CFX
Manager Dx, budete o tom informováni. Kliknutím na položku Configure Outgoing Email
(Konfigurovat odchozí e-mail) otevřete dialogové okno Options (Možnosti), kde můžete
nakonfigurovat e-mailový SMTP server. Více informací je uvedeno v části Připojení CFX
Manager Dx na SMTP Server na straně 64.

2. V textovém rámečku To (Komu) zadejte e-mailovou adresu každé osoby, kterou chcete
informovat o dokončení cyklu. Všichni příjemci obdrží po dokončení cyklu e-mail.

Poznámka: Každou e-mailovou adresu musíte zadat na samostatném řádku. Za každou e-
mailovou adresou stiskněte Enter nebo Return.
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3. (Volitelné) V textovém rámečku cc (Kopie) zadejte e-mailovou adresy příjemců, kterým chcete
poslat kopii každého e-mailového oznámení.

4. (Volitelné) Ve výchozím nastavení obdrží všichni příjemci kopii datového souboru v příloze.
Odznačte toto zaškrtávací políčko, pokud datový soubor nechcete ke kopii přidat.

5. (Volitelné) Vyberte možnost Attach Analysis Report (Připojit hlášení o analýze), abyste k e-mailu
připojili PDF soubor hlášení o analýze.

6. Kliknutím na OK uložíte změny a zavřete dialogové okno User Preferences (Uživatelské
předvolby).

Jak upravit e-mailovou adresu příjemce

u Upravte e-mailovou adresu podle potřeby a klikněte na OK.

Jak odstranit příjemce e-mailu

1. Vyberte příjemce e-mailu a stiskněte tlačítko Delete (Odstranit).

2. Kliknutím na OK uložíte změny a zavřete dialogové okno.

Důležité: Kliknutím na možnost Restore Defaults (Obnovit výchozí hodnoty) v dialogovém okně
User Preferences (Uživatelské předvolby) se obnoví všechny předvolby na všech kartách na
původní tovární nastavení. Při kliknutí na toto tlačítko postupujte opatrně.

Připojení CFX Manager Dx na SMTP Server

Důležité: Někteří komerční poskytovatelé webmailu (například Yahoo! a Gmail) mají zvýšenou e-
mailovou bezpečnost. Pokud použijete tyto účty, musíte povolit nastavení Allow less secure
apps (Povolit méně zabezpečené aplikace) v nastavení účtu, které umožní CFX Manager Dx
odesílat e-maily. Další informace naleznete v informacích o zabezpečení poskytovatele služeb
webmailu.

Před odesláním e-mailového oznámení musíte navázat spojení ze softwaru CFX Manager Dx na svůj
e-mailový server.

Připojení CFX Manager Dx na e-mailový server

1. Postupujte následovně:

n Vyberte položku User > User Preferences (Uživatel > Uživatelské předvolby) a klikněte na
položku Configure Outgoing Email (Konfigurovat odchozí e-mail) na kartě Email (E-mail).

n Vyberte Tools > Options (Nástroje > Možnosti).
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Otevře se dialogové okno Options (Možnosti) a zobrazí kartu Email (E-mail).

2. Zadejte pro vaši společnost následující informace:

n SMTP Server Name (Název serveru SMTP) – název odchozího e-mailového serveru vaší
společnosti.

n Port – číslo portu serveru SMTP. To je obvykle 25.

n Use SSL (Použít možnost SSL) – možnost Secure Sockets Layer (SSL). Toto nastavení
vyžadují některé servery SMTP. Pokud to ve vaší společnosti není vyžadováno, zrušte
zaškrtnutí tohoto políčka.

n Use Default “From” Address (Použít výchozí adresu „Od“) – název e-mailového
serveru ve vaší společnosti Servery SMTP vyžadují, aby všechny odeslané e-maily měly
adresu „Od“, která je z určité domény, například jméno@VašeSpolečnost.com. V takovém
případě zrušte zaškrtnutí tohoto políčka a zadejte platnou e-mailovou adresu.

n Authentication Required (Požadováno ověření) – pokud vaše stránky vyžadují ověření
účtu, ověřte, zda je toto políčko zaškrtnuto.

n User Name (Jméno uživatele) – jméno ověřeného účtu. To je vyžadováno pouze v
případě, že je vybrána možnost Authentication Required (Požadováno ověření).

n Password (Heslo) – heslo pro ověřený účet. To je vyžadováno pouze v případě, že je
vybrána možnost Authentication Required (Požadováno ověření).
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3. Chcete-li ověřit, zda jsou nastavení serveru SMTP správná, zadejte do textového pole Test Email
Address (Test e-mailové adresy) platnou e-mailovou adresu a klikněte na položku Test Email
(Testovat e-mail).

Poznámka: Některé servery SMTP nepovolují přílohy a jiné povolují přílohy pouze do určité
velikosti. Pokud plánujete e-mailové datové soubory nebo hlášení pomocí softwaru CFX
Manager Dx, vyberte položku Test Attachment (Příloha testu) a nastavte pro položku
Attachment Size in MB (Velikost přílohy v MB) hodnotu 5 megabytů (MB) nebo více.

4. Klepnutím na tlačítko OK uložte změny a zavřete dialogové okno.

Změna výchozího nastavení souboru

Na kartě Files (Soubor) dialogového okna User Preference (Uživatelské předvolby) můžete měnit
následující:

n Výchozí umístění pro ukládání souborů CFX Manager Dx

n Výchozí soubory pro nastavení cyklu

n Výchozí parametry pro názvy souborů

Jak změnit výchozí nastavení souboru

1. Vyberte možnost Users > User Preferences (Uživatelé > Uživatelské předvolby) a otevře se
dialogové okno User Preferences (Uživatelské předvolby).

2. V dialogovém okně User Preferences (Uživatelské předvolby) vyberte kartu Files (Soubory).
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3. V části Default Folder for File Creation (Výchozí složka pro tvorbu souborů) najděte a vyberte
výchozí složku, do které chcete ukládat nové soubory. Pro každý typ souboru můžete vybrat jiné
umístění:

n Protokol

n Destička

n Datový soubor

n Genová studie

4. V části File Selection for Run Setup (Výběr souboru pro nastavení cyklu) najděte a vyberte cílové
soubory protokolu a destičky, které se mají zobrazit, když otevřete okno Experiment Setup
(Nastavení experimentu).

5. V části Data File (Datový soubor) definujte předponu nebo příponu datových souborů. Pro každý
díl vyberte z rozevíracího seznamu novou hodnotu. V textových rámečcích Prefix (Předpona) a
Suffix (Přípona) můžete také uvést vlastní hodnoty předpony a přípony.

Software CFX Manager Dx zobrazí pod rámečky pro výběr náhled názvu souboru.

6. Kliknutím na OK uložíte změny a zavřete dialogové okno.

Důležité: Kliknutím na možnost Restore Defaults (Obnovit výchozí hodnoty) v dialogovém okně
User Preferences (Uživatelské předvolby) se obnoví všechny předvolby na všech kartách na
původní tovární nastavení. Při kliknutí na toto tlačítko postupujte opatrně.
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Nastavení výchozích parametrů protokolu

Nastavení výchozích parametrů protokolu pro Protocol Editor (Editor protokolu) a
Protocol AutoWriter (Automatický generátor protokolu)

1. Vyberte Users > User Preferences (Uživatelé > Uživatelské předvolby), aby se otevřelo dialogové
okno User Preferences (Uživatelské předvolby).

2. V dialogovém okně User Preferences (Uživatelské předvolby) vyberte kartu Protocol (Protokol).

3. V části Protocol Editor (Editor protokolu) zadejte hodnoty pro následující nastavení, která se
zobrazí v editoru Protocol Editor (Editor protokolu):

n Sample volume (Objem vzorku) – objem každého vzorku v jamkách (v μl).

n Lid Shutoff temperature (Teplota vypínání víka) – teplota v °C, při které se ohřívač víka
vypne během cyklu.

4. V části Protocol AutoWriter (Automatický generátor protokolu) zadejte hodnoty pro následující
nastavení, která se zobrazí v nástroji Protocol AutoWriter (Automatický generátor protokolu):

n Annealing temperature (Teplota hybridizace) – teplota v °C pro experimenty, které
používají iProof DNA polymerázu, iTaq DNA polymerázu nebo jiné polymerázy.

n Amplicon length (Délka amplikonu) – délka amplikonu v párech bází (bp).

5. Kliknutím na OK uložíte změny a zavřete dialogové okno.

Důležité: Kliknutím na možnost Restore Defaults (Obnovit výchozí hodnoty) v dialogovém okně
User Preferences (Uživatelské předvolby) se obnoví všechny předvolby na všech kartách na
původní tovární nastavení. Dávejte pozor při klepnutí na toto tlačítko.
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Nastavení výchozích parametrů destičky

Změny, které provedete na kartě Plate (Destička), jsou dostupné všem uživatelům softwaru. Změny
provedené během nastavení destičky jsou uživatelům k dispozici po uložení a zavření souboru
destičky.

V dialogovém okně User Preferences (Uživatelské předvolby) můžete provádět následující akce:

n Nastavit výchozí parametry destičky.

n Přidávat nové názvy cílů a vzorků do příslušných knihoven.

n Odstranit nové názvy cílů a vzorků z příslušných knihoven.

Nastavení výchozích parametrů destičky

1. Vyberte Users > User Preferences (Uživatelé > Uživatelské předvolby), aby se otevřelo dialogové
okno User Preferences (Uživatelské předvolby).

2. V dialogovém okně User Preferences (Uživatelské předvolby) vyberte kartu Plate (Destička).
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3. Zadejte hodnoty pro následující nastavení nového souboru destiček. Tyto hodnoty se objevují v
okně Plate Editor (Editor destiček):

n Plate type (Typ destičky)

n Plate size (Velikost destičky)

n Units (Jednotky) – koncentrace spouštěcí šablony pro jamky, které obsahují standardy.

CFX Manager Dx používá tyto jednotky k vytvoření standardní křivky na kartě Data Analysis
Quantification (Kvantifikace dat analýzy).

n Scientific notation (Vědecký zápis) – když je vybrán, software CFX Manager Dx zobrazí
jednotky koncentrace ve vědeckém zápisu.

n Scan mode (Režim skenování) – počet nebo typ kanálů, které mají být skenovány během
cyklu.

n Fluorophores (Fluorofory) – výchozí fluorofory, které se objevují v editoru Plate Editor
(Editor destiček) načtených kontrol jamek.

n Libraries (Knihovny) – názvy cílů a vzorků, které obvykle používáte ve svých
experimentech:

o Target names (Názvy cílů) – názvy cílových genů a sekvencí.

o Sample names (Názvy vzorků) – názvy experimentálních vzorků nebo identifikační
charakteristika vzorků (například Myš1, Myš2, Myš3).

4. Kliknutím na OK uložíte změny a zavřete dialogové okno.

Přidání nového názvu cíle nebo vzorku

u Do pole příslušné knihovny zadejte název cíle nebo vzorku a klikněte na tlačítko cíle nebo vzorku
a klikněte na tlačítko OK.

Odstranění názvu cíle nebo vzorku

u V příslušném poli knihovny vyberte název, stiskněte klávesu Delete a klikněte na tlačítko OK.

Důležité: Názvy, které odstraníte z knihovny, jsou ze softwaru trvale odstraněny a uživatelům již
nejsou k dispozici. Pro obnovení možností do výchozích názvů CFX Manager Dx, klikněte na
Restore Defaults (Obnovit výchozí). Kliknutím na možnost Restore Defaults (Obnovit výchozí
hodnoty) v dialogovém okně User Preferences (Uživatelské předvolby) se obnoví všechny
předvolby na všech kartách na původní tovární nastavení. Při odstraňování výchozích názvů CFX
Manager Dx a při klepnutí na toto tlačítko buďte opatrní.
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Nastavení výchozích parametrů analýzy dat

Nastavení výchozích parametrů analýzy dat

1. Vyberte položky Users > User Preferences (Uživatelé > Uživatelské předvolby), aby se otevřelo
dialogové okno User Preferences (Uživatelské předvolby).

2. V dialogovém okně User Preferences (Uživatelské předvolby) vyberte kartu Data Analysis
(Analýza dat).

3. V části Analysis Mode (Režim analýzy) vyberte režim, ve kterém chcete analyzovat data (buď
Fluorophore (Fluorofor), nebo Target (Cíl)).

4. V části PCR Quantitation (Kvantifikace PCR) nastavte výchozí parametry pro následující
možnosti:

n Baseline Setting (Základní nastavení) – základní metoda pro režim analýzy.

n Cq Determination Mode (Režim stanovení hodnoty Cq) – režim, ve kterém jsou hodnoty
Cq vypočteny pro každou fluorescenční stopu (buď regresní, nebo jednoprahovou).
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n Threshold Calc. Mode (Režim výpoč. prahové hodnoty) – cílové množství koncového
bodu.

Výchozí hodnota je Auto (Automaticky). To znamená, že software automaticky vypočítá cíl
koncového bodu. Chcete-li nastavit konkrétní prahovou hodnotu, zrušte zaškrtnutí políčka
Auto (Automaticky) a zadejte hodnotu koncového bodu vypočítanou v jednotkách relativní
fluorescence (nebo RFU). Maximální hodnota je 65 000,00 RFU. Datové soubory pro
následující cykly budou používat toto nastavení prahu.

n Baseline Calc. Mode (Režim výpoč. základní hodnoty) – základní hodnota pro všechny
trasy.

Výchozí hodnota je Auto (Automaticky). To znamená, že software automaticky vypočítá
základní hodnotu pro všechny trasy. Chcete-li nastavit konkrétní základní hodnotu, zrušte
zaškrtnutí políčka Auto (Automaticky) a zadejte minimální a maximální hodnoty pro rozsah
cyklu (1 až 9999). Datové soubory pro následující cykly budou používat tento rozsah cyklu.

n Log View (Zobrazení protokolu) – určuje, jak bude software zobrazovat data amplifikace:

o On (Zapnuto) – data amplifikace jsou zobrazena v semilogaritmickém grafu.

o Off (Vypnuto) – (výchozí) data amplifikace jsou zobrazena v lineárním grafu.

5. V části End Point (Koncový bod) vyberte počet koncových cyklů, které se mají při výpočtu
koncového bodu průměrovat:

n PCR – počet koncových cyklů k průměru pro data kvantifikace (výchozí hodnota je 5).

n End Point Only run (Cyklus pouze koncový bod) – počet koncových cyklů k průměru dat
koncových bodů (výchozí hodnota je 2).

6. V části Melt Curve (Křivka tání) vyberte typ vrcholu, který chcete detekovat (buď pozitivní, nebo
negativní).

7. V části Well Selector (Nástroj pro výběr jamky) vyberte, jak zobrazit popisky jamky (podle typu
vzorku, názvu cíle nebo názvu vzorku).

8. Kliknutím na OK uložíte změny a zavřete dialogové okno.

Důležité: Kliknutím na možnost Restore Defaults (Obnovit výchozí hodnoty) v dialogovém okně
User Preferences (Uživatelské předvolby) se obnoví všechny předvolby na všech kartách na
původní tovární nastavení. Dávejte pozor při klepnutí na toto tlačítko.

72 | Systémy CFX96 Dx a CFX96 DeepWell Dx



Než začnete

Nastavení výchozích parametrů datového souboru exprese genu

Jak nastavit výchozí parametry nového datového souboru exprese genu

1. Vyberte možnosti Users > User Preferences (Uživatelé > Uživatelské předvolby) a otevře se
dialogové okno User Preferences (Uživatelské předvolby).

2. V dialogovém okně User Preferences (Uživatelské předvolby) vyberte kartu Gene Expression
(Exprese genu).

3. Stanovte hodnoty následujícího nastavení:

n Relative to (Vzhledem k) – sestaví graf z dat exprese genu vzhledem ke kontrole
(s počátkem v bodě 1) nebo nule:

o Zero (Nula) – software kontrolu ignoruje. Toto je výchozí hodnota, když není v okně
Experiment Settings (Nastavení experimentu) přiřazen žádný kontrolní vzorek.

o Control (Kontrola) – software vypočítá data vzhledem ke kontrolnímu vzorku
přiřazenému v okně Experiment Setup (Nastavení experimentu).

n X-axis (Osa X) – sestaví graf vzorku nebo cíle na ose X.

n Y-axis (Osa Y) – sestaví graf v lineárním, log2 nebo log10 měřítku na ose Y.
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n Scaling (Úprava měřítka) – možnost úpravy měřítka grafu (výchozí možnost je bez úpravy
měřítka):

o Highest (Nejvyšší) – software upraví měřítko grafu podle nejvyššího datového bodu.

o Lowest (Nejnižší) – software upraví měřítko grafu podle nejnižšího datového bodu.

o Unscaled (Bez úpravy měřítka) – software prezentuje data v grafu bez úpravy měřítka.

n Mode (Režim) – režim analýzy, buď relativní množství (∆Cq), nebo normalizovaná exprese
(∆∆Cq).

n Error Bar (Chybová úsečka) – variabilita dat prezentovaná jako směrodatná odchylka (Std.
Dev.), nebo jako standardní chyba průměru (Std. Error Mean).

n Error Bar Multiplier (Násobitel chybové úsečky) – násobitel směrodatné odchylky
použitý k sestavení grafu chybových úseček (výchozí hodnota je 1).

Násobitel můžete zvýšit na 2 nebo 3.

n Sample Types to Exclude (Vyloučené typy vzorků) – typy vzorků, které budou vyloučeny
z analýzy.

Můžete vybrat jeden nebo několik vzorků, které budou vyloučeny z analýzy. Pokud chcete
vyloučit všechny typy vzorků, odznačte zaškrtávací políčka všech vybraných typů vzorků.

4. Kliknutím na OK uložíte změny a zavřete dialogové okno.

Důležité: Kliknutím na možnost Restore Defaults (Obnovit výchozí hodnoty) v dialogovém okně
User Preferences (Uživatelské předvolby) se obnoví všechny předvolby na všech kartách na
původní tovární nastavení. Při kliknutí na toto tlačítko postupujte opatrně.

Přizpůsobení pravidel pro kontrolu kvality

V softwaru CFX Manager Dx můžete nastavit pravidla kontroly kvality, která se použijí na data v okně
Data Analysis (Analýza dat). Software validuje data proti nastaveným pravidlům.

Poznámka: Ve výchozím nastavení jsou povolena všechna pravidla kontroly kvality.

Tip: Jamky, které nesplňují parametry QC (Kontrola kvality), můžete snadno vyloučit z analýzy v
modulu QC okna Data Analysis (Analýza dat).
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Přizpůsobení pravidel pro kontrolu kvality

1. Vyberte položky Users > User Preferences (Uživatelé > Uživatelské předvolby) a otevře se
dialogové okno User Preferences (Uživatelské předvolby).

2. V dialogovém okně User Preferences (Uživatelské předvolby) vyberte kartu QC (Kontrola kvality).

kde:

n NTC (Kontrola bez templátu) – kontrola bez templátu

n NRT (Bez reverzní transkriptázy) – bez reverzní transkriptázy

n Efficiency (Účinnost) – účinnost reakce

n Std Curve R^2 (Std křivka R^2) – R čtvercová hodnota pro standardní křivku

n Replicate group Cq Std Dev (Vyp. std. odch. skupiny replikátů) – směrodatná odchylka
vypočtená pro každou skupinu replikátů

3. U každého pravidla QC (Kontrola kvality) postupujte následovně:

n Chcete-li použít výchozí hodnotu, nedělejte nic.

n Chcete-li změnit hodnotu, klikněte na textové pole Value (Hodnota), zadejte novou hodnotu a
stiskněte klávesu Enter.

n Chcete-li pravidlo zakázat, zrušte zaškrtnutí políčka Use (Použít).
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4. Kliknutím na tlačítko OK uložte změny a zavřete dialogové okno.

Důležité: Kliknutím na tlačítko Restore Defaults (Obnovit výchozí hodnoty) v dialogovém okně
User Preferences (Uživatelské předvolby) se obnoví všechny předvolby na všech kartách na
původní tovární nastavení. Před klepnutím na toto tlačítko buďte opatrní.

Přizpůsobení parametrů pro export dat

Data CFX Manager Dx můžete exportovat v následujících formátech:

n Text (.txt)

n CSV (.csv)

n Excel 2007 (.xlsx)

n Excel 2003 (.xls)

n XML (.xml)

n HTML (.html)

Můžete určit typ dat pro export a přizpůsobit výstup exportovaných dat.

Přizpůsobení parametrů pro export dat

1. Vyberte Users > User Preferences (Uživatelé > Uživatelské předvolby) a otevře se dialogové
okno User Preferences (Uživatelské předvolby).

2. V dialogovém okně User Preferences (Uživatelské předvolby) vyberte kartu Custom Export
(Vlastní export).
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3. V rozevíracím seznamu Export Format (Formát exportu) vyberte formát, do kterého chcete data
exportovat.

4. V části Data to Export (Data do exportu) zaškrtněte nebo odznačte zaškrtávací políčka pro typ
dat, která mají být exportována. Vybrané položky se zobrazí v seznamu Exported Columns
(Exportované sloupce).

Poznámka: Ve výchozím nastavení jsou informace o cyklu zahrnuty do záhlaví. Odznačte
toto zaškrtávací políčko, pokud nechcete zahrnout informace o cyklu.

5. Můžete změnit pořadí zobrazení výstupu vybraných položek.

V seznamu Exported Columns (Exportované sloupce) zvýrazněte položku a potom klikněte pro
pohyb nahoru nebo dolů na tlačítka se šipkami vlevo od seznamu.

6. Volitelně můžete změnit názvy sloupců výstupu vybraných položek:

a. Klikněte na Customize Column Names (Upravit názvy sloupců).

Zobrazí se dialogové okno Column Name Customizer (Vlastní název sloupce).

b. Pro každý výchozí název sloupce, který chcete změnit, zadejte nový název do pole Custom
Name (Vlastní název).

c. Postupujte následovně:

n Kliknutím na tlačítko OK uložte změny a vraťte se na kartu Custom Export (Vlastní
export). Nový název se zobrazí v závorkách vedle výchozího názvu sloupce v seznamu
Exported Columns (Exportované sloupce).

n Kliknutím na tlačítko Cancel (Zrušit) zrušte změny a vraťte se na kartu Custom Export
(Vlastní export).

7. Kliknutím na tlačítko OK uložte změny a zavřete dialogové okno.

Důležité: Kliknutím na tlačítko Restore Defaults (Obnovit výchozí hodnoty) v dialogovém okně
User Preferences (Uživatelské předvolby) se obnoví všechny předvolby na všech kartách na
původní tovární nastavení. Před klepnutím na toto tlačítko buďte opatrní.
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Vytvoření reakčního Master Mix
Díky nástroji Master Mix Calculator (Kalkulačka Master Mix) softwaru CFX Manager Dx můžete
snadno vypočítat požadovaný objem každého komponentu ve vašemMaster Mixu. Tabulku s
výpočtemMaster Mixu můžete vytisknout na své výchozí tiskárně a výpočty pro každý cíl uložit pro
pozdější použití.

Jak vytvořit reakční Master Mix pomocí nástroje Master Mix Calculator (Kalkulačka
Master Mix)

1. Abyste otevřeli nástroj Master Mix Calculator (Kalkulačka Master Mix), postupujte následovně:

n Vyberte možnosti Tools > Master Mix Calculator (Nástroje > Kalkulačka Master Mix).

n Na panel nástrojů klikněte na možnost Master Mix Calculator (Kalkulačka Master Mix).

Objeví se Master Mix Calculator (Kalkulačka Master Mix).
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2. V části Reaction (Reakce) vyberte metodu detekce:

n SYBR®Green/EvaGreen

n Probes (Sondy)

3. Abyste vytvořili nový cíl, klikněte v části Target (Cíl) na možnost Create New (Vytvořit nový).
V rozevíracím seznamu cílů se objeví nový název cíle.

4. (Volitelné) Jak změnit výchozí název cíle:

a. V rozevíracím seznamu cílů zvýrazněte název cíle.

b. V kolonce Target (Cíl) zadejte nový název cíle.

c. Stiskněte tlačítko Enter.

5. Nastavte počáteční a koncovou koncentraci přímého a zpětného primeru a všechny sondy.

6. V části Master Mix Setup (Nastavení Master Mix) nastavte hodnotu

n počtu reakcí v cyklu

n reakčního objemu na jamku

n objemu templátu na jamku

n koncentrace supermixu na jamku

n nadbytečného reakčního objemu na jamku

7. (Volitelné) Proveďte kroky 2–6 pro potřebný počet cílů.

8. V části Choose Target to Calculate (Vybrat cíl k výpočtu) vyberte cíl, který chcete vypočítat.

Tip: Můžete současně vypočítat buď jeden, nebo několik, nebo všechny cíle.

Vypočítané objemy požadovaných komponentů pro každý vybraný cíl se objeví v tabulce Master
Mix.

9. Kliknutím na možnost Set as Default (Nastavit jako výchozí) nastavíte množství zadaná v částech
Target (Cíl) a Master Mix Setup (Nastavení Master Mix) jako nové výchozí hodnoty.

10. Kliknutím na OK uložíte obsah dialogového okna Master Mix Calculator (Kalkulačka Master Mix).

Jak vytisknout tabulku s výpočtem Master Mixu

u Abyste vytiskli tabulku s výpočtemMaster Mixu, klikněte na možnost Print (Tisk).

Tabulka s výpočtem se vytiskne na vaší výchozí tiskárně.
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Jak uložit tabulku s výpočtem Master Mixu jako PDF

u Změňte svou výchozí tiskárnu na ovladač PDF a klikněte na možnost Print (Tisk) v nástroji Master
Mix Calculator (Kalkulačka Master Mix).

Jak odstranit cíle

u V rozevíracím seznamu cílů vyberte cíl a klikněte na možnost Remove (Odstranit).

Důležité: Odstraněním cíle ze seznamu cílů se tento cíl odstraní i ze všech výpočtů Master
Mixu, pro který je použit. Při odstraňování cíle postupujte opatrně.
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Kalibrace nových barviv
Systémy CFX96 Dx jsou z výroby kalibrovány pro běžně používané fluorofory v destičkách s bílými a
čirými jamkami. Tabulka 11 uvádí fluorofory a kanály, pro které je každý přístroj kalibrován.

Poznámka: Systémy CFX96 také zahrnují kanál určený pro chemii FRET. Tento kanál
nevyžaduje kalibraci pro specifická barviva.

Fluorofory Kanál Excitace, nm Detekce, nm

FAM, SYBR® Green I 1 450–490 515–530

VIC, HEX, CAL Fluor Gold 540, Cal Fluor
Orange 560

2 515–535 560–580

ROX, Texas Red, CAL Fluor Red 610,
TEX 615

3 560–590 610–650

CY5, Quasar 670 4 620–650 675–690

Quasar 705, Cy5.5 5 672–684 705–730

Tabulka 11. Továrně kalibrované fluorofory a kanály
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Kalibrace nových barviv pro systémy CFX

1. V okně Home (Domů) vyberte cílový nástroj v podokně Detected Instruments (Detekované
nástroje).

2. Vyberte položku Tools > Calibration Wizard (Nástroje > Průvodce kalibrací), chcete-li otevřít
průvodce Dye Calibration (Kalibrace barviva).

Již kalibrované fluorofory pro cílový přístroj se objeví v tabulce Calibrated Fluorophores
(Kalibrované fluorofory).

3. V části Calibrate New or Existing Fluorophores (Kalibrace nových nebo existujících fluoroforů)
vyberte v rozevíracím seznamu fluorofor, který chcete kalibrovat.

Není-li v seznamu uveden název fluoroforu, zadejte tento název do textového pole a přidejte jej
do seznamu.

4. Vyberte typ destičky pro fluorofor.

Není-li v seznamu uveden typ destičky, zadejte jeho název do textového pole a přidejte jej do
seznamu.

5. Vyberte kanál pro fluorofor.

6. Vyberte sloupec destičky pro fluorofor.

7. (Volitelné) Zadejte barvu, kterou chcete přiřadit fluoroforu.

8. Pro přidání fluoroforu klikněte na položku Add to Plate (Přidat do destičky).

9. (Volitelné) Opakujte kroky 3–8 pro přidání každého fluoroforu, který chcete kalibrovat pro
destičku.
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10. Po dokončení přidávání fluoroforů otevřete kliknutím na položku View Plate (Zobrazit destičku)
okno Pure Dye Plate Display (Zobrazení destičky pro čisté barvivo).

Toto okno použijte jako vodítko pro vkládání barviv do destičky.

11. Připravte si 96jamkovou destičku pro kalibraci barviva:

a. Přidejte pipetou do každé jamky roztok barviva podle vzoru zobrazeného na displeji Pure
Dye Plate Display (Zobrazení destičky pro čisté barvivo).

b. Pro každý fluorofor naplňte do čtyř jamek 50 µl (96jamková destička) roztoku barviva 300 nM.
Všimněte si, že alespoň polovina destičky obsahuje prázdné jamky.

c. Destičku utěsněte těsnící metodou, kterou používáte ve svém experimentu.

12. Umístěte kalibrační destičku do bloku a zavřete víko.

13. V průvodci Dye Calibration (Kalibrace barviva) kliknutím na položku Calibrate (Kalibrovat) a OK
potvrďte, že je destička v bloku.

14. Jakmile software Software CFX Manager Dx dokončí cyklus kalibrace, zobrazí se dialogové
okno. Kliknutím na tlačítko Yes (Ano) dokončete kalibraci a otevřete prohlížeč Dye Calibration
Viewer (Prohlížeč kalibrace barviva).

15. Klepněte na tlačítko OK a okno se zavře.
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Protokol je sada kroků, které jsou prováděny v konkrétním pořadí. V softwaru CFX Manager Dx jsou
všechny kroky přidruženy k možnostem na přístroji. Kroky například instruují přístroj, aby kontroloval
teplotu bloku a víka, udržoval teplotní rozdíl bloku, přečetl destičku nebo provedl analýzu křivky tání.
Každá možnost je stanovena pro různé typy destiček a cyklů.

CFX Manager Dx nabízí dvě možnosti vytváření protokolů: Protocol Editor (Editor protokolu) a
Protocol AutoWriter (Automatický generátor protokolu).

Funkce nástroje Protocol Editor (Editor protokolu) zahrnují následující:

n Standardní ovládací prvky pro rychlé vytváření protokolů

n Schopnost rychle vypočítat gradient pro vybraný počet řádků

n Schopnost rychle vypočítat dobu cyklu pro vybraný typ destičky

n Schopnost upravovat kroky protokolu

n Schopnost ukládat protokoly pro opětovné použití

n Schopnost vytisknout protokol na výchozí tiskárně

Protocol AutoWriter (Automatický generátor protokolu) automaticky generuje přizpůsobený protokol
PCR s kroky horkého startu, počáteční denaturace, hybridizace a prodloužení na základě vámi
zadaných parametrů. Následně můžete zobrazit grafické znázornění návrhu protokolu a tento protokol
upravit, spustit nebo uložit.
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Okno Protocol Editor (Editor protokolu)
Pomocí nástroje Protocol Editor (Editor protokolu) můžete vytvářet, otevírat, kontrolovat a upravovat
protokoly. Ve výchozím nastavení se nástroj Protocol Editor (Editor protokolu) otevře s obecným
protokolem pro destičku s 96 jamkami pro detekci v reálném čase ve dvou krocích.

1. Panel nabídek poskytuje rychlý přístup k příkazům nabídek File (Soubor), Settings
(Nastavení) a Tools (Nástroje).

2. Panel nástrojů umožňuje rychlý přístup k uložení a tisku protokolu, k vložení kroku,
stanovení objemu vzorku a zobrazení předpokládané doby trvání cyklu protokolu.

3. Hlavní podokno obsahuje grafické zobrazení protokolu.

4. V dolním podokně je přehled protokolu.

5. V levém podokně jsou ovládací prvky protokolu, které můžete přidávat, abyste protokol
přizpůsobili svým potřebám.

LEGENDA
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Příkazy nabídky File (Soubor)
Save (Uložit) – uloží aktuální protokol.

Save As (Uložit jako) – uloží aktuální protokol s novým názvem nebo do nového umístění.

Close (Zavřít) – zavře nástroj Protocol Editor (Editor protokolu).

Příkaz nabídky Settings (Nastavení)
Lid Settings (Nastavení víka) – otevře dialogové okno Lid Setting (Nastavení víka), ve kterém
můžete měnit nebo nastavovat teplotu víka.

Příkazy nabídky Tools (Nástroje)
Gradient Calculator (Kalkulačka gradientu) – otevře dialogové okno, ze kterého můžete vybrat typ
bloku pro krok gradientu. Výchozí hodnota je 96 jamek.

Run time Calculator (Kalkulačka doby trvání cyklu) – otevře dialogové okno, ze kterého můžete
vybrat typ destičky a režim skenování, abyste mohli vypočítat odhadovaný čas trvání cyklu v okně Run
Setup (Nastavení cyklu). Výchozí hodnota je 96 jamek, všechny kanály.

Příkazy panelu nástrojů

– uloží soubor aktuálního protokolu.

– vytiskne vybrané okno.

– pomocí tohoto příkazu vyberte, kammají být vloženy kroky vzhledem k
aktuálně vybranému kroku.

– pomocí tohoto příkazu zadáte objem vzorku v µl. Objemy vzorků se liší v
závislosti na typu bloku:

n Pro 96jamkový, hluboký blok je rozsah 0–125 µl.

n Pro 96jamkový blok je rozsah 0–50 µl.
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– zobrazí odhadovanou dobu cyklu na základě kroků protokolu, rychlosti
rampy a typu vybraného bloku.

– zobrazí nápovědu k protokolům.

Ovládací prvky pro úpravu protokolu
Levé podokno okna Protocol Editor (Editor protokolu) nabízí ovládací prvky pro vytváření protokolů.

Každý prvek je tvořen sadou parametrů, které představují kroky protokolu. Každý parametr můžete
upravit nebo je přidávat či odstraňovat tak, abyste protokol přizpůsobili svým potřebám. Tato kapitola
popisuje možnosti těchto ovládacích prvků.

n Insert Step (Vložit krok) – vloží krok před nebo za vybraný krok.
Teplotu a dobu prodlevy můžete upravit v grafickém znázornění
protokolu nebo v přehledu protokolu.

n Insert Gradient (Vložit gradient) – vloží krok Gradient na základě
typu bloku jamek vybraného v kalkulačce gradientu. Rozsah
gradientu můžete upravovat na panelu Gradient, který se otevře po
vložení kroku Gradient.

n Insert GOTO (Vložit GOTO) – vloží krok cyklování (smyčky), který
software upozorní, aby konkrétní kroky v sekvenci opakoval po
stanovený počet cyklů. Opakování začne po dokončení prvního
cyklu. Můžete například software informovat, aby provedl 39

opakování kroků 2–4. Po posledním opakování provede software kroky 2–4 celkem 40krát. Krok
návratu (GOTO) a počet cyklů můžete upravit v grafickém znázornění protokolu nebo v přehledu
protokolu.

n Insert Melt Curve (Vložit křivku tání) – vloží krok čtení křivky tání.

n Insert Plate Read to Step (Vložit čtení destičky do kroku) – přidá povel pro čtení destičky do
vybraného kroku. Při čtení destičky se změří množství fluorescence na konci cyklu. Krok čtení
destičky je obecně posledním krokem smyčky GOTO.

Tip: Po přidání povelu pro čtení destičky do kroku se tlačítko změní na Remove Plate Read
(Odstranit čtení destičky), když tento krok vyberete.

88 | Systémy CFX96 Dx a CFX96 DeepWell Dx



Okno Protocol Editor (Editor protokolu)

n Remove Plate Read (Odstranit čtení destičky) – odstraní povel pro čtení destičky z vybraného
kroku.

Tip: Po odstranění povelu pro čtení destičky z kroku se tlačítko změní na Add Plate Read to
Step (Přidat čtení destičky do kroku), když tento krok vyberete.

n Step Options (Možnosti kroku) – otevře dialogové okno Step Options (Možnosti kroku) a
zobrazí dostupné možnosti pro vybraný krok. Podrobné informace o možnostech kroku jsou
uvedeny v části Možnosti kroku na straně 89.

Tip: Do nabídky Step Options (Možnosti kroku) se rovněž dostanete kliknutím pravým
tlačítkemmyši na krok v grafickém zobrazení.

n Delete Step (Vymazat krok) – vymaže vybraný krok z protokolu.

Možnosti kroku

Otevřete dialogové okno Step Options (Možnosti kroku), zobrazí se vámmožnosti, které můžete
přidat, změnit nebo odstranit z kroku.

n Plate Read (Číst destičku) – je-li toto políčko zaškrtnuto, přidá se do kroku čtení destičky.

n Temperature (Teplota) – stanoví cílovou teplotu pro vybraný krok.

n Gradient – stanoví rozsah gradientu pro krok; rozsah je 1–24 °C.

Poznámka: Gradient pracuje s nejnižší teplotou před blokem (na tomto obrázku řádek H) a
nejvyšší teplotou za blokem (na tomto obrázku řádek A).
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n Increment (Přírůstek) – hodnota zvýšení (nebo snížení) teploty vybraného kroku; tato hodnota
je v každém cyklu přidána k cílové teplotě. Rozsah je ±0,1–10 °C.

Poznámka: Pro snížení teploty zadejte před číselnou hodnotu záporné znaménko (–)
(například −5 °C).

n Ramp Rate (Rychlost ohřevu/ochlazování) – rychlost ohřevu/ochlazování pro vybraný krok;
rozsah závisí na velikosti bloku.

n Time (Doba) – doba prodlevy pro vybraný krok.

n Extend (Prodloužení) – doba, o kterou se vybraný krok prodlouží nebo zkrátí (v sekundách); tato
možnost je v každém cyklu přidána k době prodlevy; rozsah je 1–60 s.

n Beep (Zvukový signál) – je-li toto políčko zaškrtnuto, zazní na konci kroku zvukový signál.

Tip: Pokud zadáte číslo mimo rozsah možnosti, software tuto hodnotu změní na nejbližší
údaj v daném rozsahu.
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Tvorba protokolu v nástroji Protocol Editor (Editor
protokolu)

Pomocí nástroje Protocol Editor (Editor protokolu) můžete vytvářet vlastní soubory protokolu.
Současně můžete upravovat a ukládat již uložené soubory protokolů nebo vzorové soubory protokolů
dodané se softwarem Software CFX Manager Dx.

Abyste vytvořili nový soubor protokolu, postupujte následovně:

n Otevřete soubor protokolu v nástroji Protocol Editor (Editor protokolu).

Tip: V nástroji Protocol Editor (Editor protokolu) můžete otevřít nový nebo stávající protokol.

n Nastavte nový protokol.

n Přidejte do protokolu kroky z podokna s ovládacími prvky pro protokoly.

n Upravte vlastnosti kroků.

n Uložte protokol.

Tip: Informace o tvorbě nového protokolu z již uloženého vzorového souboru protokolu jsou
uvedeny v části Otevření stávajícího protokolu v nástroji Protocol Editor (Editor protokolu) na
straně 93.

Otevření nového souboru protokolu v nástroji Protocol Editor
(Editor protokolu)
CFXManager Dx nabízí více možností otevření nového souboru protokolu:

n Z okna Home (Domů)

n Z dialogového okna Startup Wizard (Průvodce spuštěním)

n Z dialogového okna Run Setup (Nastavení cyklu)

Jak otevřít nový soubor protokolu z okna Home (Domů)

u Vyberte možnost File > New > Protocol (Soubor > Nový > Protokol).

Otevře se okno Protocol Editor (Editor protokolu), které zobrazí výchozí soubor protokolu.

Tip: Informace o nastavení výchozího souboru protokolu jsou uvedeny v části Změna
výchozího nastavení souboru na straně 66.
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Otevření nového souboru protokolu z nástroje Startup Wizard (Průvodce spuštěním)

1. V okně Home (Domů) postupujte následovně, abyste otevřeli nástroj Startup Wizard (Průvodce
spuštěním), pokud ještě není otevřen:

n Vyberte možnosti View > Startup Wizard (Zobrazit > Průvodce spuštěním).

n Na panelu nástrojů klikněte na Startup Wizard (Průvodce spuštěním).

Ve výchozím nastavení nástroj Startup Wizard (Průvodce spuštěním) zobrazí kartu Run Setup
(Nastavení cyklu) s vybraným přístrojem CFX96.

2. V případě potřeby vyberte typ přístroje z rozevíracího seznamu.

3. Jako typ cyklu klikněte na User-defined (Definovaný uživatelem).

Otevře se dialogové okno Run Setup (Nastavení cyklu), na kartě Protocol (Protokol) a zobrazí
výchozí soubor protokolu.

4. Klikněte na Create New (Vytvořit nový).

Otevře se okno Protocol Editor (Editor protokolu), které zobrazí výchozí protokol v reálném čase.

Jak otevřít nový protokol z dialogového okna Run Setup (Nastavení cyklu)

1. V okně Home (Domů) postupujte následovně, abyste otevřeli dialogové okno Run Setup
(Nastavení cyklu):

n Vyberte možnost Run > User-defined Run (Cyklus > Cyklus definovaný uživatelem).

n Na panelu nástrojů klikněte na možnost User-defined Run Setup (Nastavení cyklu
definovaného uživatelem).

Otevře se dialogové okno Run Setup (Nastavení cyklu), na kartě Protocol (Protokol) a zobrazí
výchozí soubor protokolu.

2. Klikněte na Create New (Vytvořit nový).

Otevře se okno Protocol Editor (Editor protokolu), které zobrazí výchozí protokol v reálném čase.
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Otevření stávajícího protokolu v nástroji Protocol Editor (Editor
protokolu)
CFXManager Dx poskytuje soubory protokolu vzorku, které můžete upravovat a ukládat jako vlastní
nové protokoly. Můžete také vytvořit nový protokol z existujícího vlastního protokolu.

Otevření souboru protokolu vzorku

1. V okně Home (Domů) vyberte položky File > Open > Protocol (Soubor > Otevřít > Protokol).

Ve výchozím nastavení se Průzkumník Windows otevře do umístění složky souborů vzorku CFX
Manager Dx.

2. Otevřete složku Sample files (Soubory vzorku). Zobrazí se následující složky:

n ConventionalProtocols (Běžné protokoly) – obsahuje příklady souborů protokolu pro
tradiční analýzu PCR.

n DataFiles (Datové soubory) – obsahuje příklady datových souborů, které můžete použít k
prozkoumání funkcí CFX Manager Dx.

n MeltCalibration (Kalibrace táni) – obsahuje ukázkové soubory protokolů pro použití s
programem Bio-Rad software pro přesnou melt analýzu.

n Plates (Destičky) – obsahuje soubory vzorových destiček.

n RealTimeProtocols (Protokoly v reálném čase) – obsahuje příklady souborů protokolu
pro analýzu PCR v reálném čase.

3. Otevřete složku protokolu pro typ cyklu, který chcete provést, buď ConventionalProtocols (Běžné
protokoly), anebo RealTimeProtocols (Protokoly v reálném čase).

4. Vyberte požadovaný protokol a klikněte na tlačítko Open (Otevřít).

Protokol vzorku se otevře v okně Protocol Editor (Editor protokolu).

5. Vyberte položky File > Save As (Soubor > Uložit jako) a uložte protokol s novým názvem nebo do
nové složky.
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Otevření stávajícího protokolu

1. V okně Home (Domů) postupujte následovně:

n Vyberte položky File > Open > Protocol (Soubor > Otevřít > Protokol), přejděte na cílový
soubor, vyberte ho a klikněte na položku Open (Otevřít).

n Otevřete Startup Wizard (Průvodce spuštěním) a postupujte následovně:

o Chcete-li zobrazený protokol upravit, klikněte na tlačítko Edit Selected (Upravit vybraný).

o Chcete-li upravit jiný existující protokol, klikněte na tlačítko Select Existing (Vybrat
stávající) a přejděte na cílový soubor.

Protokol se otevře v okně Protocol Editor (Editor protokolu).

2. Vyberte položky File > Save As (Soubor > Uložit jako) a uložte protokol s novým názvem nebo do
nové složky.

Nastavení nového protokolu
Tip: Pokud váš soubor protokolu obsahuje požadované parametry (například, pokud upravujete
stávající soubor destičky), můžete tuto část přeskočit. Přejděte na Přidání kroků do protokolu na
straně 96.

Nové soubory protokolu vyžadují následující parametry:

n Typ bloku

n Režim skenování pro zvolený typ bloku

n Teplota víka

n Objem vzorku

Nastavení typu bloku

CFXManager Dx automaticky vypočítává teplotní přírůstky pro kroky gradientu podle typu bloku.

Poznámka: Typ desky nastavený v editoru Protocol Editor (Editor protokolu) musí být stejný jako
destička v reakčním modulu.

Nastavení typu bloku

u V okně Protocol Editor (Editor protokolu) vyberte Tools > Gradient Calculator (Nástroje >
Kalkulačka gradientu) a v rozevíracím seznamu, který se objeví, vyberte příslušný typ destičky.

Výběr režimu skenování pro zvolený typ bloku

Abyste určili dobu cyklu protokolu, vyberte typ cílového bloku a režim skenování.
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Jak vybrat typ bloku a režim skenování

u V okně Protocol Editor (Editor protokolu) vyberte položky Tools > Run time Calculator (Nástroje >
Kalkulačka doby cyklu) a v otevřeném rozevíracím seznamu zvolte vhodný typ destičky a režim
skenování.

Nastavení teploty víka

Software CFX Manager Dx nastaví výchozí teplotu víka 105,0 °C.

Pokud to protokol vyžaduje, můžete změnit výchozí nastavení nebo vypnout ohřívač víka.

Tip: Výchozí teplotu víka můžete změnit v dialogovém okně User Preferences (Uživatelské
předvolby). Viz část Nastavení výchozích parametrů protokolu na straně 68.

Nastavení teploty víka

1. V okně Plate Editor (Editor destiček) vyberte Settings > Lid Settings (Nastavení > Nastavení
víka).

Zobrazí se dialogové okno Lid Settings (Nastavení víka).

2. Postupujte následovně:

n Vyberte User Defined (Uživatelsky definovaná) a do textového pole zadejte hodnotu teploty.

n Vyberte Turn Off Lid Heater (Vypnout ohřívač víka).

3. Dotykem na tlačítko OK změny potvrďte a zavřete dialogové okno.

Nastavení objemu vzorku

Standardně nastavuje CFX Manager Dx objem vzorku pro každou jamku na 25 μl. Rozsah Systém
CFX Dx je však 0–125 µl.

Přístroj používá jeden ze dvou režimů regulace teploty, aby určil, kdy vzorek dosáhne cílové teploty v
protokolu:

n Calculated mode (Vypočítaný režim) – když je objem vzorku nastaven na objem odpovídající
bloku, přístroj vypočítá teplotu vzorku na základě objemu vzorku. Toto je výchozí režim.

n Block mode (Režim bloku) – když je objem vzorku nastaven na nulu (0) μl, přístroj zaznamená
teplotu vzorku stejně jako naměřenou teplotu bloku.

Nastavení objemu vzorku pro konkrétní blok

u V okně Plate Editor (Editor destiček) zadejte správnou hodnotu na panelu nástrojů do textového
pole Sample Volume (Objem vzorku).
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Tip: Výchozí objem vzorku můžete změnit v dialogovém okně User Preferences (Uživatelské
předvolby). Více informací naleznete v části Změna výchozího nastavení souboru na straně 66.

Přidání kroků do protokolu
Jak přidat krok do protokolu

1. Otevřete protokol v okně Protocol Editor (Editor protokolu).

2. Určete, kam chcete nový krok vložit. Na panelu nástrojů vyberte v rozevíracím seznamu Step
(Krok) možnost Before (Před) nebo After (Za).

3. V grafu vyberte krok, před kterým nebo za který chcete vložit nový krok.

4. V levém podokně klikněte na položku Insert Step (Vložit krok).

5. Chcete-li změnit teplotu nebo dobu prodlevy, klikněte na výchozí hodnotu v grafu nebo v přehledu
protokolu a zadejte novou hodnotu.

6. (Volitelné) V levém podokně klikněte na Step Options (Možnosti kroku), otevře se dialogové okno
Step Options (Možnosti kroku), ve kterémmůžete upravovat dostupné možnosti pro vybraný
krok.

Tip: Dialogové okno Step Options (Možnosti kroku) můžete otevřít přes nabídku po kliknutí
pravým tlačítkemmyši na podokno grafu nebo podokno přehledu protokolu.

7. Abyste uložili změny v protokolu, klikněte na OK a následně na Yes (Ano).

Otevře se dialogové okno Save As (Uložit jako)

8. V dialogovém okně Save As (Uložit jako) zadejte název nového souboru protokolu a klikněte na
položku Save (Uložit).
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Vložení kroku Gradient
Jak vložit krok Gradient

1. Ujistěte se, že velikost destičky pro gradient je stejná jako typ bloku přístroje, 96 jamek.

2. Pokud jste tak doposud neučinili, vyberte velikost destičky pro gradient:

Vyberte položky Tools > Gradient Calculator (Nástroje > Kalkulačka gradientu) a zvolte v
rozevíracím seznamu odpovídající typ jamky.

3. Na panelu nástrojů vyberte v rozevíracím seznamu Insert Step (Vložit krok) možnost Before
(Před) nebo After (Za).

4. V grafu nebo na přehledovém panelu vyberte krok, před kterým nebo za který chcete vložit krok
Gradient.

5. Na levém panelu klikněte na Insert Gradient (Vložit gradient). Nový krok Gradient bude v grafu a v
přehledovém podokně zvýrazněn, například:

Teplota každého řádku v gradientu se objeví v tabulce Gradient v pravém podokně.
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6. Při úpravě rozsahu teploty gradientu postupujte následovně:

n Klikněte na výchozí teplotu v grafu nebo v přehledovém podokně a zadejte novou teplotu.

n Klikněte na Step Options (Možnosti kroku) pro zadání rozsahu gradientu v okně Step Options
(Možnosti kroku).

n Změňte hodnotu Range (Rozsah) v tabulce Gradient.

7. Chcete-li upravit dobu prodlevy, klikněte v grafickém nebo textovém zobrazení na výchozí dobu a
zadejte novou hodnotu.

8. Kliknutím na OK a poté na Yes (Ano) změny uložíte.

Vložení kroku GOTO
Poznámka: Krok GOTO nelze vložit do souboru GOTO; nelze vytvořit vnořené smyčky GOTO.

Jak vložit krok GOTO

1. Na panelu nástrojů vyberte v rozevíracím seznamu Insert Step (Vložit krok) možnost Before
(Před) nebo After (Za).

2. V grafu vyberte krok, před kterým nebo za který chcete vložit krok GOTO.

3. V levém podokně klikněte na Insert GOTO (Vložit GOTO).

4. Chcete-li změnit počet kroků GOTO nebo opakování GOTO, vyberte v grafu nebo na
přehledovém panelu výchozí hodnotu a zadejte novou hodnotu.

5. Klepnutím na OK a poté na Yes (Ano) změny uložíte.

Vložení kroku Křivka tání
Tip: Není možné vložit krok Křivka tání dovnitř smyčky GOTO.

Poznámka: Krok Křivka tání obsahuje na začátku 30s prodlevu, která není v protokolu
zobrazena.

Jak vložit krok Křivka tání

1. Na panelu nástrojů vyberte v rozevíracím seznamu Insert Step (Vložit krok) možnost Before
(Před) nebo After (Za).

2. V grafu vyberte krok, před který nebo za který chcete vložit krok Křivka tání.
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3. Na levém panelu klikněte na Insert Melt Curve (Vložit křivku tání). Nový krok Křivka tání bude v
grafu a v přehledovém podokně zvýrazněn, například:

4. Chcete-li upravit rozsah teploty tání nebo dobu přírůstku, vyberte v grafu nebo v přehledovém
podokně výchozí hodnotu a zadejte novou hodnotu.

5. Kliknutím na OK a poté na Yes (Ano) změny uložíte.
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Přidání nebo odstranění čtení destičky
Tip: Po přidání povelu pro čtení destičky do kroku se tlačítko změní na Remove Plate Read
(Odstranit čtení destičky), když tento krok vyberete.

Jak přidat čtení destičky do kroku

1. Na panelu nástrojů vyberte v rozevíracím seznamu Insert Step (Vložit krok) možnost Before
(Před) nebo After (Za).

2. V grafu vyberte krok, před který nebo za který chcete vložit krok čtení destičky.

3. Chcete-li přidat čtení destičky do vybraného kroku, klikněte v levém podokně na možnost Add
Plate Read to Step (Přidat čtení destičky do kroku).

4. Kliknutím na OK a poté na Yes (Ano) změny uložíte.

Jak odstranit čtení destičky z kroku

u V grafu vyberte krok, jenž obsahuje čtení destičky, a v levém podokně klikněte na položku
Remove Plate Read (Odstranit čtení destičky).

Změna možností kroku
Změna možností kroku pro vybraný krok

1. V grafu nebo na přehledovém panelu vyberte cílový krok.

2. V levém podokně klikněte na položku Step Options (Možnosti kroku). Otevře se dialogové okno
Step Options (Možnosti kroku).

Případně klikněte pravým tlačítkemmyši na cílový krok v libovolném podokně a v zobrazené
nabídce vyberte položku Step Options (Možnosti kroku).

3. Přidání, úprava nebo odstranění možností:

n Do příslušného textového pole zadejte hodnotu.

n Upravte hodnotu v konkrétním textovém poli.

n Označte nebo odznačte zaškrtávací políčko.

4. Kliknutím na tlačítko OK uložíte změny a zavřete dialogové okno Step Options (Možnosti kroku).

5. Klepnutím na OK a poté na Yes (Ano) protokol uložíte.
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Výmaz kroku
Vymazání kroku v protokolu

1. V grafu nebo na přehledovém panelu vyberte krok.

2. Chcete-li odstranit vybraný krok, klikněte na levém panelu na možnost Delete Step (Odstranit
krok).

3. Klepnutím na OK a poté na Yes (Ano) protokol uložíte.

Kopírování, export nebo tisk protokolu
Jak kopírovat protokol

u Klikněte pravým tlačítkemmyši na přehled protokolu a vyberte možnost Copy Protocol (Kopírovat
protokol).

Přehled můžete vložit do souboru .txt, .xls, .doc nebo .ppt.

Jak exportovat protokol

1. Klikněte pravým tlačítkemmyši na přehled protokolu a vyberte možnost Export Protocol
(Exportovat protokol).

Otevře se dialogové okno Save As (Uložit jako).

2. (Volitelné) V Průzkumníkovi Windows přejděte do složky, do které chcete soubor protokolu uložit.

3. Do pole File name (Název souboru) zadejte název exportovaného souboru protokolu.

4. Klikněte na Save (Uložit).

Jak vytisknout protokol

u Klikněte pravým tlačítkemmyši na přehled protokolu a vyberte možnost Print (Tisk).

Na své výchozí tiskárně můžete vytisknout přehled protokolu.
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Vytvoření protokolu pomocí nástroje Protocol AutoWriter
(Automatický generátor protokolu)

Důležité: Společnost Bio-Rad neručí za to, že provedení protokolu vytvořeného pomocí nástroje
Protocol AutoWriter (Automatický generátor protokolu) vždy povede k produktu PCR v reálném
čase.

Nástroj Protocol AutoWriter (Automatický generátor protokolu) softwaru CFX Manager Dx
automaticky vytváří protokoly cyklů na základě následujících vstupních parametrů:

n Amplicon length (Délka amplikonu) – předpokládaná délka produktu PCR

n Annealing temperature (Teplota hybridizace) – reakční Ta pro použité primery

Pokud je Ta neznámá, můžete pro její automatický výpočet na základě sekvencí primerů použít
nástroj Ta Calculator (Kalkulačka Ta).

Poznámka: Hodnota Ta je upravena na základě informací o teplotě tání primeru (Tm), která
vychází z vybraného enzymu a rychlosti protokolu.

n Enzyme type (Typ enzymu) – enzym polymeráza DNA (polymeráza iTaq, iProof DNA, nebo
Other (Jiné))

Pokud použijete jiný enzym než iTaq nebo iProof DNA, můžete zadat další informace, včetně
rozsahu gradientu, doby aktivace horkého startu (s) a doby konečného prodloužení (s).

n Run speed (Rychlost cyklu) – rychlost reakce (standardní, rychlá, ultrarychlá)

Nástroj Protocol AutoWriter (Automatický generátor protokolu) optimalizuje protokol podle
vybraného nastavení rychlosti. Celková doba cyklu je určena počtem kroků a cyklů, dobou
inkubace v každém kroku a dobou dosažení homogennosti při cílové teplotě.

Na základě vámi zadaných parametrů a standardních pokynů PCR nástroj Protocol AutoWriter
(Automatický generátor protokolu) automaticky vygeneruje přizpůsobený protokol PCR s kroky
horkého startu, počáteční denaturace, hybridizace a prodloužení. Následně můžete zobrazit grafické
znázornění návrhu protokolu a tento protokol upravit, provést nebo uložit.
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Jak vytvořit nový protokol nástrojem Protocol AutoWriter (Automatický generátor
protokolu) softwaru CFX Manager Dx

1. V okně Home (Domů) vyberte Tools > Protocol AutoWriter (Nástroje > Automatický generátor
protokolu).

Objeví se dialogové okno Protocol AutoWriter (Automatický generátor protokolu).

2. V části Enter Target Values/Enzyme (Zadat cílové hodnoty/enzym) postupujte následovně:

n Zadejte teplotu hybridizace (Ta) pro primery, pokud ji znáte.

Tip: Více informací naleznete v části Použití nástroje Ta Calculator (Kalkulačka Ta) na
straně 104.

Poznámka: Pro informace o výpočtech použitých nástrojem Ta Calculator (Kalkulačka
Ta) viz Breslauer a kol. 1986.

n Zadejte délku amplikonu v párech bází (bp).

n Vyberte typ enzymu ze seznamu možností (polymeráza iTaq DNA, polymeráza iProof DNA
nebo Other (Jiné)).

Tip: Pokud jako typ enzymu zvolíte Other (Jiné), aktivují se parametry v části Additional
Parameters (Optional) (Další parametry (volitelné)).
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3. Jestliže jste jako typ enzymu vybrali Other (Jiné), můžete do protokolu přidávat následující
parametry:

n Rozsah gradientu

n Aktivační teplota horkého startu

n Doba konečného prodloužení

4. V části Type (Typ) přesuňte posuvnou lištu pro výběr rychlosti protokolu (Standard (Standardní),
Fast (Rychlá), Ultrafast (Ultrarychlá)). Software CFX Manager Dx upraví celkovou dobu cyklu.

5. Vyberte prováděný typ PCR (výchozí je Real-time PCR (PCR v reálném čase)).

Při použití PCR v reálném čase přidá software CFX Manager Dx krok čtení destičky pro sběr dat o
fluorescenci.

6. V části Preview (Náhled) protokol zkontrolujte. Podle potřeby můžete provádět změny.

7. Postupujte následovně:

n Kliknutím na OK nový protokol uložíte. Po uložení se protokol otevře v nástroji Startup
Wizard (Průvodce spuštěním). Po kliknutí na položku Edit Selected (Editovat vybrané)
můžete v protokolu provádět změny. Můžete například změnit teplotu víka a objem vzorku.

n Kliknutím na Cancel (Zrušit) okno zavřete bez uložení protokolu.

Použití nástroje Ta Calculator (Kalkulačka Ta)
Je-li teplota hybridizace pro primer neznámá, můžete pro výpočet hodnoty použít nástroj Ta Calculator
(Kalkulačka Ta). Hodnotu můžete použít k vytvoření protokolu v okně Protocol AutoWriter
(Automatický generátor protokolu) nebo Protocol Editor (Editor protokolu).

O nástroji Ta Calculator (Kalkulačka Ta)
Nástroj Ta Calculator (Kalkulačka Ta) počítá hodnotu Tm pro každý primer a hodnotu Ta pro protokol
při standardní rychlosti.

Hodnota Ta pro protokol vychází z průměrných hodnot Tm primerů s použitím následujících pravidel:

n Pokud je rozdíl mezi hodnotami Tm primerů >4 °C, pak Ta = (nižší z obou hodnot Tm primerů + 2)
– 4 °C

n Pokud je rozdíl mezi hodnotami Tm ≤4 °C, pak Ta = (průměr hodnot Tm primeru) – 4 °C
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Metoda počítání párů bází

Pro každý primer používá Ta Calculator (Kalkulačka Ta) metodu počítání párů bází pro sekvence 14
párů bází (bp) nebo méně.

Tm = ((w*A + x*T) * 2) + ((y*G + z*C) * 4)

kde w, x, y a z jsou čísla bází A, T, G, a C v daném pořadí.

Metoda „nejbližších sousedů“

Pro sekvence delší než 14 párů bází (bp) se používá metoda nejbližšího souseda. V metodě
nejbližších sousedů jsou výpočty teploty tání založeny na termodynamickém vztahu mezi entropií
(pořadí nebo míra náhodnosti oligonukleotidu), entalpií (teplo uvolněné nebo absorbované
oligonukleotidem), volnou energií a teplotou.

∆H = ∆G + T* ∆S

kde:

n ∆H = hodnota entalpie, cal/mol*K

n T = teplota, Kelvin

n ∆S = hodnota entropie, cal/mol*K

n ∆G = Gibbsova volná energie v cal/mol*K

Změna entropie a entalpie se vypočítá přímo součtem hodnot pro nukleotidové páry uvedené v
Tabulka 12 (Breslauer et al. 1986).

Vztah mezi volnou energií a koncentrací reaktantů a produktů v rovnováze je dán vztahem:

∆G = R*T*ln ((DNA * Primer)/(DNA + Primer))

kde R je plynová konstanta (1,986 cal/mol*K).

Nahrazení G ve dvou rovnicích a řešení pro T dává

T = ∆H/(∆S + R*Ln((DNA * Primer)/(DNA + Primer)))

za předpokladu, že koncentrace komplexu DNA a DNA-primeru je stejná.

Empiricky bylo stanoveno, že během přechodu z jednovláknové DNA na B-formu existuje 5 kcal volné
energie (3,4 kcal) (Sugimoto et al. 1996). To je pravděpodobně spirálová iniciační energie. Přidání
úpravy pro sůl nakonec dává rovnici, kterou kalkulačka Ta používá:

T = (∆H – 5(kcal/K*mol))/(∆S + (R * ln(1/(primer)))) + 16,6 log10 (SaltMolarity)
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Není nutná žádná konstantní hodnota pro koncentraci soli, protože různé parametry byly stanoveny
při 1 M NaCl a hodnota log10 z 1 je nula.

Termodynamické výpočty předpokládají, že hybridizace probíhá při pH 7,0. Výpočty Tm předpokládají,
že sekvence nejsou symetrické a obsahují alespoň jednu G nebo C.

Oligonukleotidová sekvence by měla být alespoň 14 bází dlouhá, aby poskytla rozumné hodnoty Tm.
Méně než 14 bází používá metody párování základních párů (viz Tabulka 12 níže).

Interakce ∆H ∆S ∆G

AA TT 9,1 24 1,5

AT TA 8,6 23,9 1,5

AC TG 6,5 17,3 1,3

AG TC 7,8 20,8 1,6

TA AT 6 16,9 0,9

TT AA 9,1 24 1,9

TC AG 5,6 13,5 1,6

TG AC 5,8 12,9 1,9

CA GT 5,8 12,9 1,9

CT GA 7,8 20,8 1,6

CC GG 11 26,6 3,1

CG GC 11,9 27,8 3,6

GA CT 5,6 13,5 1,6

GT CA 6,5 17,3 1,3

GC CG 11,1 26,7 3,1

GG CC 11 26,6 3,1

Tabulka 12. Breslauerovy interakční konstanty
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Použití nástroje Ta Calculator (Kalkulačka Ta)

Jak používat nástroj Ta Calculator (Kalkulačka Ta)

1. Abyste otevřeli nástroj Ta Calculator (Kalkulačka Ta), postupujte následovně:

n Pokud se aktuálně nacházíte v nástroji Protocol AutoWriter (Automatický generátor
protokolu), klikněte na Ta Calculator (Kalkulačka Ta).

n V okně Home (Domů) vyberte položky Tools > Ta Calculator (Nástroje > Kalkulačka Ta).

Otevře se dialogové okno Ta Calculator (Kalkulačka Ta).

2. Do textového rámečku Forward Primer (Přímý primer) zadejte nebo vložte sekvenci přímého
primeru.

Tip: Pro zadání sekvence můžete rovněž využít tlačítka A, T, G, C na levé straně
dialogového okna.

3. Do textového rámečku Reverse Primer (Zpětný primer) zadejte nebo vložte sekvenci zpětného
primeru.

4. Klikněte na Calculate (Vypočítat).

Nástroj Ta Calculator (Kalkulačka Ta) vypočítá a zobrazí Tm pro každý primer a průměrné hodnoty
Tm a Ta, například:
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Pokud jsou hodnoty Tm primerů více než 4 °C od sebe, použije nástroj Protocol AutoWriter
(Automatický generátor protokolu) nižší hodnotu Tm primerů + 2 °C jako základ pro výpočet
hodnoty Ta, kterou můžete dále upravit změnou enzymu a rychlosti reakce.

Nástroj Ta Calculator (Kalkukačka Ta) vygeneruje teplotu hybridizace pro standardní rychlost s
polymerázou iTaq DNA. Při použití jiného enzymu nastavení rychlosti automaticky upraví
hodnotu Ta.

5. Postupujte následovně:

n Pokud jste nástroj Ta Calculator (Kalkulačka Ta) otevřeli z nástroje Protocol AutoWriter
(Automatický generátor protokolu), klikněte na OK. Vrátíte se do nástroje Protocol AutoWriter
(Automatický generátor protokolu). Teplota hybridizace se automaticky upraví.

n Pokud jste nástroj Ta Calculator (Kalkulačka Ta) otevřeli z nabídky Tools (Nástroje),
zaznamenejte si výpočty a klikněte na možnost Cancel (Zrušit). Kalkulačka se zavře.
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Soubor destičky obsahuje informace o parametrech cyklu, jako je režim skenování, fluorofory a obsah
jamky. Po spuštění software CFX Manager Dx propojí obsah jamky s fluorescenčními daty
shromážděnými během cyklu a aplikuje příslušnou analýzu v okně Data Analysis (Analýza dat). Pro
vytvoření standardní křivky jsou například použity jamky naplněné standardním typem vzorku.

Software CFX Manager Dx poskytuje dvě možnosti pro vytvoření destiček: Plate Editor (Editor
destiček) pro PCR v reálném čase a Setup Wizard (Průvodce nastavením) pro analýzu normalizované
exprese genu.

Plate Editor (Editor destiček) obsahuje následující funkce:

n Standardní fluorofory a typy vzorků, které mají být přiřazeny jamkám destiček

n Schopnost nastavit referenční cíl a kontrolní vzorek pro analýzu exprese genu

n Schopnost upravovat nastavení destičky před spuštěním cyklu, během cyklu nebo po dokončení
cyklu

n Schopnost ukládat soubory destiček pro opakované použití

n Schopnost vytisknout soubor destičky na výchozí tiskárnu

Setup Wizard (Průvodce nastavením) vás provede vytvořením rozložení destičky pro analýzu
normalizované exprese genu. Setup Wizard (Průvodce nastavením) můžete použít před spuštěním
cyklu, během cyklu nebo po dokončení cyklu.
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Okno Plate Editor (Editor destiček)
Pomocí nástroje Plate Editor (Editor destiček) můžete vytvářet vlastní destičky nebo měnit stávající
destičky.

1. Panel nabídek poskytuje rychlý přístup k příkazům nabídek File (Soubor) a Settings
(Nastavení) i k možnostem nástrojů pro úpravu destiček.

2. Panel nástrojů poskytuje rychlý přístup k důležitým funkcím zakládání destiček.

3. Hlavní podokno obsahuje přehled destičky a možnosti pro destičku, které můžete použít.

4. Pravé podokno obsahuje možnosti, kterými můžete svou destičku přizpůsobit.

5. Spodní podokno zobrazuje typ destičky a poskytuje rychlý přístup k možnostem zobrazení.

LEGENDA
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Příkazy nabídky File (Soubor)
Save (Uložit) – uloží datový soubor destičky do umístění stanoveného na kartě File (Soubor) v
dialogovém okně User Preferences (Uživatelské předvolby). Více informací naleznete v části Změna
výchozího nastavení souboru na straně 66. Tato položka nabídky je dostupná pouze při vytváření
nového souboru destičky.

Save As (Uložit jako) – uloží otevřený soubor destičky s novým názvem, který zadáte. Tato položka
nabídky je dostupná pouze při vytváření nového souboru destičky.

Extract Plate (Extrahovat destičku) – otevře dialogové okno, ve kterémmůžete extrahovat/uložit
soubor destičky (.pltd). Tato položka nabídky je dostupná pouze při zobrazení nebo úpravách
stávajícího souboru destičky.

Print (Tisk) – vytiskne otevřený datový soubor destičky.

Close (Zavřít) – zavře nástroj Plate Editor (Editor destiček).

Příkazy karty Settings (Nastavení)
Plate Size (Velikost destičky) – poskytuje možnosti, ze kterých můžete vybrat velikost destičky pro
daný cyklus.

Poznámka: Systém CFX Dx může používat pouze 96jamkovou destičku.

Plate Type (Typ destičky) – umožňuje vybrat typ jamek na destičce, na které jsou uloženy vzorky,
buď jako BRWhite (BR bílá), nebo BR Clear (BR čirá). Pro přesnou analýzu dat musí být zvolený typ
destičky shodný s typem destičky použitým v cyklu.

Number Convention (Konvence čísel) – umožňuje vybrat nebo zrušit výběr možností zobrazení
jednotek ve vědeckém zápisu. Výchozí nastavení je zobrazení jednotek ve vědeckém zápisu.

Units (Jednotky) – umožňuje vybrat jednotky, které se mají zobrazovat v tabulkách při kvantifikaci
neznámých hodnot oproti standardní křivce.

Příkazy nabídky Editing Tools (Nástroje pro úpravy)
Setup Wizard (Průvodce nastavením) – otevře nástroj Setup Wizard (Průvodce nastavením),
ve kterémmůžete definovat parametry rozložení a analýzy pro aktuální destičku. Nástroj Setup
Wizard (Průvodce nastavením) můžete použít před spuštěním cyklu, během něj i po jeho dokončení.

Spreadsheet View/Importer (Zobrazení/import tabulky) – otevře dialogové okno View (Zobrazit),
které ukazuje rozložení destičky jako šablonu ve formátu tabulky. V tomto dialogovém okně můžete
exportovat nebo importovat data o šabloně destičky ve formátu .csv.

Flip Plate (Otočit destičku) – otočí obsah destičky o 180o.
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Příkazy panelu nástrojů

Uloží aktuální soubor destičky.

Zobrazí rozevírací seznam, ze kterého můžete zvýšit nebo snížit zvětšení
náhledu destičky.

Zobrazí rozevírací seznam, ze kterého můžete vybrat režim skenování, jenž
přístroji řekne, ze kterých kanálů má během cyklu shromažďovat data o
fluorescenci.

Otevře Well Groups Manager (Správce skupin jamek), ve kterémmůžete
vytvářet skupiny jamek pro aktuální destičku.

Zobrazí dialogové okno, ve kterémmůžete zvolit barvy a symboly pro trasy
amplifikace.

Otevře dialogové okno View (Zobrazit), které ukazuje rozložení destičky
jako šablonu ve formátu tabulky. V tomto dialogovém okně můžete
exportovat nebo importovat data o šabloně destičky ve formátu .csv.

Zobrazí nezbytné kroky pro nastavení destičky a založení jamek.
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Vytvoření souboru destičky pomocí Plate Editor (Editor
destiček)

Pomocí nástroje Protocol Editor (Editor destiček) můžete vytvářet vlastní soubory destičky. Můžete
také upravovat a ukládat již uložené soubory destiček nebo soubory vzorku dodané se softwarem
Software CFX Manager Dx.

Abyste vytvořili nový soubor destičky, postupujte následovně:

n Otevřete souboru destičky v nástroji Plate Editor (Editor destiček)

n Vyberte typ destičky.

Poznámka: Typ desky pro soubor destičky musí být stejný jako destička v reakčním modulu.

n Vyberte režim skenování, který má být použit v protokolu.

n Vyberte fluorofory, které se mají použít na destičce.

n Vyberte typy vzorků, cíle a vzorky.

n V případě potřeby vyberte replikáty.

n Uložte uspořádání destičky.

Tip: Chcete-li vytvořit novou destičku z dříve uložených nebo souborů destiček, viz Otevření
stávajícího souboru destičky v nástroji Plate Editor (Editor destiček) na straně 115.

Otevření nového souboru destičky v nástroji Plate Editor (Editor
destiček)
Software CFX Manager Dx nabízí několik možností, jak otevřít nový soubor destičky:

n Z okna Home (Domů)

n Z dialogového okna Startup Wizard (Průvodce spuštěním)

n Z dialogového okna Run Setup (Nastavení cyklu)

Jak otevřít nový soubor destičky z okna Home (Domů)

u Vyberte možnosti File > New > Plate (Soubor > Nový > Destička).

Otevře se okno Plate Editor (Editor destiček), které zobrazí výchozí soubor destičky pro vybraný
přístroj.

Tip: Informace o nastavení vašeho výchozího souboru destičky jsou uvedeny v části Změna
výchozího nastavení souboru na straně 66.
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Jak otevřít nový soubor destičky z nástroje Startup Wizard (Průvodce spuštěním)

1. V okně Home (Domů) postupujte následovně, abyste otevřeli nástroj Startup Wizard (Průvodce
spuštěním), pokud ještě není otevřen:

n Vyberte možnosti View > Startup Wizard (Zobrazit > Průvodce spuštěním).

n Na panelu nástrojů klikněte na položku Startup Wizard (Průvodce spuštěním).

Ve výchozím nastavení nástroj Startup Wizard (Průvodce spuštěním) obsahuje kartu Run Setup
(Nastavení cyklu) s vybraným přístrojem CFX96.

2. V případě potřeby vyberte typ přístroje z rozevíracího seznamu.

3. Pro vytvoření nové destičky klikněte na User-defined (Definovaný uživatelem) jako typ cyklu.

Otevře se dialogové okno Run Setup (Nastavení cyklu), které obsahuje kartu Protocol (Protokol).

4. Klikněte na kartu Plate (Destička) a na možnost Create New (Vytvořit novou).

Otevře se okno Plate Editor (Editor destiček), které zobrazí výchozí rozložení destičky pro
vybraný přístroj.

Jak otevřít nový soubor destičky z dialogového okna Run Setup (Nastavení cyklu)

1. V okně Home (Domů) postupujte následovně, abyste otevřeli dialogové okno Run Setup
(Nastavení cyklu):

n Vyberte možnosti Run > User-defined Run (Cyklus > Cyklus definovaný uživatelem).

n Na panelu nástrojů klikněte na možnost User-defined Run Setup (Nastavení cyklu
definovaného uživatelem).

Otevře se dialogové okno Run Setup (Nastavení cyklu) na kartě Protocol (Protokol).

2. Abyste vytvořili novou destičku, klikněte na kartu Plate (Destička) a na možnost Create New
(Vytvořit novou).

Otevře se okno Plate Editor (Editor destiček), které zobrazí výchozí rozložení destičky pro
vybraný přístroj.
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Otevření stávajícího souboru destičky v nástroji Plate Editor
(Editor destiček)
Software CFX Manager Dx poskytuje soubory destičky vzorku, které můžete upravovat a ukládat jako
vlastní nové destičky. Můžete také vytvořit nový soubor destičky z dříve uloženého souboru destiček.

Otevření souboru destičky vzorku

1. V okně Home (Domů) vyberte položky File > Open > Plate (Soubor > Otevřít > Destička).

Průzkumník Windows se otevře do umístění složky CFX Manager Dx Sample files (Soubory
vzorků).

2. Otevřete složku Sample files (Soubory vzorků) a potom otevře složku Plates (Destičky).

3. Vyberte destičku a klikněte na tlačítko Open (Otevřít).

Otevře se soubor vzorek destičky v okně Plate Editor (Editor destiček).

4. Vyberte položky File > Save As (Soubor > Uložit jako) a uložte soubor destičky s novým názvem
nebo do nové složky.

Otevření předchozího uloženého souboru destičky

1. V okně Home (Domů) vyberte položky File > Open > Plate (Soubor > Otevřít > Destička), přejděte
na cílovou destičku a klikněte na položku Open (Otevřít).

Otevře se cílová destička v okně Plate Editor (Editor destiček).

2. Vyberte File > Save As (Soubor > Uložit jako) a uložte soubor destičky s novým názvem nebo do
nové složky.
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Nastavení nového souboru destičky
Tip: Pokud váš soubor destičky obsahuje požadované parametry (například pokud upravujete
vzorek nebo stávající soubor destičky), můžete tuto část přeskočit. Přejděte na část Přiřazení
volitelných parametrů k souboru destičky na straně 122.

Nové soubory destičky vyžadují následující parametry:

n Velikost destičky

n Typ destičky

n Režim skenování

n Jeden fluorofor (barvivo)

n Jeden typ vzorku

Výběr velikosti a typu destičky

Důležité: Velikost destičky musíte vybrat během nastavení destičky. Během cyklu nebo po něm
nemůžete velikost destičky měnit.

Software použije během cyklu velikost a typ destičky pro všechny jamky. Ujistěte se, že vybraná
velikost destičky je stejná jako destička, kterou při cyklu použijete.

Přístroje CFX96 a CFX96 DeepWell společnosti Bio-Rad jsou ve výrobním závodě kalibrovány pro
mnoho kombinací fluorescenčních barviv a destiček. Kalibrace platí pouze pro daný přístroj, barvivo a
typ destičky. Ujistěte se, že fluorofor, který chcete použít, je pro vybraný typ destičky kalibrován.

Výběr režimu skenování

Systémy CFX96 a CFX96 DeepWell excitují a detekují fluorofory v pěti kanálech. Všechny systémy
používají více režimů snímání dat pro sběr dat fluorescence během cyklu.

Software CFX Manager Dx poskytuje tři režimy skenování:

n All Channels (Všechny kanály)

o Skenuje kanály 1 až 5 na systémech CFX96 a CFX96 DeepWell

n SYBR® /FAM

o Skenuje pouze kanál 1

o Provádí rychlé skenování

n FRET

o Skenuje pouze kanál FRET

o Provádí rychlé skenování
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Výběr fluoroforů

Důležité: Před zahájením cyklu software Software CFX Manager Dx ověří, zda jsou vámi
uvedené fluorofory na destičce kalibrovány pro daný přístroj. Není možné zpracovat destičku,
pokud obsahuje fluorofory, které nebyly pro příslušný přístroj kalibrovány.

Před cyklem musíte založit alespoň jeden fluorofor pro rozložení destičky. V tuto chvíli můžete přidat
potřebné množství fluoroforů, přičemž destička musí obsahovat alespoň jeden. V nabídce Target
Names (Názvy cílů) se vybrané fluorofory objeví jako možnosti pro cíle.

Pomocí dialogového okna Select Fluorophores (Vybrat fluorofory) načtete fluorofory (nebo barviva
destičky) do možností pro založení jamky v nástroji Plate Editor (Editor destiček). Fluorofory, které se
objeví v dialogovém okně Select Fluorophores (Vybrat fluorofory), závisí na vámi vybraném režimu
skenování:

n Všechny kanály

Jsou zobrazeny všechny dostupné fluorofory.

Tip: Můžete přidat nebytný počet fluoroforů, avšak pouze jeden na jeden kanál v každé
jamce.

n SYBR®/FAM

Zobrazí se pouze fluorofory pro kanál 1.

n FRET

Zobrazí se pouze fluorofor pro kanál 6.

Tip: Fluorofor FRET pro kanál 6 bude zobrazen pouze v případě, že je vybraným režimem
skenování FRET. Tato možnost není k dispozici pro režim skenování All Channels (Všechny
kanály).

Poznámka: Není možné fluorofory přímo přidávat nebo odstraňovat z dialogového okna Select
Fluorophore (Vybrat fluorofor). Musíte provést kalibraci nových fluoroforů pro přístroj pomocí
nástroje Calibration Wizard (Průvodce kalibrací). Po kalibraci je nový fluorofor automaticky přidán
do tohoto seznamu.
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Výběr typů vzorků

Důležité: Abyste mohli přiřadit jamky destičky před cyklem, musíte vybrat alespoň jeden typ
vzorku.

Software CFX Manager Dx nabízí pět typů vzorků:

n Unknown (Neznámý)

n Standard (Standardní)

n NTC (Kontrola bez templátu)

n Positive Control (Pozitivní kontrola)

n Negative Control (Negativní kontrola)

n NRT (Bez reverzní transkriptázy)

Typy vzorků přiřazujete jamkám destičky.

Nastavení nové destičky

Nastavení nové destičky

1. Otevřete novou destičku v okně Plate Editor (Editor destiček).

2. Chcete-li nastavit velikost destičky, vyberte Settings > Plate Size (Nastavení > Velikost destičky)
a vyberte příslušnou velikost destičky z rozevírací nabídky.

3. Chcete-li nastavit typ desky, vyberte možnost Settings > Plate Type (Nastavení > Typ destičky) a
v rozevírací nabídce vyberte možnost buď BRWhite (BR bílá), nebo BR Clear (BR čirá).

4. Volitelně můžete v nabídce Settings (Nastavení) změnit konvence čísel a jednotky zobrazení:

n Chcete-li změnit konvenci čísel, vyberte Settings > Number Convention (Nastavení >
Konvence o číslech) a vyberte položku Scientific Notation (Vědecký zápis).

Tip: Ve výchozím nastavení je vybrán Scientific Notation (Vědecký zápis). V tomto
případě výběr Scientific Notation (Vědecký zápis) zruší výchozí nastavení a nastaví
konvenci o číslech do standardní formy.

n Chcete-li změnit jednotky zobrazení, zvolte Settings > Units (Nastavení > Jednotky) a
vyberte novou hodnotu jednotky.

5. Chcete-li nastavit režim skenování, vyberte příslušný režim skenování z rozevíracího seznamu
Scan Mode (Režim skenování) na panelu nástrojů okna Plate Editor (Editor destiček).
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6. Vyberte potřebné fluorofory pro destičku:

a. V pravém podokně klikněte na tlačítko Clear Fluorophores (Vymazat fluorofory).

Zobrazí se dialogové okno Select Fluorophores (Vybrat fluorofory). Uvidíte fluorofory
dostupné pro zvolený režim skenování v Krok 5, příklad:

b. Chcete-li vybrat fluorofor, klikněte na zaškrtávací políčko Selected (Vybrané).

Tip: Chcete-li odstranit fluorofor ze seznamu, klikněte na zaškrtávací políčko Selected
(Vybrané).

c. Chcete-li změnit barvu zobrazení fluoroforu, klikněte na pole Color (Barva).

Poznámka: Vybraná barva reprezentuje fluorofor jak v okně Plate Editor (Editor
destičce), tak v grafu Data Analysis (Analýza dat).

d. V dialogovém okně Color (Barva) vyberte požadovanou barvu nebo klikněte na tlačítko
Define Custom Colors (Definovat vlastní barvy) a vytvořte novou barvu, která bude
představovat fluorofor.

e. Kliknutím na tlačítko OK uložte změny a ukončete dialogové okno Select Fluorophores
(Vybrat fluorofory).
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7. Musíte vybrat alespoň jednu jamku, do které chcete načíst typ vzorku. Ve výchozím nastavení je
vybrána možnost A1.

V podokně tabulky postupujte následovně:

n Chcete-li načíst více sousedních jamek, klikněte na jamku a táhněte až k cílové jamce.

n Chcete-li načíst více nesousedících jamek, podržte klávesu Control a klikněte na každou
jamku.

n Chcete-li načíst celý sloupec se stejným typem vzorku, klikněte na číslo sloupce.

n Chcete-li načíst celý řádek, klikněte na číslo řádku.

n Chcete-li načíst celou destičku, klikněte na levý horní roh destičky.

Například:

8. V rozevírací nabídce Sample Type (Typ vzorku) přiřaďte vybrané jamce nebo jamkám typ vzorku.

9. Přiřaďte alespoň jeden fluorofor do všech jamek, které obsahují typ vzorku. Do jamky nebo
skupiny jamek můžete přiřadit více než jeden fluorofor.
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Poznámka: Na každý kanál můžete přiřadit pouze jeden fluorofor. Nelze přiřadit více než
jeden fluorofor ze stejného kanálu do stejné jamky.

Tip: Fluoroforu můžete přiřadit cíl nebo můžete přiřadit do jamky v tomto okamžiku pouze
fluorofor a po provedení experimentu přiřadit cíl k fluoroforu.

n Chcete-li vybraným jamkám přiřadit pouze fluorofor, v části Target Names (Názvy cíle) v
pravém podokně označte zaškrtávací políčko Load (Načtení) pro konkrétní fluorofor.

n Chcete-li přiřadit fluoroforu cíl, vyberte v části Target Names (Názvy cíle) z rozevíracího
seznamu název cíle pro konkrétní fluorofor. Software automaticky vybere zaškrtávací políčko
Load (Načíst).

10. U jamek, které obsahují typ vzorku Standard (Standardní), musíte načíst koncentraci. Každá
jamka může mít jinou hodnotu koncentrace. Standardně software Software CFX Manager Dx
načítá koncentraci 1,00E+06 do všech jamek s typem vzorku Standard (Standardní). V případě
potřeby můžete hodnotu změnit.

a. V podokně destičky vyberte jamku nebo skupinu jamek Standard (Standardní).

b. V části Concentration (Koncentrace) klikněte na Load (Načíst) a načtěte hodnotu do vybrané
jamky nebo vybraných jamek.

c. (Volitelné) Chcete-li načíst jinou koncentraci, zadejte novou hodnotu do textového pole
Concentration (Koncentrace) a stiskněte klávesu Enter.

d. Tento krok proveďte pro všechny jamky se vzorkem typu Standard (Standardní).

Tip: Pro načtení stejné koncentrace do všech jamek Standard (Standardní) se ujistěte,
že se zobrazuje v rozevíracím seznamu pod hodnotou Concentration (Koncentrace)
možnost <All> (<Všechny>). Pro načtení stejné hodnoty koncentrace do všech jamek se
specifickým fluoroforem klikněte na rozevírací seznam a vyberte fluorofor.

11. Klepnutím na OK novou destičku uložíte.
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Přiřazení volitelných parametrů k souboru destičky
Soubor destičky obsahuje informace o obsahu každé jamky naplněné vzorkem pro cyklus. Po cyklu
software Software CFX Manager Dx propojí obsah jamky s daty o fluorescenci shromážděnými
během protokolu a v okně Data Analysis (Analýza dat) použije příslušnou analýzu.

Pomocí softwaru CFX Manager Dx můžete přiřazovat parametry každé jamce na destičce před
provedením experimentů, během nich nebo i po nich. Parametry můžete přiřadit ke stávajícímu nebo
novému souboru destičky. Tyto parametry zahrnují:

n Target names (Názvy cílů) – zájmový cíl nebo cíle (geny nebo sekvence) v každé založené
jamce.

n Sample names (Názvy vzorků) – identifikátor nebo podmínka, která odpovídá vzorku v každé
založené jamce, například 0hod, 1hod nebo 2hod.

Tip: Názvy cílů a názvy vzorků musejí být mezi jamkami stejné, aby bylo možné srovnávat
data na kartě Gene Expression (Exprese genu) v okně Data Analysis (Analýza dat). Každý
název musí obsahovat stejná velká písmena, interpunkci a mezery. Například „Actin“ není
totéž jako „actin,“ „2Hr“ není totéž jako „2 hr.“ a „Mouse 1“ není totéž jako „mouse1.“ Aby byly
zajištěny konzistentní názvy, zadávejte je v části Libraries (Knihovny) v nabídce User > User
Preferences > Plate (Uživatel > Uživatelské předvolby > Destička), která je k dispozici v okně
Home (Domů).

n Biological sets (Biologické soubory) – identifikátor nebo podmínka, která odpovídá souboru
jamek.

n Replicates (Replikace) – každá jamka použitá k analýze stejné kombinace vzorku a cíle/cílů; tj.
reakce qPCR replikace.

n Dilution series (Série ředění) – množství nutné pro změnu koncentrace typu vzorku Standard
(Standardní) ve skupině replikací, aby se vytvořila data pro standardní křivku k analýze.

Přiřazení cíle jamkám
Tip: Jedné nebo několika jamkámmůžete přiřadit stejný název cíle. Rovněž můžete přiřadit
několik cílů jedné jamce.

Jak přiřadit cíl jamce nebo skupině jamek

1. V nástroji Plate Editor (Editor destiček) se ujistěte, že je jamce nebo skupině jamek přiřazen typ
vzorku.

Další informace o přiřazení typů vzorku jamkám jsou uvedeny v části Výběr typů vzorků na straně
118.
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2. Na panelu destiček vyberte jamku nebo skupinu jamek:

n Chcete-li vybrat jednu jamku, klikněte na ni.

n Chcete-li vybrat více sousedních jamek, klikněte na jamku a táhněte až k cílové jamce.

n Chcete-li vybrat více nesousedících jamek, podržte klávesu Control a klikněte na každou
jamku.

n Chcete-li vybrat celý sloupec se stejným typem vzorku, klikněte na číslo sloupce.

n Chcete-li vybrat celý řádek, klikněte na číslo řádku.

3. V pravém podokně vyberte z rozevíracího seznamu Target Name (Název cíle) název pro každý
vybraný fluorofor.

4. Opakujte Krok 3 pro každou jamku nebo skupinu jamek, kterým musíte přiřadit cíl.

Tip: Každému vybranému fluoroforu můžete přiradit stejný nebo odlišný název cíle.

5. Klikněte na OK, abyste potvrdili změny a uložili destičku.

Jak odstranit název cíle

u Abyste odstranili název cíle z vybrané jamky nebo skupiny jamek, odznačte její zaškrtávací
políčko Load (Načíst).

Důležité: Odstraněním názvu cíle z jamky se rovněž odstraní příslušný fluorofor. Při
odstraňování názvu cíle z jamky postupujte opatrně.
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Jak přidat název cíle do seznamu

u Chcete-li do rozevíracího seznamu přidat název cíle, postupujte následovně:

n Do rozevíracího seznamu Target Name (Název cíle) zadejte název a stiskněte Enter.

Tip: Názvy cílů, které přidáte do jednoho seznamu, se objeví ve všech ostatních
seznamech cílů.

n Klikněte na zelený symbol + napravo od rozevíracího seznamu, zadejte název pro cíl a
stiskněte Enter.

n Na panelu nástrojů klikněte na položku User Preferences (Uživatelské předvolby) a přidejte
název do knihovny Target Names (Názvy cílů) na kartě Plate (Destička).

Důležité: Názvy cílů, které jste přidali do rozevíracího seznamu, budou dostupné pouze pro
aktuální destičku a pouze v případě, že název přiřadíte k jamce a uložíte rozvržení destičky.
Pokud název nepřiřadíte k jamce a neuložíte rozvržení destičky, název se neuloží a nebude v
budoucnu dostupný. Chcete-li název cíle přidat natrvalo, přidejte jej také do knihovny Target
Names (Názvy cílů) pomocí dialogového okna User Preferences (Uživatelské předvolby).
Názvy, které přidáte do knihovny, budou k dispozici, když znovu otevřete Plate Editor (Editor
destiček). Více informací naleznete v části Nastavení výchozích parametrů destičky na
straně 69.

Jak odstranit název cíle ze seznamu

1. Na panelu nástrojů klikněte na položku User Preferences (Uživatelské předvolby).

Dialogové okno User Preferences (Uživatelské předvolby) zobrazí kartu Plate (Destička).

2. V knihovně Target Names (Názvy cílů) na kartě Plate (Destička) vyberte název, který chcete
odstranit, a stiskněte tlačítko Delete (Odstranit).

3. Klikněte na OK, abyste změny uložili a opustili jste dialogové okno User Preferences (Uživatelské
předvolby).

Důležité: Názvy cílů, které jste uložili se souborem destičky, nelze odstranit. Vlastní názvy,
které přidáte do rozevíracího seznamu Target Names (Názvy cílů), nepoužijete je a neuložíte
je s destičkou, jsou ze seznamu automaticky odstraněny. Názvy, které odstraníte z knihovny
Target Names (Názvy cílů), jsou ze softwaru trvale odstraněny a uživatelům již nejsou k
dispozici. Při odstraňování názvů cílů postupujte opatrně.
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Přiřazení názvu vzorku jamkám
Poznámka: Pro přiřazení názvu vzorku musíte vybraným jamkám přiřadit alespoň jeden
fluorofor. Pokud vybraným jamkám není přiřazen fluorofor, rozevírací seznam Sample Names
(Název vzorku) bude neaktivní. Další informace o přiřazení fluoroforů naleznete v části Přiřazení
cíle jamkám na straně 122.

Tip: Ke každé jamce nebo skupině jamek můžete přiřadit pouze jeden název vzorku.

Přiřazení názvu vzorku k jamce nebo skupině jamek

1. V nástroji Plate Editor (Editor destiček) zkontrolujte, zda byl jamce nebo skupině jamek přiřazen
fluorofor.

2. V podokně destiček vyberte jamku nebo skupinu jamek.

3. V pravém podokně vyberte z rozevíracího seznamu název Sample Names (Název vzorku).

4. Opakujte Krok 3 pro každou jamku nebo skupinu jamek, kterým musíte přiřadit název vzorku.

5. Klikněte na tlačítko OK, aby se potvrdily změny a uložila destička.

Odstranění názvu vzorku

u K odstranění názvu vzorku z vybrané jamky nebo skupiny jamek zrušte zaškrtnutí políčka Load
(Načíst).
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Přidání názvu vzorku do seznamu

u Chcete-li do rozevíracího seznamu přidat název vzorku, postupujte následovně:

n Do rozevíracího seznamu Sample Names (Název vzorku) zadejte název a stiskněte Enter.

n Klikněte na zelený symbol + napravo od rozevíracího seznamu a zadejte název pro vzorek.

n Na panelu nástrojů klikněte na položku User Preferences (Uživatelské předvolby) a přidejte
název do knihovny Sample Names (Název vzorku) na kartě Plate (Destička).

Důležité: Název vzorku, který jste přidali do rozevíracího seznamu, bude dostupný pouze
pro aktuální destičku a pouze v případě, že název přiřadíte k jamce a uložíte rozvržení
destičky. Pokud název nepřiřadíte k jamce a neuložíte rozvržení destičky, název se neuloží a
nebude v budoucnu dostupný. Chcete-li trvale přidat název vzorku, přidejte ho také do
knihovny Sample Names (Název vzorku) pomocí dialogového okna User Preferences
(Uživatelské předvolby). Názvy, které přidáte do knihovny, jsou k dispozici poté, co znovu
otevřete Plate Editor (Editor destiček). Více informací naleznete v části Nastavení výchozích
parametrů destičky na straně 69.

Odstranění názvu vzorku ze seznamu

1. Na panelu nástrojů klikněte na položku User Preferences (Uživatelské předvolby).

Dialogové okno User Preferences (Uživatelské předvolby) zobrazí kartu Plate (Destička).

2. V knihovně Sample Names (Název vzorku) na kartě Plate (Destička) vyberte název, který chcete
odstranit, a stiskněte tlačítko Delete (Odstranit).

3. Klikněte na OK, aby se změny uložily, a opusťte dialogové okno User Preferences (Uživatelské
předvolby).

Důležité: Názvy vzorku, které jste uložili se souborem destičky, nelze odstranit. Vlastní
názvy, které přidáte do rozevíracího seznamu Sample Names (Název vzorku) a nepoužíváte
a uložíte je s destičkou, jsou automaticky odstraněny ze seznamu. Názvy, které odstraníte z
knihovny Sample Names (Název vzorku), jsou ze softwaru trvale odstraněny a uživatelům již
nejsou k dispozici. Při odstraňování názvů vzorku buďte opatrní.

Přiřazení biologických souborů jamkám
Poznámka: Pro přiřazení biologického souboru musíte vybraným jamkám přiřadit alespoň jeden
fluorofor. Přiřazení fluoroforu aktivuje rozevírací seznam Biological Set Name (Název
biologického souboru). Další informace o přiřazení fluoroforů naleznete v části Přiřazení cíle
jamkám na straně 122.

Tip: Ke každé jamce nebo skupině jamek můžete přiřadit jeden biologický soubor.
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Přiřazení biologického souboru k jamce nebo skupině jamek

1. V možnostech View (Zobrazení) ve spodní části okna Plate Editor (Editor destiček) zaškrtněte políčko
Biological Set (Biologický soubor).

2. V nástroji Plate Editor (Editor destiček) zkontrolujte, zda byl jamce nebo skupině jamek přiřazen
fluorofor.

3. V podokně destiček vyberte jamku nebo skupinu jamek.

4. V pravém podokně proveďte výběr z rozevíracího seznamu Biological Set Name (Název
biologického souboru).

Software CFX Manager Dx automaticky zaškrtne políčko Load (Načíst).

5. Opakujte Krok 4 pro každou jamku nebo skupinu jamek, kterým musíte přiřadit biologický soubor.

6. Klikněte na tlačítko OK, aby se potvrdily změny a uložila destička.

Tip: Přiřazení názvů biologických souborů k jamkám povolí možnosti Biological Set Analysis
Options (Možnosti nastavení biologického souboru) v dialogovém okně Experiment Settings
(Nastavení experimentu), ve kterémmůžete provést analýzu vzorků v jedné ze čtyř
konfigurací. Více informací naleznete v části Změna nastavení experimentu na straně 133.

Odstranění biologického souboru

u K odstranění biologického souboru z vybrané jamky, zrušte zaškrtnutí políčka Load (Načíst).

Přidání biologického souboru do seznamu

u Chcete-li do rozevíracího seznamu přidat biologický soubor, napište název do rozevíracího
políčka Biological Set Name (Název biologického souboru) a stiskněte Enter.

Důležité: Názvy biologických souborů, které jste přidali do rozevíracího seznamu, budou
dostupné pouze pro aktuální destičku a pouze v případě, že název přiřadíte k jamce a uložíte
rozvržení destičky. Pokud název nepřiřadíte k jamce a neuložíte rozvržení destičky, název se
neuloží a nebude v budoucnu dostupný.
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Zobrazení všech biologických souborů na destičce

u Zaškrtněte políčko Biological Set (Biologický soubor) v možnostech View (Zobrazení) ve spodní
části okna Editor.

Všechny jamky zobrazují příslušný název biologického souboru, pokud je přiřazen. V pravém
podokně se zobrazí ovládací prvek Biological Set Name (Název biologického souboru).

Chcete-li skrýt biologické soubory, zrušte zaškrtnutí políčka Biological Set (Biologický soubor) v
možnostech View (Zobrazení).

Přiřazení čísel replikátů jamkám
Důležité: Pro přiřazení čísel replikátů musí vybrané jamky mít totožný obsah jamky. To znamená,
že vybrané jamky musí mít stejný typ vzorku a fluorofor. Je-li to možné, musí jim být rovněž
přiřazeny stejné názvy cíle a vzorku a stejný biologický soubor. Pokud nejsou stejné, software
Software CFX Manager Dx tuto možnost nepovolí.

Jak přiřadit čísla replikace skupině jamek

1. V nástroji Plate Editor (Editor destiček) se ujistěte, že je obsah skupiny jamek totožný.

2. V podokně destičky vyberte cílovou skupinu jamek.

3. Abyste přiřadili stejné číslo replikace všem vybraným jamkám, zadejte do rámečku v části
Replicate # (Číslo replikace) v pravém podokně číslo replikace a vyberte možnost Load (Načíst).

4. (Volitelné) Jak použít sérii replikací pro soubor vybraných jamek:

a. Klikněte na Technical Replicates (Technické replikace) Replicate Series (Série replikací).
Část Replicate # (Číslo replikace) se změní a zobrazí následující možnosti:
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n Replicate size (Velikost replikace) – číslo představující počet jamek v každé skupině
replikací

n Starting replicate # (Počáteční číslo replikace) – první číslo v sérii replikací pro
vybranou skupinu replikací

Poznámka: Ve výchozím nastavení zobrazuje software Software CFX Manager Dx
počáteční číslo replikace, které je o jedno větší než poslední číslo replikace přiřazené na
destičce. Například jestliže je poslední číslo replikace na destičce pět, příští počáteční
číslo bude šest. Počáteční číslo můžete změnit na libovolné číslo, které zatím není
přiřazeno.

n Směr založení (vodorovný nebo svislý)

b. Kliknutím na Apply (Použít) použijete parametry na sérii a vrátíte se na obrazovku Replicate
# (Číslo replikace).

5. Klikněte na OK, abyste potvrdili změny a uložili destičku.

Jak odstranit jamku ze série replikací

u Vyberte jamku nebo skupinu jamek, kterou chcete odstranit, a odznačte zaškrtávací políčko
Replicate # Load (Načíst číslo replikace).

Případně můžete kliknout na Clear Replicate # (Vymazat číslo replikace), abyste vymazali číslo
replikace z vybrané jamky nebo skupiny jamek.

Přiřazení série ředění standardním typům vzorků
Jak bylo uvedeno výše, musí být všem jamkám se vzorkem typu Standard (Standardní) přiřazena
hodnota koncentrace. Série ředění můžete přiřadit více jamkám s typem vzorku Standard
(Standardní).

Poznámka: Pro přiřazení série ředění do skupiny jamek musí být jamky zahrnuty v sériích
replikací. Další informace o přidávání jamek k sériím replikací naleznete v části Přiřazení čísel
replikátů jamkám na straně 128.
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Přiřazení série ředění skupině standardních jamek se vzorky

1. V nástroji Plate Editor (Editor destiček) zajistěte splnění následujících požadavků:

n Typ vzorku pro skupinu jamek je Standard (Standardní).

n Všem jamkám ve skupině je přiřazen alespoň jeden fluorofor a všechny obsahují stejné
fluorofory.

n Všechny jamky ve skupině jsou zahrnuty ve stejné sérii replikací.

Poznámka: Software CFX Manager Dx aktivuje možnost Dilution Series (Série ředění)
pouze, pokud vybrané jamky splňují tato kritéria.

2. V podokně destiček vyberte cílovou skupinu jamek.

3. V části Concentration (Koncentrace) v pravém podokně klikněte na položku Dilution Series (Série
ředění). V části Concentration (Koncentrace) se zobrazí následující možnosti:

n Starting concentration (Počáteční koncentrace) – hodnota koncentrace, ze které série
začíná

n Replicates from and to (Replikuje se z a do) – replikace v sérii, na kterou se použije
faktor ředění

n Dilution factor (Faktor ředění) – množství, které změní koncentraci v každé skupině
replikací

4. Nastavte hodnoty možností, nebo potvrďte výchozí hodnoty.

5. Ve výchozím nastavení se série ředění snižuje o faktor ředění. Pro zvětšení série ředění vyberte
možnost Increasing (Zvětšení).
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6. (Nepovinné) Ve výchozím nastavení se faktor ředění vztahuje na všechny fluorofory v sérii
replikací. Pokud vaše série obsahují více než jeden fluorofor a chcete ředění aplikovat na jeden
fluorofor, vyberte jej z rozevíracího seznamu.

7. Klikněte na Apply (Použít), chcete-li použít série ředění na skupinu jamek a vrátit se na zobrazení
Concentration (Koncentrace).

8. Klikněte na tlačítko OK, aby se potvrdily změny a uložila destička.

Kopírování obsahu jamky do jiné jamky
Obsah jamky můžete kopírovat a vložit jej do jedné nebo několika jamek. Můžete ale kopírovat pouze
obsah jedné jamky. Není možné vybrat více jamek a kopírovat jejich obsah.

Jak zkopírovat obsah jamky do jiné jamky

1. V podokně destiček vyberte jamku, kterou chcete kopírovat.

2. Klikněte pravým tlačítkemmyši na jamku a vyberte možnost Copy Well (Kopírovat jamku).

3. Vyberte jamku nebo jamky, do kterých chcete obsah vložit:

n Chcete-li vybrat jednu jamku, klikněte na ni.

n Chcete-li vybrat více sousedních jamek, klikněte na jamku a přetáhněte ji do cílové jamky.

n Chcete-li vybrat více nesousedících jamek, podržte klávesu Control a klikněte na každou
jamku.

4. Když jsou cílové jamky vybrány, klikněte pravým tlačítkemmyši a vyberte možnost Paste Well
(Vložit jamku).

Software Software CFX Manager Dx vloží obsah první jamky do vybraných jamek.

Přidání poznámky k jamce
Můžete k jamce přidávat popisné poznámky. Poznámky k jamce můžete zobrazit na kartě
Quantification (Kvantifikace) v okně Data Analysis (Analýza dat).

Jak přidat poznámku k jamce

1. V podokně destiček vyberte jamku nebo jamky, ke kterém chcete přidat poznámku.

2. V části View (Zobrazit) v dolním podokně vyberte možnost Well Note (Poznámka k jamce).

V pravém podokně se objeví oblast Well Note (Poznámka k jamce).
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3. Do textového rámečku zadejte obsah poznámky a stiskněte Enter.

Text se objeví ve spodní části vybraných jamek.

Tip: Pokud jste již poznámku k jamce vytvořili, můžete ji vybrat v rozevíracím seznamu a
použít ji pro vybrané jamky.

Výmaz veškerého obsahu jamky
Můžete vymazat individuální jamku, skupinu jamek nebo veškerý obsah destičky. Výmaz jamek
neodstraňuje data fluorescence shromážděná během čtení destičky.

Výmaz jamky trvale odstraní obsah z jamky. Při odstraňování jamek buďte opatrní.

Výmaz veškerého nastavení jamky

1. V editoru Plate Editor (Editor destiček) vyberte jamku nebo skupinu jamek v podokně destičky:

n Chcete-li vybrat jednu jamku, klikněte na jamku.

n Chcete-li vybrat více sousedních jamek, klikněte na jamku a táhněte až k cílové jamce.

n Chcete-li vybrat více nesousedících jamek, podržte klávesu Control a klikněte na každou
jamku.

n Chcete-li vybrat celý sloupec se stejným typem vzorku, klikněte na číslo sloupce.

n Chcete-li vybrat celý řádek, klikněte na číslo řádku.

2. V pravém podokně klikněte na tlačítko Clear Wells (Vymazat jamky).

Software CFX Manager Dx vymaže všechna nastavení vybraných jamek.

3. Klikněte na OK, aby se potvrdily změny a uložila destička.
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Změna nastavení experimentu
Pomocí dialogového okna Experiment Settings (Nastavení experimentu) můžete zobrazit nebo měnit
seznam cílů nebo vzorků, popř. vybrat skupinu pro analýzu exprese genu a možnost analýzy, pokud
jste jamkám na destičce přiřadili biologické soubory.

V dialogovém okně Experiment Settings (Nastavení experimentu) obsahuje karta Targets (Cíle)
seznam názvů cílů pro každou reakci PCR, například cílový gen nebo zájmové sekvence genů.

Karta Samples (Vzorky) obsahuje seznam názvů vzorků, který uvádí zdroj cíle, například vzorek
odebraný po 1 hodině (1 h) nebo od konkrétní osoby (myš1).

Jak změnit nastavení destiček v dialogovém okně Experiment Settings (Nastavení
experimentu)

1. Abyste otevřeli dialogové okno Experiment Settings (Nastavení experimentu), postupujte
následovně:

n V pravém podokně nástroje Plate Editor (Editor destiček) klikněte na položku Experiment
Settings (Nastavení experimentu).

n Na kartě Gene Expression (Exprese genu) v okně Data Analysis (Analýza dat) klikněte na
položku Experiment Settings (Nastavení experimentu).

Otevře se dialogové okno Experiment Settings (Nastavení experimentu) s obsahem karty Targets
(Cíle).
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2. Abyste přidali nový název cíle nebo vzorku, na příslušné kartě zadejte název do textového
rámečku New (Nový) a klikněte na Add (Přidat).

3. Abyste odstranili jeden nebo několik názvů cíle nebo vzorku ze seznamu, na příslušné kartě
označte zaškrtávací políčko položky v sloupci Select to Remove (Vybrat k odstranění) a klikněte
na položku Remove checked item(s) (Odstranit označené položky).

4. Software CFX Manager Dx vyloučí typ vzorku NTC (kontrola bez templátu) z analýzy exprese
genu.

Pro zařazení typu vzorku NTC odznačte jeho zaškrtávací políčko v části Exclude the following
sample types (Vyloučit následující typy vzorků). Pomocí příslušných zaškrtávacích políček
můžete vyloučit následující typy vzorků:

n NRT (Bez reverzní transkriptázy)

n Negative Control (Negativní kontrola)

n Positive Control (Pozitivní kontrola)

n Standard (Standardní)
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5. Na kartě Targets (Cíle):

a. Pokud chcete vybrat cíl jako referenci pro analýzu dat exprese genu, vyberte jej ve sloupci
Reference.

b. Pokud chcete skrýt nastavení, které bude použito na kartě Gene Expression (Exprese genu)
v okně Analysis Settings (Nastavení analýzy), odznačte položku Show Analysis Settings
(Zobrazit nastavení analýzy).

Software skryje následující sloupce:

n Color (Barva)

n Show Chart (Zobrazit graf)

n Auto Efficiency (Automatická účinnost)

n Efficiency (%) (Účinnost (%))

c. Chcete-li změnit barvu cíle zaneseného do grafu Gene Expression (Exprese genu), klikněte
na jeho buňku ve sloupci Color (Barva), vyberte v otevřeném dialogovém okně Color (Barva)
novou barvu a klikněte na OK.

d. Chcete-li zobrazit cíl vybranou barvou v grafu Gene Expression (Exprese genu), označte
jeho zaškrtávací políčko v sloupci Show Chart (Zobrazit graf).

e. Software CFX Manager Dx ve výchozím nastavení automaticky vypočítá relativní účinnost
pro cíl, pokud jeho data obsahují standardní křivku.

Chcete-li použít již stanovenou hodnotu účinnosti, zadejte hodnotu do příslušné buňky v
sloupci Efficiency (%) (Účinnost (%)) a stiskněte klávesu Enter. Software CFX Manager Dx
odznačí zaškrtávací políčko Auto Efficiency (Automatická účinnost).

6. Na kartě Samples (Vzorky):

a. Chcete-li vybrat vzorek jako kontrolní vzorek pro analýzu dat exprese genu, označte její
zaškrtávací políčko v sloupci Control (Kontrola).

b. Chcete-li přiřadit kontrolní podmínku k vzorku pro cyklus, klikněte na její zaškrtávací políčko
v sloupci Control (Kontrola).

c. Klikněte na možnost Show Analysis Settings (Zobrazit nastavení analýzy), pokud ještě není
vybrána, abyste zobrazili nebo změnili parametry analýzy, které budou použity na kartě
Gene Expression (Exprese genu). Software skryje sloupce Color (Barva) a Show Chart
(Zobrazit graf).
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7. Pokud jste k jamkám na destičce přiřadili jeden nebo více biologických souborů (viz Přiřazení
biologických souborů jamkám na straně 126), vyberte ze seznamu Biological Set Analysis Options
(Možnosti analýzy biologických souborů) jednu z následujících možností:

n Target vs. Sample (Cíl vs. vzorek) – ve výpočtech exprese genu se použije pouze název
vzorku v jamce.

n Target vs. Biological Set (Cíl vs. biologický soubor) – ve výpočtech se použije pouze
název biologického souboru.

n Target vs. Sample_Biological Set(Cíl vs. vzorek, biologický soubor) – ve výpočtech se
použije jeden název tvořený kombinací názvu vzorku a názvu biologického souboru.

n Target vs. Biological Set_Sample (Cíl vs. biologický soubor, vzorek) – ve výpočtech se
použije jeden název tvořený kombinací názvu biologického souboru a názvu vzorku.

8. Kliknutím na OK uložíte parametry v dialogovém okně Experiment Settings (Nastavení
experimentu) a vrátíte se do okna Plate Editor (Editor destiček).

Vytvoření skupin jamek
Skupiny jamek rozdělují jednu destičku do podskupin jamek, které lze analyzovat nezávisle v okně
Data Analysis (Analýza dat). Po nastavení skupin jamek vyberte v okně Data Analysis (Analýza dat)
jednu z nich, abyste mohli data analyzovat jako nezávislou skupinu. Například nastavte skupiny jamek
pro analýzu více experimentů prováděných na jedné destičce nebo pro analýzu každé skupiny jamek
s jinou standardní křivkou.

Poznámka: Výchozí skupina jamek je All Wells (Všechny jamky).

Vytvoření skupin jamek

1. Chcete-li otevřít sekci Well Groups Manager (Správce skupin jamek), postupujte následovně:

n V panelu nástrojů Plate Editor (Editor destiček) klikněte na položku Well Groups (Skupiny
jamek).

n V okně Data Analysis (Analýza dat) klikněte na položku ManageWell Groups (Správce
skupin jamek).
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Zobrazí se dialogové oknoWell Groups Manager (Správce skupin jamek).

2. Kliknutím na tlačítko Add (Přidat) vytvoříte novou skupinu. Rozevírací nabídka zobrazuje název
skupiny jako Group 1 (Skupina 1) pro první vytvořenou skupinu.

3. Vyberte jamky pro skupinu jamek v zobrazení destičky kliknutím a přetažením přes skupinu
jamek. Vybrané jamky se objeví ve okně Manager (Správce) modře.

4. (Volitelné) Chcete-li změnit název skupiny, vyberte její jméno v rozevírací nabídce a zadejte nový
název.

5. (Volitelné) Chcete-li odstranit skupinu jamek, vyberte její název v rozevíracím seznamu a klikněte
na tlačítko Delete (Odstranit).

6. Kliknutím na tlačítko OK dokončete a zavřete okno nebo kliknutím na tlačítko Cancel (Zrušit) okno
zavřete bez provedení změn.

Důležité: Chcete-li zobrazit skupiny jamek, vyberte Well Groups (Skupiny jamek) v možnosti
View (Zobrazit) v dolní části okna Plate Editor (Editor destiček).
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Položky nabídky po kliknutí pravým tlačítkem myši pro dialogové okno Well
Groups Manager (Správce skupin jamek)

Tabulka 13 obsahuje seznam položek nabídky dostupných v dialogovém okněWell Groups Manager
(Správce skupin jamek) poté, když kliknete pravým tlačítkemmyši na jakoukoliv jamku.

Položka Funkce

Copy (Kopírovat) Zkopíruje obsah jamky, který pak může být vložen do
jiných jamek.

Copy as Image (Kopírovat jako
obrázek)

Zkopíruje zobrazení nástroje pro výběr jamek jako
obrázek.

Print (Tisk) Vytiskne zobrazení nástroje pro výběr jamek.

Print Selection (Vytisknout
výběr)

Vytiskne pouze vybrané buňky.

Export to Excel (Export do
aplikace Excel)

Exportuje data do tabulky Excel.

Export to Csv (Export do
souboru CSV)

Exportuje data jako dokument oddělený čárkami.

Export to Xml (Export do
souboru XML)

Exportuje data jako dokument ve formátu .xml.

Export to Html (Export do
souboru HTML)

Exportuje data jako dokument ve formátu .html.

Tabulka 13. Položky v dialogovém okně Plate Editor Well Selector (Nástroj pro výběr
jamek, Editor destiček) po kliknutí pravým tlačítkem myši
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Změna stylů trasování
Během nastavení destičky a během probíhajícího cyklu můžete měnit barvu a styl tras pro amplifikaci.
Když jsou data shromažďována, můžete snadno zobrazit trasy v stavovém okně v reálném čase.

Změna stylů trasování

1. Klikněte na Trace Styles (Styly trasování) v panelu nástrojů Plate Editor (Editor destiček).

Zobrazí se dialogové okno Trace Styles (Styly trasování) pro otevřenou destičku, například:

2. Chcete-li zobrazit styly trasování konkrétním fluoroforem, vyberte jej z rozevíracího seznamu
Fluorophores (Fluorofory).

3. Změna zobrazení trasování:

a. Vyberte typ trasování z rozevíracího seznamuWells (Jamky).

b. Klikněte na její barvu ve sloupci Color (Barva).

c. V zobrazeném dialogovém okně Color (Barva) vyberte jinou barvu trasování a klikněte na
tlačítko OK.

Změna typu jamky se objeví v tabulce níže.

d. (Volitelné) V rozevíracím seznamu Symbols (Symboly) vyberte symbol trasování.

4. Chcete-li sadu barev rychle změnit, klikněte na příslušnou volbu v části Color Quick Set (Rychlé
nastavení barev).

5. Chcete-li zobrazit štítky v mřížce, vyberte typ štítku v části Well Labels (Štítky jamek).

6. Klepnutím na tlačítko OK uložte změny nebo zrušte změny stisknutím tlačítka Cancel (Zrušit).
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Zobrazení destičky ve formátu tabulky
Nástroj Spreadsheet View/Importer (Zobrazení/Import tabulky) zobrazuje obsah destičky ve formátu
tabulkového procesoru. Nástroj Spreadsheet View/Importer (Zobrazení/Import tabulky) můžete použít
k exportu obsahu jamky ve formátu odděleném tabulátory do aplikace, například aplikace Microsoft
Excel. Obsah jamky můžete také importovat z aplikace textu odděleného tabulátorem.

Použití nástroje Spreadsheet View/Importer (Zobrazení/Import tabulky)

1. Na panelu nástrojů Plate Editor (Editor destiček) klikněte na Spreadsheet View/Importer
(Zobrazení/Import tabulky) a otevřete dialogové okno Plate Spreadsheet View (Zobrazit destičku
jako tabulku).

2. Dialogové okno Spreadsheet View (Zobrazit tabulku) zobrazuje obsah destičky pro jeden
fluorofor. Chcete-li zobrazit obsah destičky pro jiný fluorofor, vyberte jej z rozevíracího seznamu
Fluors List (Seznam fluorů).

3. Kliknutím na položku Export Template (Exportovat šablonu) exportujete šablonu tabulky pro
destičku do souboru Excel (formát .csv). Tuto šablonu můžete upravit a importovat informace o
obsahu jamky.

4. (Volitelné) Kliknutím na tlačítko Import (Importovat) importujete obsah jamky ze souboru s
oddělovači.

5. Chcete-li tabulku seřadit podle údajů v konkrétním sloupci, klikněte na trojúhelník vedle názvu
sloupce.
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Tip: Obsah libovolné buňky můžete upravit ve sloupci, který má vedle názvu sloupce
hvězdičku (*) (například *Cílový název).

Poznámka: Ve sloupci Quantity (Množství) vyberte jednotky pro data standardní křivky
otevřením editoru Plate Editor (Editor destiček) a v panelu nabídek vyberte položky Settings >
Units (Nastavení > Jednotky). Po dokončení cyklu destičky se data z těchto standardů zobrazí v
grafu Standard Curve (Standardní křivka) na kartě Quantification (Kvantifikace) v okně Data
Analysis (Analýza dat) s vybranými jednotkami.

Položky nabídky Plate Spreadsheet View/Importer (Zobrazení/import tabulky
destiček) po kliknutí pravým tlačítkem myši

Tabulka 14 obsahuje seznam položek nabídky dostupných v nástroji Spreadsheet View/Importer
(Zobrazení/import tabulky) poté, když v nástroji kliknete pravým tlačítkemmyši na jakoukoliv jamku.

Položka Funkce

Copy (Kopírovat) Zkopíruje celou tabulku.

Copy as Image
(Kopírovat jako
obrázek)

Zkopíruje tabulku jako soubor obrázku.

Print (Tisk) Vytiskne tabulku.

Print Selection
(Vytisknout výběr)

Vytiskne pouze vybrané buňky.

Export to Excel (Export
do aplikace Excel)

Exportuje soubor do tabulky aplikace Excel.

Export to CSV (Export
do souboru CSV)

Exportuje soubor jako soubor .csv.

Export to Xml (Export
do souboru XML)

Exportuje soubor jako soubor .xml.

Export to Html (Export
do souboru HTML)

Exportuje soubor jako soubor .html.

Find (Najít) Vyhledá konkrétní text.

Sort (Řazení) Seřadí tabulku na základě výběru až tří sloupců dat v okně Sort
(Řazení).

Tabulka 14. Položky nabídky nástroje Plate Spreadsheet View/Importer
(Zobrazení/import tabulky destiček) po kliknutí pravým tlačítkem myši
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Vytvoření rozložení destičky pomocí nástroje Plate Setup
Wizard (Průvodce nastavením destičky)

Nástroj Setup Wizard (Průvodce nastavením destičky) můžete použít k zadání informací o rozložení
destičky, které jsou nutné pro analýzu normalizované exprese genu, a to včetně:

n Názvů cílů

n Názvů vzorků

n Umístění cílů a vzorků na destičce

n Referenčních genů

n Kontrolního vzorku

Nástroj Setup Wizard (Průvodce nastavením) můžete použít před cyklem, během něj i po něm.

Použití Setup Wizard (Průvodce nastavením) pro destičku
Tato část vysvětluje, jak vytvořit rozvržení destičky pomocí nástroje Setup Wizard (Průvodce
nastavením) pro destičku. Chcete-li snadněji prohlížet obsah každé jamky na destičce, klikněte na
tlačítko Zoom plate (Lupa) v horní části Setup Wizard (Průvodce nastavením).

Důležité: Pokud se vrátíte na kartu Auto layout (Automatické rozvržení) a nacházíte se na jiné
kartě v Setup Wizard (Průvodce nastavením), rozložení destičky se resetuje. Při výběru této karty
postupujte opatrně.

Tip: Rozvržení můžete obnovit výběrem položky Tools > Clear Plate (Nástroje > Vymazat
destičku) v Setup Wizard (Průvodce nastavením).

Použití Setup Wizard (Průvodce nastavením) pro destičku

1. Otevře editor Plate Editor (Editor destiček).

2. Chcete-li otevřít Setup Wizard (Průvodce nastavením), postupujte vyberte možnost Editing Tools
> Setup Wizard (Úpravy nástrojů > Průvodce nastavením).

Zobrazí se okno Setup Wizard (Průvodce nastavením), které zobrazuje kartu Auto layout
(Automatické rozložení).
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Vytvoření rozložení destičky pomocí nástroje Plate Setup Wizard (Průvodce nastavením destičky)

3. Na kartě Auto layout (Automatické rozložení) postupujte následovně:

a. Klikněte na jamku v mřížce a přetáhněte ji napříč a dolů pro specifikování oblasti na destičce,
do které chcete načíst vzorek.

b. Zadejte počet cílů a vzorků, které chcete načíst.

Tip: Počet cílů a vzorků se musí rovnat počtu vybraných buněk. Pokud se zadaná čísla
nevejdou do vybrané oblasti, upravte čísla nebo vybranou oblast destičky. Lze určit
orientaci položek na destičce a jejich seskupení.

c. (Volitelné) Změna orientace destičky. Můžete například nastavit cíle ve sloupcích a vzorky v
řádcích, nebo provést seskupení podle vzorků.

d. Klikněte na Next (Další) a pokračujte na kartu Target names (Názvy cílů).

Poznámka: Pokud rozvržení destičky nemá pravidelný vzor, použijte kartu Target names
(Názvy cílů) pro ruční umístění vašich cílů nebo kartu Sample names (Názvy vzorků) pro
ruční umístění vzorků na destičku. Kliknutím a přetažením vyberete více jamek.
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4. Na kartě Target names (Názvy cílů) definujte názvy cílů pro cílové skupiny:

a. Postupujte následovně:

n Chcete-li přejmenovat cíle podle skupiny, nastavte pro parametr Select by (Vybrat
podle) položku Target (Cíl).

n Chcete-li přejmenovat cíle podle jamky, nastavte pro parametr Select by (Vybrat podle)
položku Well (Jamka).

b. Vyberte cílovou skupinu nebo jamku v mřížce a zadejte název do rozevíracího seznamu
Target name (Název cíle).

Tip: Stiskněte klávesu Tab pro výběr další skupiny nebo jamky vpravo nebo Enter pro
výběr další skupiny nebo jamky níže. Nebo na kartách Target name (Název cíle) a
Sample name (Název vzorku) podržte klávesu Control a klikněte na jamku, abyste
vybrali více jamek, které nesousedí.

c. Klikněte na položku Next (Další) a pokračujte na kartu Sample names (Názvy vzorků).

5. Na kartě Sample names (Názvy vzorků) definujte názvy vzorků pro cílové skupiny.

6. Klikněte na položku Next (Další) a pokračujte na kartu Reference targets (Referenční cíle).

7. Na kartě Reference targets (Referenční cíle) vyberte jeden nebo více cílů, které se použijí jako
reference pro normalizovanou expresi genu, a klikněte na tlačítko Next (Další) a přejděte na kartu
Control sample (Kontrolní vzorek).

8. Na kartě Control sample (Kontrolní vzorek) vyberte jeden vzorek, který se použije jako kontrola
pro výpočty relativní exprese genu.

9. Kliknutím na tlačítko OK uložíte rozvržení desky a vrátíte se do nástroje Plate Editor (Editor
destiček), ve kterémmůžete dále definovat parametry destičky. Více informací naleznete v části
Přiřazení volitelných parametrů k souboru destičky na straně 122.

Případně klikněte na tlačítko Previous (Předchozí), chcete-li se vrátit na předchozí kartu a provést
změny.

Poznámka: Návrat na kartu Auto layout (Automatické rozvržení) automaticky obnoví
destičku. Dávejte pozor při klepnutí na tlačítko Previous (Předchozí).
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Kapitola 8 Provádění experimentů
Tato kapitola vysvětluje, jak spustit vlastní (uživatelem definované) nebo PrimePCR experimenty
pomocí softwaru CFX Manager Dx.

Datový soubor cyklu obsahuje protokol a informace o destičce pro cyklus. Soubor také obsahuje data
z analýz, která CFX Manager Dx provádí po dokončení cyklu.

Software CFX Manager Dx umožňuje snadné nastavení a spuštění uživatelsky definovaných nebo
PrimePCR experimentů. Okno Run Setup (Nastavení cyklu) vás provede běžnými kroky nastavení
experimentu, což vede k dialogovému oknu Start Run (Spustit cyklus), ze kterého spustíte cyklus.

Otevření okna Run Setup (Nastavení cyklu)
Otevření okna Run Setup (Nastavení cyklu)

u Postupujte následovně:

n Na kartě Run Setup (Nastavení cyklu) v nástroji Startup Wizard (Průvodce spuštěním)
klikněte buď na položku User-defined (Možnost zadaná uživatelem), nebo PrimePCR.

n V okně Home (Domů) klikněte na panelu nástrojů buď na položku User-defined Run Setup
(Nastavení cyklu zadané uživatelem), nebo PrimePCR Run Setup (Nastavení cyklu
PrimePCR).

n V okně Home (Domů) klepněte buď na položky Run > User-defined Run (Spustit > Cyklus
zadaný uživatelem) nebo Run > PrimePCR Run (Spustit > Cyklus PrimePCR).
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Okno Run Setup (Nastavení cyklu)
Okno Run Setup (Nastavení cyklu) poskytuje rychlý přístup k souborům a nastavením potřebným pro
nastavení a spuštění experimentu. Pokud se rozhodnete spustit experiment definovaný uživatelem,
otevře se okno Run Setup (Nastavení cyklu), které zobrazí kartu Protocol (Protokol). Pokud se
rozhodnete spustit experiment PrimePCR, otevře se okno Run Setup (Nastavení cyklu), které zobrazí
kartu Start run (Spustit cyklus).

Tip: V části Provádění experimentů PrimePCR na straně 162 naleznete informace o PrimePCR;
v části Karta Start Run (Spustit cyklus) na straně 153 naleznete další informace o kartě Start Run
(Spustit cyklus).

1. Karty vás provedou nastavením a spuštěním experimentu:

n Na kartě Protocol (Protokol) – vyberte existující protokol, který chcete spustit nebo
upravit, nebo vytvořte nový protokol v editoru Protocol Editor (Editor protokolu).

n Na kartě Plate (Destička) – vyberte existující destičku, kterou chcete spustit nebo upravit,
nebo vytvořte novou destičku v nástroji Plate Editor (Editor destičky).

n Karta Start Run (Spustit cyklus) – zobrazuje nastavení experimentu, vybere jeden nebo
více bloků přístrojů a spouští cyklus.

2. Hlavní okno zobrazuje možnosti pro každou kartu, když ji použijete.

3. Navigační tlačítka vedou na kartu Start Run (Spustit cyklus).

LEGENDA
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Karta Protocol (Protokol)
Karta Protocol (Protokol) obsahuje náhled souboru protokolu, který chcete provést. Soubor protokolu
obsahuje pokyny pro kroky teploty přístroje a možnosti přístroje, kterými se řídí rychlost
ohřevu/ochlazování, objem vzorku a teplota víka.

Ve výchozím nastavení software zobrazuje protokol definovaný v části File Selection for Run Setup
(Výběr souboru pro nastavení cyklu) karty Files (Soubory) v dialogovém okně User > User
Preferences (Uživatel > Uživatelské předvolby). Výchozí protokol můžete v dialogovém okně User
Preferences (Uživatelské předvolby) změnit. Více informací naleznete v části Změna výchozího
nastavení souboru na straně 66.

Na kartě Protocol (Protokol) můžete:

n vytvořit nový protokol k provedení;

n vybrat stávající protokol k provedení nebo úpravám.

Více informací o tvorbě a úpravě protokolů je uvedeno v Kapitola 6, Vytváření protokolů.
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Jak vytvořit nový protokol

1. Na kartě Protocol (Protokol) klikněte na možnost Create New (Vytvořit nový).

Objeví se okno Protocol Editor (Editor protokolu).

2. Pomocí nástroje Protocol Editor (Editor protokolu) vytvořte nový protokol.

3. Kliknutím na OK protokol uložíte a vrátíte se na kartu Protocol (Protokol) v nabídce Run Setup
(Nastavení cyklu).

4. Zobrazte podrobnosti o protokolu a postupujte následovně:

n Jsou-li podrobnosti správné, kliknutím na položku Next (Další) přejdete na kartu Plate
(Destička).

n Jsou-li podrobnosti nesprávné, kliknutím na položku Edit Selected (Upravit vybrané) se
vrátíte do nástroje Protocol Editor (Editor protokolu). Upravte protokol, uložte změny a poté
klikněte na položku Next (Další) na kartě Protocol (Protokol). Přejdete tak na kartu Plate
(Destička).

Jak vybrat stávající protokol

1. Na kartě Protocol (Protokol) postupujte následovně:

n Klikněte na položku Select Existing (Vybrat stávající) a přejděte na stávající protokol.

n Klikněte na položku Express Load (Expresní načtení) a z rozevíracího seznamu protokolů
vyberte protokol.

Tip: Z rozevíracího seznamu Express Load (Expresní načtení) můžete přidávat nebo
odstraňovat protokoly. Více informací je uvedeno v následující části Přidání a odstranění
protokolů pro expresní načtení.

2. Zobrazte podrobnosti o protokolu a postupujte následovně:

n Jsou-li podrobnosti správné, kliknutím na položku Next (Další) přejdete na kartu Plate
(Destička).

n Jsou-li podrobnosti nesprávné, kliknutím na položku Edit Selected (Upravit vybrané) otevřete
okno Protocol Editor (Editor protokolu). Upravte protokol, uložte změny a poté klikněte na
položku Next (Další) na kartě Protocol (Protokol). Přejdete tak na kartu Plate (Destička).
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Přidání a odstranění protokolů pro expresní načtení

Můžete měnit obsah rozevíracího seznamu Express Load (Expresní načtení), které se zobrazuje v
editoru Protocol Editor (Editor protokolu). Protokoly v tomto seznamu jsou uloženy v následující
složce:

c:\Users\Public\Documents\Bio-Rad\CFX\Users\<user_name>\ExpressLoad\

Změna seznamu Express Load (Expresní načtení) protokolů

1. Přejděte do složky ExpressLoad (Expresní načtení) a otevřete ji.

2. Zkontrolujte soubory protokolu (.pcrl) ve složce.

3. Postupujte následovně:

n Vymažte protokoly ze složky a odstraňte je z rozevíracího seznamu.

n Zkopírujte protokoly do složky a přidejte je do rozevíracího seznamu.
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Karta Plate (Destička)
Poznámka: Jestliže protokol vybraný na kartě Protocol (Protokol) nezahrnuje krok čtení destičky
pro analýzu PCR v reálném čase, je karta Plate (Destička) skrytá. Abyste zobrazili kartu Plate
(Destička), přidejte do protokolu alespoň jedno čtení destičky.

Karta Plate (Destička) obsahuje náhled souboru destičky, který chcete načíst. Při cyklu PCR v
reálném čase obsahuje soubor destičky popis obsahu každé jamky, včetně jejích fluoroforů, režimu
skenování a typu destičky. Software CFX Manager Dx využívá tyto popisy ke sběru a analýze dat.

Ve výchozím nastavení software zobrazuje destičku definovanou v části File Selection for Run Setup
(Výběr souboru pro nastavení cyklu) karty Files (Soubory) v dialogovém okně User > User
Preferences (Uživatel > Uživatelské předvolby). Výchozí destičku můžete v dialogovém okně User
Preferences (Uživatelské předvolby) změnit. Více informací naleznete v části Změna výchozího
nastavení souboru na straně 66.

Na kartě Plate (Destička) můžete:

n vytvořit novou destičku k načtení.

n vybrat stávající destičku k načtení nebo úpravám.

Více informací o tvorbě a úpravě destiček je uvedeno v Kapitola 7, Příprava destiček.
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Jak vytvořit novou destičku

1. Na kartě Plate (Destička) klikněte na možnost Create New (Vytvořit novou).

Objeví se Plate Editor (Editor destiček).

2. Pomocí nástroje Plate Editor (Editor destiček) vytvořte novou destičku.

3. Kliknutím na OK destičku uložíte a vrátíte se na kartu Plate (Destička) v nabídce Run Setup
(Nastavení cyklu).

4. Zobrazte podrobnosti o destičce a postupujte následovně:

n Jsou-li podrobnosti správné, kliknutím na položku Next (Další) přejdete na kartu Start Run
(Spustit cyklus).

n Jsou-li podrobnosti nesprávné, kliknutím na položku Edit Selected (Upravit vybrané) se
vrátíte do nástroje Plate Editor (Editor destiček). Upravte soubor destičky, uložte změny a
poté klikněte na položku Next (Další) na kartě Plate (Destička). Přejdete tak na kartu Start
Run (Spustit cyklus).

Jak vybrat stávající soubor destičky

1. Na kartě Plate (Destička) postupujte následovně:

n Klikněte na položku Select Existing (Vybrat stávající) a přejděte na stávající soubor destičky.

n Klikněte na položku Express Load (Expresní načtení) a z rozevíracího seznamu vyberte
soubor destičky.

Tip: Z rozevíracího seznamu Express Load (Expresní načtení) můžete přidávat nebo
odstraňovat destičky. Více informací je uvedeno v následující části Přidání a odstranění
souborů destiček pro expresní načtení.

2. Zobrazte podrobnosti o destičce a postupujte následovně:

n Jsou-li podrobnosti správné, kliknutím na položku Next (Další) přejdete na kartu Start Run
(Spustit cyklus).

n Jsou-li podrobnosti nesprávné, kliknutím na položku Edit Selected (Upravit vybrané) otevřete
okno Plate Editor (Editor destiček). Upravte soubor destičky, uložte změny a poté klikněte na
položku Next (Další). Přejdete tak na kartu Start Run (Spustit cyklus).
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Přidání a odstranění souborů destiček pro expresní načtení

Můžete měnit obsah rozevíracího seznamu Express Load (Expresní načtení), který se zobrazuje v
editoru Plate Editor (Editor destiček). Destičky, které se objeví v tomto seznamu, jsou uloženy v
následující složce:

c:\Users\Public\Documents\Bio-Rad\CFX\Users\<user_name>\ExpressLoad\

Změna seznamu Express Load (Expresní načtení) souborů destiček

1. Přejděte do složky ExpressLoad (Expresní načtení) a otevřete ji.

2. Zkontrolujte soubory destiček (.pltd) ve složce.

3. Postupujte následovně:

n Vymažte soubory destičky ze složky, chcete-li je odstranit z rozevíracího seznamu.

n Zkopírujte soubory destiček do složky, chcete-li je přidat do rozevíracího seznamu.
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Karta Start Run (Spustit cyklus)
Na kartě Start Run (Spustit cyklus) se zobrazují informace o experimentu, který se má spustit.
Zobrazuje také připojený blok nebo bloky přístroje, na kterých můžete experiment spustit.

Na kartě Start Run (Spustit cyklus) můžete provést následující:

n Zobrazit podrobné informace o cyklu, včetně vybraného souboru protokolu, souboru destičky a
režimu skenování.

n Přidávat poznámky o cyklu.

n Zobrazit podrobnosti o všech připojených přístrojích, včetně jejich provozního stavu (v chodu
nebo nečinný), objemu vzorku v µl, teploty víka, režimu emulace a ID nebo čárového kódu, pokud
je k dispozici.

Poznámka: Můžete upravovat sloupce, které se zobrazují v tabulce Start Run on Selected
Blocks (Spustit cyklus s vybranými bloky). Další informace naleznete v části Změna údajů v
tabulce Selected Blocks (Vybrané bloky) na straně 154.

n Vyberte jeden nebo více bloků, na kterých chcete cyklus provést.

n Otevřete nebo zavřete víko každého vybraného přístroje.

n Spusťte cyklus.
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Změna údajů v tabulce Selected Blocks (Vybrané bloky)

Sloupce v tabulce Start Run on Selected Block(s) (Spustit cyklus s vybranými bloky) můžete měnit.
Rovněž můžete měnit výchozí objem vzorku a teplotu víka v tabulce. Změny nastavení se použijí na
cyklus, který má být proveden.

Jak přidat sloupce do tabulky Start Run on Selected Blocks (Spustit cyklus s vybranými
bloky)

u Klikněte na tabulku pravým tlačítkemmyši a označte příslušnou možnost v otevřené nabídce.

Jak odstranit sloupce z tabulky Start Run on Selected Blocks (Spustit cyklus s
vybranými bloky)

u Klikněte na tabulku pravým tlačítkemmyši a odznačte příslušnou možnost v otevřené nabídce.

Jak upravit objem vzorku nebo teplotu víka pro blok

u Vyberte buňku s objemem vzorku nebo teplotou víka pro cílový blok a zadejte do ní novou
hodnotu.

Jak přidat ID cyklu nebo čárový kód pro blok

u Vyberte buňku ID/Bar Code (ID/čárový kód) pro cílový blok a zadejte ID nebo naskenujte blok
pomocí čtečky čárových kódů.

Provedení experimentu
Důležité: Před provedením experimentu se ujistěte, že antivirový software vašeho počítače
nespustí během cyklu antivirovou kontrolu.

Jak provést experiment

1. Na kartě Start Run (Spustit cyklus) ověřte podrobnosti o destičce a protokolu v části Run
Information (Informace o cyklu).

2. (Volitelné) V textovém rámečku Notes (Poznámky) můžete přidávat poznámky k cyklu nebo
experimentu.

3. Označte zaškrtávací políčko jednoho nebo několika bloků, na kterých chcete cyklus provést.

Tip: Abyste provedli experiment na všech blocích, vyberte možnost Select All Blocks (Vybrat
všechny bloky) pod tabulkou Selected Blocks (Vybrané bloky).

4. (Volitelné) Po kliknutí na možnost Flash Block Indicator (Indikátor Flash Block) začne blikat LED
indikátor na vybraných blocích přístroje.
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Karta Start Run (Spustit cyklus)

5. Vložte do bloku experimentální destičky:

a. Klikněte na možnost Open Lid (Otevřít víko). Otevře se motorizované víko každého
vybraného bloku.

b. Do každého vybraného bloku vložte experimentální blok.

c. Klikněte na možnost Close Lid (Zavřít víko).

Tip: Pro otevření a zavření víka můžete také stisknout tlačítko na přední straně každého
bloku.

6. Kliknutím na možnost Open Lid (Otevřít víko) nebo Close Lid (Zavřít víko) otevřete a zavřete
motorizované víko každého vybraného bloku přístroje.

7. Zobrazte podrobnosti o cyklu a postupujte následovně:

n Jsou-li podrobnosti správné, klikněte na Start Run (Spustit cyklus).

n Jsou-li podrobnosti nesprávné:

o Opravte podrobnosti v tabulce Selected Blocks (Vybrané bloky) a klikněte na Start Run
(Spustit cyklus).

o Vraťte se na správnou kartu a proveďte příslušné změny, uložte je a poté klikněte na
položku Next (Další) pro návrat na kartu Start Run (Spustit cyklus) a spuštění cyklu.

Jak zahájit nový cyklus z předchozího cyklu

u Postupujte následovně:

n Vyberte možnost File > Repeat a Run (Soubor > Opakovat cyklus) v hlavní nabídce softwaru,
přejděte na datový soubor cyklu, který chcete opakovat, a dvakrát na něj klikněte.

n Vyberte kartu Repeat Run (Opakovat cyklus) v nástroji Startup Wizard (Průvodce spuštěním)
a dvakrát klikněte na datový soubor cyklu, který chcete opakovat.

Případně můžete na kartě Repeat Run (Opakovat cyklus) kliknout na možnost Browse
(Procházet), přejít na datový soubor cyklu, který chcete opakovat, a dvakrát na něj kliknout.
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Kapitola 8 Provádění experimentů

Dialogové okno Run Details (Podrobnosti o cyklu)
Po kliknutí na tlačítko Start Run (Spustit cyklus) software CFX Manager Dx vyzve k uložení datového
souboru (.pcrd), spustí cyklus a otevře dialogové okno Run Details (Podrobnosti o cyklu). Dialogové
okno Run Details (Podrobnosti o cyklu) obsahuje tři karty stavu:

n Run Status (Stav cyklu) – tato karta slouží k zobrazení aktuálního stavu protokolu, otevření
nebo zavření víka, pozastavení cyklu, přidání opakování, přeskočení kroků nebo zastavení cyklu.

n Real-time Status (Stav v reálném čase) – tato záložka slouží k zobrazení dat fluorescence
PCR v reálném čase při jejich sběru.

n Time Status (Časový stav) – tato karta slouží k zobrazení odpočítávací časomíry pro protokol
na celé obrazovce.

Tyto karty jsou podrobně vysvětleny v následujících kapitolách.

Karta Run Status (Stav cyklu)
Karta Run Status (Stav cyklu) ukazuje aktuální stav probíhajícího cyklu. V tomto náhledu můžete
rovněž ovládat víko a měnit probíhající cyklus.

1. Panel Run Status (Stav cyklu) – ukazuje aktuální průběh protokolu.

2. Ovládací prvky Run Status (Stav cyklu) – umožňují vám ovládat přístroj nebo
přerušit aktuální protokol.

3. Panel Run Information (Informace o cyklu) – ukazuje podrobnosti o cyklu.

LEGENDA
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Dialogové okno Run Details (Podrobnosti o cyklu)

Příkazy Run Status (Stav cyklu)

Pomocí příkazů na kartě Run Status (Stav cyklu) můžete buď ovládat přístroj ze softwaru, nebo změnit
probíhající cyklus.

Poznámka: Provádění změn protokolu během cyklu, například přidávání opakování, nezmění
soubor protokolu spojeného s cyklem. Tyto akce jsou zaznamenány do protokolu Run Log
(Protokol cyklu).

– otevře motorizované víko na vybraném přístroji.

Důležité: Otevření víka během cyklu pozastaví cyklus během aktuálního kroku a může
změnit data.

– zavře motorizované víko na vybraném přístroji.

– Přidá další opakování k aktuálnímu kroku GOTO v protokolu. Tato volba je k dispozici, pouze
když je spuštěn krok GOTO.

– přeskočí aktuální krok v protokolu.

Poznámka: Pokud přeskočíte krok GOTO, software vás vyzve, abyste potvrdili, že chcete
přeskočit celou smyčku GOTO a pokračovat dalším krokem protokolu.

– bliká indikátor LED na vybraném přístroji pro identifikaci vybraných bloků.

– pozastaví protokol.

Poznámka: Tato akce je zaznamenána v protokolu Run Log (Protokol cyklu).

– obnoví pozastavený protokol.

– zastaví cyklus před ukončením protokolů.

Poznámka: Zastavení cyklu před ukončením protokolu může změnit vaše data.
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Karta Real-time Status (Stav v reálném čase)
Karta Real-time Status (Stav v reálném čase) zobrazuje data PCR shromážděná v reálném čase v
každém cyklu během cyklu po přečtení prvních dvou destiček.

1. Podokno Amplification trace (Amplifikace tras) – zobrazuje amplifikační data v
reálném čase během cyklu.

2. Well group identifier (Identifikátor skupiny jamek) – pokud byly v nastavení
destičky identifikovány skupiny jamek, mohou uživatelé vybrat konkrétní skupinu
jamek pro zobrazení jejich tras, jamek a tabulkových informací.

Step number identifier (Identifikátor čísla kroku) – pokud protokol shromažďuje
data ve více než jednom kroku (například během amplifikace a křivky tání),
mohou uživatelé vybrat konkrétní krok a zobrazit trasy shromážděné v tomto
kroku.

3. PodoknoWell selector (Nástroj pro výběr jamky) – zobrazí aktivní, neaktivní a
prázdné jamky na destičce.

4. Podokno Nastavení destičky – zobrazí nastavení destičky v tabulkovém formátu.

LEGENDA
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Dialogové okno Run Details (Podrobnosti o cyklu)

5. Podokno Run details (Podrobnosti o cyklu) – zobrazuje stav cyklu v reálném
čase včetně těchto položek:

n Current step (Stávající krok)

n Current repeat (Stávající opakování)

n Current temperature (Stávající teplota)

n Time remaining (Zbývající čas)

n Sample temperature (Teplota vzorku)

n Lid temperature (Teplota víka)

6. Plate Setup (Nastavení destičky) – otevře dialogové okno Plate Setup
(Nastavení destičky), ve kterémmohou uživatelé upravovat aktuální nastavení
destičky během cyklu.

Na kartě Real-time Status (Stav v reálném čase) můžete:

n Zobrazit nebo skrýt trasy v reálném čase jejich výběrem v podokně nástroje pro výběr jamky nebo
v tabulce nastavení destiček.

n Zobrazit jednotlivé trasy nebo skupiny tras tak, že je vyberete v rozevíracím seznamu skupin.

n Upravit nebo nahradit soubor destičky.

n Použít pro cyklus soubor PrimePCR.

Zobrazení nebo skrytí tras v reálném čase

Standardně jsou všechny naplněné jamky aktivní a zobrazují se v tabulce nastavení destičky. Aktivní
jamky se objeví v podokně nástroje pro výběr jamek modře. V podokně nástroje pro výběr jamek se
skryté jamky se zobrazují jako světle šedé a nepoužité jamky se zobrazují jako tmavě šedé.

Během cyklu můžete skrýt trasy z aktivních jamek. CFX Manager Dx nadále sbírá data pro všechny
jamky; když jamky skryjete, jejich data se neobjeví v tabulce nastavení destičky.

Skrytí tras v reálném čase

u V podokně nástroje pro výběr jamek klikněte na aktivní (modré) jamky, které chcete skrýt.

Zobrazení tras v reálném čase

u V podokně nástroje pro výběr jamek klikněte na skryté (světle šedé) jamky, které chcete zobrazit.

Další informace o nástroji pro výběr jamky naleznete v části Nástroj pro výběr jamky na straně 175.
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Úprava nastavení destičky

Úprava nastavení destičky

u Klikněte na možnost Plate Setup (Nastavení destičky) a potom vyberte položku View/Edit Plate
(Zobrazit/Upravit destičku).

Objeví se okno Plate Editor (Editor destiček), ve kterémmůžete upravovat destičku během
probíhajícího cyklu. Další informace o úpravách desek naleznete v Kapitola 7, Příprava destiček.

Poznámka: Styly trasování můžete také upravit v okně Plate Editor (Editor destiček). Změny
se objeví v grafu amplifikačního záznamu na kartě Real-time Status (Stav v reálném čase).

Nahrazení souboru destičky

Tip: Náhrada souboru destičky je obzvláště užitečná, když spustíte cyklus se souborem Quick
Plate (Rychlá destička) ve složce ExpressLoad (Expresní načtení).

Jak nahradit soubor destičky

u Klikněte na možnost Plate Setup (Nastavení destičky) a vyberte jednu z následujících možností:

n Replace Plate file (Nahradit soubor destičky) – vyberte nový soubor destičky ze seznamu v
okně prohlížeče

n Apply PrimePCR file (Použít soubor PrimePCR) – vyhledejte pomocí chytrého vyhledávání
soubor cyklu, ze kterého bude získáno rozložení destičky, nebo klikněte na možnost Browse
(Procházet), abyste našli soubor stažený z internetových stránek společnosti Bio-Rad, který
se nenachází ve složce PrimePCR

Poznámka: Software CFX Manager Dx kontrolujte režim skenování a velikost destičky pro
soubor destičky. Ty musejí být stejné jako nastavení cyklu, se kterým byl cyklus zahájen.
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Dialogové okno Run Details (Podrobnosti o cyklu)

Karta Time Status (Časový stav)
Karta Time Status (Časový stav) ukazuje zbývající čas do dokončení aktuálního cyklu.
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Provádění experimentů PrimePCR
Experimenty PrimePCR využívají testy specifické pro cesty nebo onemocnění, které Bio-Rad validuje
a optimalizuje a jsou k dispozici v následujících formátech:

n Připravené panely – destičky obsahující testy, které jsou specifické pro biologickou dráhu nebo
onemocnění; zahrnují kontroly a referenční geny PrimePCR

n Vlastní konfigurované destičky – destičky, které lze nastavit v uživatelsky definovaném rozložení
s možností výběru testů pro požadované cíle, kontroly a reference

n Individuální testy – zkumavky, které obsahují jednotlivé sady primerů pro použití v reakcích v
reálném čase

Chcete-li zkrátit celkovou dobu cyklu, můžete melt krok v protokolu odstranit. Společnost Bio-Rad
důrazně doporučuje, abyste neprováděli žádné další úpravy protokolu cyklu PrimePCR. Výchozí
protokol je protokol, který byl použit pro validaci testu. Jakékoliv odchylky od tohoto protokolu mohou
mít vliv na výsledky. Změny protokolu jsou zaznamenány na kartě Run Information (Informace o cyklu)
výsledného datového souboru a ve všech vytvořených sestavách.

Spuštění cyklu PrimePCR

u Chcete-li spustit cyklus PrimePCR, postupujte následovně:

n V nástroji Startup Wizard (Průvodce spuštěním) vyberte PrimePCR na kartě Run Setup
(Nastavení cyklu) a poté vyberte příslušnou chemii (SYBER nebo sondu).

n Vyberte položku PrimePCR, která bude spuštěna ze seznamu Recent Runs (Aktuální cykly)
na kartě Repeat Run (Opakovat cyklus) v průvodci Startup Wizard (Průvodce spuštěním).

n Vyberte položky File > New > PrimePCR Run (Soubor > Nový > Cyklus PrimePCR) v okně
Home (Domů).

n Vyberte položky File > Open > PrimePCR Run (Soubor > Otevřít > Cyklus PrimePCR) v okně
Home (Domů).

n Přetáhněte soubor protokolu cyklu PrimePCR do okna Home (Domů).

Po výběru cyklu PrimePCR se otevře okno Run Setup (Nastavení cyklu) na kartě Start Run (Spustit
cyklus) s výchozím rozložením destičky PrimePCR načteným na základě vybraného nástroje.

Chcete-li zkrátit celkovou dobu cyklu, můžete melt krok v protokolu odstranit.

u Na kartě Protocol (Protokol) zrušte zaškrtnutí políčka vedle Include Melt Step (Zahrnout melt
krok).
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Provádění experimentů PrimePCR

Import cílových informací pro destičky PrimePCR do rozložení destiček

1. Postupujte následovně:

n Na kartě Real-time Status (Stav v reálném čase) v dialogovém okně Run Details
(Podrobnosti o cyklu) vyberte položky Plate Setup > Apply PrimePCR File (Nastavení
destičky > Použít soubor PrimePCR).

n V okně Data Analysis (Analýza dat) vyberte položky Plate Setup > Apply PrimePCR File
(Nastavení destičky > Použít soubor PrimePCR).

2. V dialogovém okně spuštění souboru PrimePCR klikněte na položku Browse (Procházet) a
přejděte na příslušný soubor PrimePCR (.csv).

3. Vyberte cílový soubor PrimePCR a klikněte na Open (Otevřít).

CFX Manager Dx importuje cílové informace do rozvržení destičky
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Kapitola 9 Přehled analýzy dat
CFXManager Dx nabízí několik způsobů otevření a zobrazení datových souborů. Můžete:

n Vybrat File > Open > Data File (Soubor > Otevřít > Datový soubor) v okně Home (Domů) a přejít
na cílový soubor .pcrd.

n Vybrat File > Recent Data Files (Soubor > Nejnovější datové soubory) v okně Home (Domů),
budete tak mít výběr ze seznamu deseti nejnovějších otevřených datových souborů.

Okno Data Analysis (Analýza dat)
Okno Data Analysis (Analýza dat) zobrazuje více záložek, přičemž každá záložka zobrazuje
analyzovaná data pro konkrétní metodu analýzy nebo informace specifické pro cyklus. Záložky se
zobrazují pouze tehdy, jsou-li pro tento typ analýzy k dispozici data shromážděná v cyklu.

Tip: Chcete-li vybrat karty, které chcete zobrazit, vyberte je v rozevírací nabídce View (Zobrazit) v
okně Data Analysis (Analýza dat). Chcete-li se vrátit k původnímu rozložení karty, vyberte
položky Settings > Restore Default Window Layout (Nastavení > Obnovit výchozí rozvržení
okna).
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Panel nástrojů pro analýzu dat
Panel nástrojů v okně Data Analysis (Analýza dat) poskytuje rychlý přístup k důležitým funkcím
analýzy dat.

Tabulka 15 uvádí seznam funkcí tlačítek na panelu nástrojů.

Tlačítko Název Funkce

Plate Setup
(Nastavení
destičky)

View/Edit pane (Zobrazit/upravit destičku):
Otevře Plate Editor (Editor destiček) pro
zobrazení a úpravy obsahu jamek.

Replace Plate file (Nahradit soubor destičky):
Vybere soubor destičky, který má nahradit
rozložení destičky.

Apply PrimePCR file (Použít soubor
PrimePCR): Vybere soubor cyklu, který má
nahradit rozložení PrimePCR cyklu.

ManageWell
Groups
(Spravovat
skupiny jamek)

Pro tvorbu, úpravu a výmaz skupin jamek
klikněte na oknoWell Groups Manager
(Správce skupiny jamek).

Well Group
(Skupina jamek)

Vybere existující název skupiny jamek z
rozevírací nabídky. Výchozí výběr je All
Wells (Všechny jamky). Toto tlačítko se
zobrazí pouze tehdy, když jsou vytvořeny
skupiny.

Analysis Mode
(Režim analýzy)

Analyzuje data v režimu Fluorophore
(Fluorofor) nebo Target (Cíl).

Help (Nápověda) Otevře digitální kopii příručky ve formátu
Acrobat PDF.

Tabulka 15. Panel nástrojů v okně Data Analysis (Analýza dat)
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Okno Data Analysis (Analýza dat)

Panel nabídek pro analýzu dat
Tabulka 16 obsahuje seznam položek nabídky v okně Data Analysis (Analýza dat).

Položka
nabídky Příkaz Funkce

File (Soubor) Save (Uložit) Uloží soubor.

Save As (Uložit jako) Uloží soubor s novým názvem.

Repeat Run (Opakovat cyklus) Extrahuje protokol a soubor destičky z
aktuálního cyklu pro nové spuštění.

Close (Zavřít) Zavře okno Data Analysis (Analýza dat)

View (Zobrazit) Run Log (Protokol cyklu) Otevře okno Run Log (Protokol cyklu) a zobrazí
protokol cyklu aktuálního datového souboru.

Quantification (Kvantifikace),
Melt Curve (Křivka tání), Gene
Expression (Exprese genu),
End Point (Koncový bod),
Custom Data View (Vlastní
zobrazení dat), QC (Kontrola
kvality), Run Information
(Informace o cyklu)

Zobrazuje analyzovaná data na vybraných
kartách v okně Data Analysis (Analýza dat).
Musí být vybrána alespoň jedna karta.

Settings
(Nastavení)

Cq Determination Mode
(Režim určení Cq)

Vyberte možnost Regression (Regrese) nebo
Single Threshold (Jeden práh), a určete tak, jak
se vypočítávají hodnoty Cq pro každou stopu.

Baseline Setting (Základní
nastavení)

Vyberte metodu Baseline Subtraction (Odečet
základní linie) pro vybrané skupiny jamek.

Analysis Mode (Režim
analýzy)

Vyberte, zda chcete analyzovat data s použitím
možnosti Fluorophore (Fluorofor), nebo Target
(Cíl).

Tabulka 16. Seznam položek v okně Data Analysis (Analýza dat)
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Položka
nabídky Příkaz Funkce

Cycles to Analyze (Cykly pro
analýzu)

Vyberte cykly, které mají být analyzovány.

Baseline Thresholds (Výchozí
prahy)

Otevřte okno Baseline Threshold (Výchozí
prahy) a upravte základní linii nebo prahovou
hodnotu.

Trace Styles (Styly trasování) Otevře okno Okno Trace Styles (Styly
trasování).

Plate Setup (Nastavení
destičky)

Otevře Plate Editor (Editor destiček) pro
zobrazení a úpravu destičky; nahraďte aktuální
destičku jedním z uživatelsky definovaných
souborů destiček nebo souborem cyklu
PrimePCR.

Include All Excluded Wells
(Zahrnout všechny vyloučené
jamky)

Zahrne všechny vyloučené jamky v analýze.

Mouse Highlighting
(Zvýraznění myší)

Zapíná nebo vypíná současné zvýraznění dat
ukazatelem myši.

Tip: Pokud je Mouse Highlighting
(Zvýraznění myší) vypnuto, stiskněte
klávesu Control (Ctrl) pro dočasné zapnutí
zvýraznění.

Restore Default Window
Layout (Obnovit výchozí
rozvržení okna)

Obnoví uspořádání oken na výchozí nastavení.

Tabulka 16. Seznam položek v okně Data Analysis (Analýza dat), pokračování
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Okno Data Analysis (Analýza dat)

Položka
nabídky Příkaz Funkce

Export
(Exportovat)

Export All Data Sheets to
Excel (Export všech tabulek do
aplikace Excel)

Exportuje všechny pohledy tabulky z každé
karty do samostatného souboru aplikace Excel.

Custom Export (Vlastní export) Otevře okno Custom Export (Vlastní export), ve
kterém je možné určit pole, která mají být
exportována, a formát souboru.

Export to LIMS (Export do
složky LIMS)

Otevře okno pro uložení dat do předem
určeného formátu do složky LIMS.

Seegene Export (Export pro
Seegene)

Otevře okno pro identifikaci umístění
ukládaných dat ze všech zobrazení tabulky v
souborech aplikace Excel, speciálně
strukturovaných pro použití společností
Seegene, Inc.

Tools (Nástroje) Reports (Hlášení) Otevře hlášení pro tento datový soubor.

Well Group Reports (Hlášení o
skupinách jamek)

Otevře okno Well Group Report (Hlášení o
skupinách jamek) k vytvoření hlášení pro
určené skupiny jamek.

Import Fluorophore Calibration
(Import kalibrace fluoroforu)

Vyberte kalibrační soubor, který se použije pro
aktuální datový soubor.

qbase+ Spouští qbase+ v2.5 přímo z aktuálního
souboru .pcrd, pokud je nainstalován.

Tabulka 16. Seznam položek v okně Data Analysis (Analýza dat), pokračování
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Karta Details (Podrobnosti)
Každá karta v okně Data Analysis (Analýza dat) obsahuje data z grafu a tabulek pro konkrétní metodu
analýzy a zahrnuje nástroj pro výběr jamek, s jehož pomocí lze vybírat data, která chcete zobrazit.
Když se otevře, zobrazí okno Data Analysis (Analýza dat) ve výchozím nastavení kartu Quantification
(Kvantifikace). Data z grafu Amplification (Amplifikace) na kartě Quantification (Kvantifikace) můžete
použít ke stanovení příslušného nastavení analýzy pro cyklus.

Poznámka: Software propojuje data v podoknech každé karty Data Analysis (Analýza dat).
Například při zvýraznění jamky tak, že když na ni v nástroji pro výběr jamky umístíte kurzor,
zvýrazní se i data ve všech ostatních podoknech.

Nástroj pro výběr Step Number (Číslo kroku)
Systémy CFX96 a CFX96 DeepWell mohou získávat fluorescenční data ve více krocích protokolu;
software uchovává data získaná v jednotlivých krocích odděleně. Software zobrazí přepínač Step
Number (Číslo kroku). Pokud protokol obsahuje alespoň jeden krok sběru dat, software Software CFX
Manager Dx zobrazí data z prvního kroku sběru.

Pokud protokol obsahuje více než jeden krok sběru, můžete z rozevíracího seznamu vybrat další krok,
například:

Když vyberete krok, software použije tento výběr na všechna data, která se zobrazí v okně Data
Analysis (Analýza dat).
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Okno Data Analysis (Analýza dat)

Zobrazení skupin jamek v analýze dat
Pro účely nezávislé analýzy pomocí skupin jamek lze jamky na destičce sdružovat do dílčích sad.
Když vytvoříte skupiny jamek, objeví se názvy skupin v okně Data Analysis (Analýza dat), v
rozevíracím seznamuWell Groups (Skupiny jamek) na panelu nástrojů.

Jestliže jste vytvořili skupiny jamek, zobrazí software po otevření okna Data Analysis (Analýza dat)
výchozí skupinu jamek All Wells (Všechny jamky), která uvádí data pro všechny jamky obsažené v
grafech a tabulkách. V nástroji pro výběr jamek se objeví pouze jamky v načtené skupině s příslušným
obsahem a ve výpočtech pro analýzu dat budou zahrnuta pouze data pro tyto jamky.

Poznámka: Pokud jste nevytvořili skupiny jamek, rozevírací seznamWell Groups (Skupiny
jamek) se na panelu nástrojů neobjeví.

Změna obsahu jamky po cyklu
Během analýzy dat se změnou způsobu zobrazení dat na základě změny obsahu jamek v nástroji
Plate Editor (Editor destiček) nikdy nezmění data o fluorescenci shromážděná z každé jamky během
pracovního cyklu. Když modul shromáždí data o fluorescenci, nemůžete tato data vymazat, ale
můžete je vyloučit ze zobrazení a z analýzy.

Jak změnit obsah jamek po pracovním cyklu

u V okně Data Analysis (Analýza dat) klikněte na Plate Setup (Nastavení destičky) a vyberte jednu
z následujících možností:

n Edit/View Plate (Editovat/upravit destičku) – otevře nástroj Plate Editor (Editor destiček),
ve kterémmůžete provádět manuální změny rozložení.

n Replace Plate file (Nahradit soubor destičky) – otevře prohlížeč Select Plate (Vybrat
destičku), ve kterémmůžete přejít na dříve uložený soubor destičky, jímž chcete nahradit
aktuální rozložení destičky.

n Apply PrimePCR file (Použít soubor PrimePCR) – otevře dialogové okno Select
PrimePCR file (Vybrat soubor PrimePCR), ve kterémmůžete přejít na spouštěcí soubor
PrimePCR a použít jej na rozložení destičky.

Tip: Informace o obsahu jamky můžete přidávat nebo upravovat před cyklem PCR, během něj
nebo po jeho ukončení. Před cyklem musíte přiřadit režim skenování a velikost destičky. Tyto
parametry nelze po cyklu měnit.
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Nastavení analýzy dat
Data v grafu Amplification (Amplifikace) na kartě Quantification (Kvantifikace) zobrazují relativní
fluorescenci (RFU) pro každou jamku v každém cyklu. Každá trasa v grafu představuje data z jednoho
fluoroforu v jedné jamce. Tato data jsou použita pro stanovení hodnot Cq pro každou jamku na
základě jednoho fluoroforu. Software používá k určení hodnot Cq jeden ze dvou režimů:

n Regression (Regrese) – aplikuje vícerozměrný, nelineární regresní model na jednotlivé trasy
jamky a pak tento model používá k výpočtu optimální hodnot Cq.

n Single Threshold (Jeden práh) – používá jedinou prahovou hodnotu pro výpočet hodnot Cq na
základě prahu průniku jednotlivých stop fluorescence.

Vyberte položky Settings > Cq Determination Mode (Nastavení > Režim určení Cq) a vyberte režim
určení hodnot Cq.

Úprava prahu
V režimu Single Threshold (Jeden práh) můžete upravit práh pro fluorofor tak, že kliknete na řádek s
prahem v grafu Amplification (Amplifikace) a svisle kurzor posunete. Případně můžete stanovit přesný
práh překročení pro vybraný fluorofor.

Základní nastavení
Software automaticky nastaví základní linii individuálně pro každou jamku. Základní nastavení určuje
metodu odečtu základní linie pro všechny fluorescenční trasy. Software poskytuje tři možnosti
odečítání základní linie:

n No Baseline Subtraction (Bez odečtu základní linie) – zobrazí data jako relativní
fluorescenční trasy. Některé analýzy v tomto režimu analýzy nejsou možné, a proto software
nezobrazuje karty Gene Expression (Exprese genu), End Point (Koncový bod) a Allelic
Discrimination (Alelická diskriminace).

n Baseline Subtracted (Základní linie odečtena) – zobrazí data jako odečtené trasy základních
linií pro každý fluorofor v jamce. Software musí odečíst kmenová data pro stanovení cyklů
kvantifikace, vytvořit standardní křivky a určit koncentraci neznámých vzorků. Aby se generovala
základní odečtená trasa, software upraví nejlepší přímku procházející zaznamenanou
fluorescencí každé jamky během základních cyklů a pak odečte data nejlepšího přizpůsobení z
pozadí odečtených dat v každém cyklu.

n Baseline Subtracted Curve Fit (Úprava odečtené základní linie) – zobrazí data jako
odečtené stopy základní linie a software vyhladí odečtenou základní křivku pomocí středového
filtru se středním vážením. Tento proces se provádí tak, že každá hodnota Cq zůstává
nezměněna.
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Nastavení analýzy dat

Kromě těchto možností můžete také vybrat možnost Apply Fluorescent Drift Correction (Použít korekci
posunu fluorescence). Pro jamky, které mají abnormálně driftující hodnoty RFU během počátečních
několika cyklů běhu, software odvodí odhadovanou základní linii ze sousedních jamek, pro které byla
úspěšně vytvořena horizontální základní linie.

Změna nastavení odčítání základní linie

u Vyberte položky Settings > Baseline Setting (Nastavení > Nastavení základní linie).

Režim analýzy
Data mohou být seskupena a analyzována podle fluoroforu nebo podle cílového názvu. Při seskupení
podle fluoroforu se zobrazují datové stopy podle fluoroforu, jak je uvedeno v nastavení destičky pro daný
cyklus. Údaje o individuálních fluoroforech se objevují v grafu amplifikace a standardní křivky (je-li k
dispozici), pokud jsou vybrána příslušná zaškrtávací políčka nástroje pro výběr fluoroforu, nacházející se
pod grafem amplifikace.
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Při seskupení podle cíle se zobrazují datové stopy podle názvu cíle zadaného v nastavení destičky
pro daný cyklus.

Výběr režimu analýzy dat

u Postupujte následovně:

n Vyberte Settings > Analysis Mode (Nastavení > Režim analýzy).

n Vyberte režim z rozbalovací nabídky Analysis Mode (Režim analýzy) na panelu nástrojů.

Cykly pro analýzu
Počet cyklů pro analýzu můžete omezit. Můžete rovněž analyzovat data z konkrétních souborů cyklů.
Maximální počet cyklů, které lze analyzovat, je 50.

Poznámka: Odstranění cyklů na začátku pracovního cyklu může mít významný dopad na
stanovení základních linií.

Jak omezit analýzu dat na konkrétní rozsah cyklů

1. Vyberte položky Settings > Cycles to Analyze (Nastavení > Cykly pro analýzu).

Otevře se dialogové okno Cycles to Analyze (Cykly pro analýzu).

2. Zadejte počáteční a koncové hodnoty cyklu a klikněte na OK.

Klikněte na možnost Restore Defaults (Obnovit výchozí) v dialogovém okně Cycles to Analyze (Cykly
pro analýzu) pro návrat k cyklům, které byly pro analýzu původně použity.
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Nástroj pro výběr jamky

Nástroj pro výběr jamky
Nástroj pro výběr jamky slouží k zobrazení nebo skrytí dat jamky v grafech nebo tabulkách v okně
Data Analysis (Analýza dat). V nástroji pro výběr jamky lze vybrat pouze jamky naplněné vzorkem.
Software používá pro jamky v nástroji pro výběr jamky barvy:

n Blue (Modrá) – označuje vybrané jamky. Data z vybraných jamek se zobrazí v okně Data
Analysis (Analýza dat).

n Light gray (Světle šedá) – označuje nevybrané jamky Data z nevybraných jamek se zobrazí v
okně Data Analysis (Analýza dat).

n Dark gray (Tmavě šedá) – označuje prázdné jamky.

Zobrazení nebo skrytí dat o jamce

u V nástroji pro výběr jamky postupujte následovně:

n Chcete-li skrýt jednu jamku, klikněte na konkrétní jamku. Chcete-li tuto jamku zobrazit,
klikněte na ni znovu.

n Chcete-li skrýt více jamek, přetáhněte kurzor přes jamky, které chcete vybrat. Chcete-li tyto
jamky zobrazit, znovu kurzor přetáhněte.
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n Kliknutím na levý horní roh destičky skryjete všechny jamky. Pro výběr všech jamek klikněte
znovu na levý horní roh.

n Kliknutím na začátek sloupce nebo řádku skryjete příslušné jamky. Klepnutím na sloupec
nebo řádek znovu jamky zobrazíte.

Položky nabídky nástroje pro výběr jamek po kliknutí pravým
tlačítkem myši
Tabulka 17 obsahuje seznammožností dostupných v zobrazení nástroje pro výběr jamek po kliknutím
pravým tlačítkemmyši.

Položka Funkce

Well XX (Jamka XX) Zobrazí pouze tuto jamku, odstraní tuto jamku z náhledu, nastaví
barvu této jamky nebo vyjme tuto jamku z analýzy.

Selected Wells (Vybrané
jamky) (kliknout pravým
tlačítkemmyši a přetáhnout)

Zobrazí pouze tyto jamky, odstraní tyto jamky z náhledu, nastaví
barvu těchto jamek, nebo vyjme tyto jamky z analýzy.

Copy (Kopírovat) Zkopíruje obsah jamky do schránky, včetně typu vzorku a
volitelného čísla replikace.

Copy as Image (Kopírovat jako
obrázek)

Zkopíruje zobrazení nástroje pro výběr jamek jako obrázek.

Print (Tisk) Vytiskne zobrazení nástroje pro výběr jamek.

Print Selection (Vytisknout
výběr)

Vytiskne aktuální výběr.

Export to Excel (Export do
aplikace Excel)

Exportuje data do tabulky Excel.

Export to Csv (Export do
souboru CSV)

Exportuje data jako textový dokument.

Export to Xml (Export do
souboru XML)

Exportuje data jako dokument ve formátu .xml.

Well Labels (Štítky jamek) Změní štítky jamek na Sample Type (Typ vzorku), Target Name
(Název cíle), nebo Sample Name (Název vzorku).

Tabulka 17. Položky nabídky nástroje pro výběr jamek po kliknutí pravým tlačítkem myši
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Nástroj pro výběr jamky

Dočasné vyloučení jamek z analýzy
Jak dočasně vyloučit jamky z analýzy dat

1. Klikněte pravým tlačítkemmyši na nástroj pro výběr jamky. Pro vyloučení více jamek tyto jamky,
trasy nebo body zvýrazněte tak, že na ně kliknete pravým tlačítkemmyši a přetáhnete je.

2. Z nabídky po kliknutí pravým tlačítkemmyši vyberte příslušnou možnost:

n Well > Exclude Well (Jamka > Vyloučit jamku)

n Selected Wells > Exclude from Analysis (Vybrané jamky > Vyloučit z analýzy)

n Selected Traces > Exclude these wells from Analysis (Vybrané trasy > Vyloučit tyto jamky z
analýzy)

Případně pokud chcete trvale odejmout jamky z analýzy, vymažte obsah jamek v nástroji Plate
Editor (Editor destiček) tak, že kliknete na tlačítko Clear Wells (Vymazat jamky).

Důležité: Obsah každé vymazané jamky musíte znovu zadat.

Jak zahrnout vyloučenou jamku

u Klikněte pravým tlačítkemmyši na příslušnou jamku v nástroji pro výběr jamek a vyberte položky
Well > Include Well in Analysis (Jamka > Zahrnout jamku do analýzy).
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Grafy
Každý graf v okně Data Analysis (Analýza dat) zobrazuje data v různých diagramech a zahrnuje
možnosti pro úpravu a export dat nebo grafických prvků grafu.

Společné položky nabídky pro grafy po kliknutí pravým
tlačítkem myši
Tabulka 18 uvádí položky nabídky pravým tlačítkemmyši, které jsou k dispozici v grafech. Některé
dostupné položky jsou k dispozici pro všechny grafy a tyto položky lze použít ke změně zobrazení dat
nebo k snadnému exportu dat z grafu.

Položka Funkce

Copy (Kopírovat) Zkopíruje graf do schránky.

Save Image As (Uložit
obrázek jako)

Uloží obrázek v určené velikosti, rozlišení a typu souboru. Dostupné
formáty obrázků jsou PNG (výchozí), JPG a BMP.

Page Setup (Nastavení
stránky)

Náhled a výběr nastavení stránky pro tisk.

Print (Tisk) Vytiskne graf.

Set Scale to Default
(Nastavit měřítko na
výchozí)

Po zvětšení grafu vrátí graf do výchozího zobrazení.

Chart Options (Možnosti
grafu)

Otevře okno Chart Options (Možnosti grafu) pro změnu grafu, včetně
změny názvu, výběru limitů pro osy x a y, zobrazení rastrových čar a
menších zaškrtnutí v osách.

Tabulka 18. Položky nabídky pro grafy po kliknutí pravým tlačítkem myši

Poznámka: Položky nabídky, které se vztahují na konkrétní grafy, jsou popsány v Kapitola 10,
Podrobnosti o analýze dat.
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Grafy

Kopírování dat z grafů do schránky
Obsah náhledu grafu můžete kopírovat a vložit jej do jakékoliv aplikace, která umí pracovat s
bitmapovými obrazovými soubory.

Jak kopírovat data z grafů do schránky

1. Z nabídky grafu po kliknutí pravým tlačítkemmyši vyberte možnost Copy (Kopírovat).

2. Otevřete aplikaci, která umí pracovat s bitmapovými obrázky, například Microsoft Word.

3. Klikněte pravým tlačítkemmyši a vyberte možnost Paste (Vložit) pro vložení bitmapového
obrázku ze schránky do aplikace.

Úprava základního nastavení prahů
V režimu Single Threshold (Jeden práh) můžete upravit práh pro fluorofor tak, že kliknete na řádek s
prahem v grafu Amplification (Amplifikace) a svisle kurzor posunete. Případně můžete stanovit přesný
práh překročení pro vybraný fluorofor.

Tip: Na kartě Data Analysis (Analýza dat) v nabídce User > User Preferences (Uživatel >
Uživatelské předvolby) můžete určit rozsah cyklu, abyste stanovili výchozí úroveň pro všechny
datové soubory.

Jak nastavit počáteční a koncový výchozí cyklus pro každou jamku

1. Na kartě Quantification (Kvantifikace) vyberte jeden fluorofor pod grafem Amplification
(Amplifikace).

2. Z nabídky grafu po kliknutí pravým tlačítkemmyši vyberte Baseline Threshold (Výchozí práh).

Otevře se dialogové okno Baseline Threshold (Výchozí práh).
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3. V části Baseline Cycles (Výchozí cykly) postupujte následovně:

n Pro výběr jedné jamky klikněte na číslo jejího řádku.

n Pro výběr několika sousedních jamek klikněte na číslo řádku první jamky a táhněte v sloupci
dolů až k poslední jamce.

n Pro výběr několika jamek, které se nenacházejí vedle sebe, stiskněte klávesu Control a
klikněte postupně na čísla řádků všech cílových jamek.

n Pro výběr všech jamek klikněte na levý horní roh tabulky.

4. Upravte výchozí počáteční cyklus a výchozí koncový cyklus pro všechny vybrané jamky, popř.
změňte číslo počátečního a koncového cyklu v dolní části tabulky.

Tip: Pro návrat nastavení na poslední uložené hodnoty klikněte na položku Reset All User
Defined Values (Resetovat všechny hodnoty definované uživatelem).

5. Pro uložení změn a návrat ke grafu klikněte na OK.

Jak stanovit rozsah cyklu pro všechny datové soubory

u V okně Home (Domů) nebo Plate Editor (Editor destiček) vyberte User > User Preferences
(Uživatel > Uživatelské předvolby) a zvolte kartu Data Analysis (Analýza dat).
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Grafy

Řazení cílových hodnot a dat vzorků
Poznámka: Tato možnost je k dispozici pouze v grafu exprese genu.

Ve výchozím nastavení se seznamy Targets (Cíle) a Samples (Vzorky) zobrazují v abecedním pořadí.
Dialogové okno Sort (Řazení) slouží k řazení zobrazení v obráceném abecedním pořadí nebo k
ručnímu přesunutí výrazu na jinou pozici v seznamu.

Řazení cílů a vzorků

1. Z nabídky grafu po kliknutí pravým tlačítkemmyši klikněte na položku Sort (Řazení).

Zobrazí se dialogové okno Gene Expression Chart Sorting (Řazení dat grafu exprese genu).

2. V dialogovém okně klikněte na položku Z-A a seřadíte seznam v obráceném abecedním pořadí.

3. Chcete-li termín ručně přesunout, vyberte jej a klikněte na příslušné tlačítko mezi grafy:

n Kliknutím na šipku nahoru nebo dolů přesunete vybraný termín o jednu pozici.

n Kliknutím na šipku nahoru nebo dolů přesunete vybraný výraz na začátek nebo na konec
seznamu.

4. Kliknutím na tlačítko OK a uložte změny a vraťte se na kartu Gene Expression (Exprese genu).

Návod k použití | 181



Kapitola 9 Přehled analýzy dat

Zvětšení oblasti v grafu
Jak zvětšit oblast v grafu

u Klikněte a přetáhněte kurzor přes graf a následně klikněte na položku Zoom (Lupa)*. Software
změní velikost grafu a vystředí jej na vybranou oblast.

Poznámka: * V případě sloupcového grafu nemusíte na vyskakovací příkaz Zoom (Lupa)
klikat.

Jak resetovat graf chart na plný náhled

u Klikněte pravým tlačítkemmyši na graf a vyberte položku Set Scale to Default (Nastavit měřítko
na výchozí).

Kopírování grafů do souboru Microsoft
Datové grafy můžete kopírovat do dokumentů pro Microsoft Word, Excel nebo PowerPoint. Rozlišení
obrázku odpovídá rozlišení obrazovky, ze které byl obrázek získán.

Jak kopírovat grafy do souboru Microsoft

1. V okně Data Analysis (Analýza dat) vyberte možnost Copy (Kopírovat) z nabídky grafu po
kliknutím pravým tlačítkemmyši.

2. Otevřete prázdný soubor Microsoft a vložte obsah ze schránky.

Případně: Klikněte na ikonu pro přetažení a přetáhněte graf do souboru Microsoft.
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Tabulky
Tabulky zobrazené v náhledu Data Analysis (Analýza dat) obsahují možnosti pro řazení a přenos dat.
Můžete sloupce řadit jedním z následujících způsobů:

n Klikněte a přetáhněte sloupec do nové pozice ve vybrané tabulce.

n Pro řazení dat ve vzestupném nebo sestupném pořadí klikněte na záhlaví sloupce.

Jak seřadit až tři sloupce dat v okně Sort (Řazení)

1. Klikněte pravým tlačítkemmyši do tabulky a vyberte položku Sort (Řazení).

2. V dialogovém okně Sort (Řazení) vyberte název prvního sloupce, který chcete seřadit. Seřaďte
data ve vzestupném nebo sestupném pořadí.

3. Vyberte druhý nebo třetí sloupec k řazení a zvolte možnost Ascending (Vzestupně) nebo
Descending (Sestupně).

4. Klikněte na OK pro řazení dat nebo na Cancel (Zrušit) pro ukončení řazení.

Zvýrazněte data v příslušných grafech a v nástroji pro výběr jamek tak, že podržíte kurzor nad buňkou.
Klikněte do buňky pro zkopírování a vložení jejího obsahu do jiného softwarového programu.

Běžné položky nabídky pro tabulky po kliknutí pravým tlačítkem
myši
Tabulka 19 zobrazuje položky nabídky po kliknutí pravým tlačítkemmyši dostupné v libovolném
zobrazení tabulky.

Položka Funkce

Copy (Kopírovat) Zkopíruje obsah vybraných jamek do schránky a vloží obsah do
tabulky, jako je Excel.

Copy as Image (Kopírovat jako
obrázek)

Zkopíruje zobrazení tabulky jako soubor obrázku a vloží jej do
souboru, který akceptuje soubor obrázku. Může jít například o
textové, obrázkové nebo tabulkové soubory.

Print (Tisk) Vytiskne aktuální zobrazení.

Print Selection (Vytisknout
výběr)

Vytiskne aktuální výběr.

Tabulka 19. Položky nabídky pro tabulky po kliknutí pravým tlačítkem myši
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Položka Funkce

Export to Excel (Export do
aplikace Excel)

Exportuje data do tabulky Excel.

Export to CSV (Export do
souboru CSV)

Exportuje data oddělené čárkou do souboru (.csv).

Export to Xml (Export do
souboru XML)

Exportuje data do souboru Xml.

Export to Html (Export do
souboru HTML)

Exportuje data do souboru Html.

Find (Najít) Vyhledá text.

Sort (Řazení) Seřadí data až do třech sloupců.

Select Columns (Vybrat
sloupce)

Vybere sloupce, které budou zobrazeny v tabulce.

Tabulka 19. Položky nabídky pro tabulky po kliknutí pravým tlačítkem myši, pokračování
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Export

Export
Software CFX Manager Dx obsahuje čtyři možnosti exportu z rozevírací nabídky Export:

n Export All Data Sheets (Export všech tabulek)

n Custom Export (Vlastní export)

n Export to LIMS (Export do LIMS)

n Seegene Export (Export pro Seegene)

Export všech tabulek
Všechny náhledy tabulek z každé karty softwaru Software CFX Manager Dx můžete exportovat do
jednotlivých souborů.

Jak exportovat všechny tabulky

u Vyberte Export > Export All Data Sheets (Exportovat > Exportovat všechny tabulky) a poté
vyberte typ souboru, který chcete:

n CSV (*.csv)

n Text (*.txt)

n Excel 2007 (*.xlsx)

n Excel 2003 (*.xls)

n XML (*.xml)
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Tvorba vlastního souboru pro export
Vytvoření vlastního souboru pro export

1. Vyberte položky Export > Custom Export (Exportovat > Vlastní export). Zobrazí se dialogové
okno Custom Export (Vlastní export).

2. Z rozevíracího seznamu, který se objeví, vyberte formát exportu.

3. Zaškrtněte políčka u položek, které chcete exportovat.

4. (Volitelné) Chcete-li změnit názvy sloupců, klikněte na tlačítko Customize Column Name (Upravit
názvy sloupců).

5. Klikněte na položku Export (Exportovat). Otevře se dialogové okno Save As (Uložit jako).

6. V dialogovém okně Save As (Uložit jako) uveďte název souboru a umístění, do kterého se
exportovaný soubor uloží.

7. Kliknutím na OK se exportovaný soubor uloží.
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Export do složky LIMS
Můžete data exportovat do souborového formátu kompatibilního s LIMS.

Jak exportovat data ve formátu LIMS

1. Vyberte položky Export > Export to LIMS Folder (Exportovat > Export do složky LIMS).

Otevře se dialogové okno Save As (Uložit jako).

2. V dialogovém okně Save As (Uložit jako) uveďte název souboru a umístění, do kterého se
exportovaný soubor uloží.

3. Kliknutím na OK se exportovaný soubor uloží.

Export dat ve formátu Seegene
Data ze všech náhledů tabulek můžete exportovat do souborů aplikace Excel, jejichž struktura je
upravena konkrétně pro použití společností Seegene, Inc.

Jak exportovat data ve formátu Seegene

1. Vyberte Export > Seegene Export (Exportovat > Export pro Seegene).

Otevře se dialogové okno Save As (Uložit jako).

2. V dialogovém okně Save As (Uložit jako) uveďte umístění složky, do které se exportované
soubory aplikace Excel (.xlsx) ve formátu Seegene uloží.

3. Kliknutím na OK se exportované soubory uloží.
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Kapitola 10 Podrobnosti o analýze dat
V softwaru CFX Manager Dx v okně Data Analysis (Analýza dat) je několik záložek, z nichž lze
prohlížet data. Tato kapitola podrobně vysvětluje tyto záložky.

Tip: V okně Data Analysis (Analýza dat) můžete pomocí nabídky View (Zobrazit) vybrat, které
karty se mají zobrazit. Vlastní rozložení se uloží s datovým souborem.
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Karta Quantification (Kvantifikace)
Pomocí dat na kartě Quantification (Kvantifikace) nastavíte podmínky analýzy dat, včetně výchozího
nastavení pro jednotlivé jamky a nastavení prahů. Karta Quantification (Kvantifikace) zobrazuje data v
těchto čtyřech náhledech:

n Graf Amplification (Amplifikace) – zobrazuje relativní jednotky fluorescence (RFU) pro každou
jamku při každém cyklu. Každá trasa v grafu představuje data z jednoho fluoroforu v jedné jamce.

n Standard curve (Standardní křivka) – objeví se pouze v případě, že pracovní cyklus obsahuje
jamky označené jako standardní typ vzorku (Std (Standardní)). Standardní křivka zobrazuje
prahový cyklus zaznamenaný oproti záznamu počátečního množství. Legenda ukazuje účinnost
reakce (E) pro každý fluorofor v jamkách se standardním typem vzorku.

n Nástroj pro výběr jamky – vybere jamky s daty o fluorescenci, které chcete zobrazit.

n Tabulka – zobrazí tabulku dat shromážděných ve vybraných jamkách.

Možnosti pro fluorofor
Pro zobrazení dat o fluoroforu v grafech a tabulkách na kartě Quantification (Kvantifikace) vyberte
cílové fluorofory pod grafem Amplification (Amplifikace). Pro skrytí dat o fluoroforu v okně analýze dat
odznačte příslušné zaškrtávací políčko.
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Dialogové okno Trace Styles (Styly trasování)
Pomocí dialogového okna Trace Styles (Styly trasování) můžete upravit vzhled tras při amplifikaci a
grafů křivek tání na kartách Quantification (Kvantifikace) a Melt Curve (Křivka tání). Následně můžete
zobrazit náhled změn v nástroji pro výběr jamek, který naleznete v dialogovém okně Trace Styles
(Styly trasování).

Jak upravit styly trasování

1. Na grafu Amplification (Amplifikace) vyberte pouze jeden fluorofor.

2. Otevřete dialogové okno Trace Styles (Styly trasování) jedním z následujících způsobů:

n Klikněte na Trace Styles (Styly trasování) v grafu Amplification (Amplifikace).

n V panelu nabídek Data Analysis (Analýza dat) vyberte položky Settings > Trace Styles
(Nastavení > Styly trasování).

n Klikněte pravým tlačítkem na trasu a vyberte Trace Styles (Styly trasování).

Otevře se dialogové okno Trace Styles (Styly trasování).

3. V nástroji pro výběr jamek v dolním podokně dialogového okna Trace Styles (Styly trasování)
vyberte konkrétní sadu jamek. Případně vyberte jamky obsahující jeden typ vzorku v rozevíracím
nabídce ve sloupci Wells (Jamky).
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4. Postupujte následovně:

n Pro výběr barvy pro vybrané jamky klikněte na políčko ve sloupci Color (Barva).

n Pro přiřazení symbolu vybraným jamkám vyberte symbol z rozevíracího seznamu Symbol.

n Pro rychlé vybarvení jamek podle štítku tlačítka klikněte na příslušný rychlý výběr:

o Random byWell (Náhodně podle jamky)

o Random by Replicate (Náhodně podle replikace)

o Use Fluor Colors (Použít barvy fluoru)

o Use Target Colors (Použít barvy cílů)

o Use Sample Colors (Použít barvy vzorků)

n Pro přiřazení štítků jamek vyberte možnost Sample Type (Typ vzorku), Target Name (Název
cíle), Sample Name (Název vzorku) nebo Symbol.

Možnost Log Scale (Logaritmické měřítko)
Vyberte Log Scale (Logaritmické měřítko) pod grafem Amplification (Amplifikace) pro zobrazení tras
fluorescence v semilogaritmickémměřítku:

Tip: Pro zvětšení jakékoliv oblasti grafu přetáhněte kurzor přes cílovou oblast. Pro návrat na plný
náhled klikněte pravým tlačítkemmyši na graf a vyberte možnost Set Scale to Default (Nastavit
měřítko na výchozí).
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Graf Standard Curve (Graf standardních křivek)
Software vytvoří graf Standard Curve (Graf standardních křivek) na kartě Quantification
(Kvantifikace), jestliže data zahrnují typy vzorků definovaných jako Std alespoň pro jeden fluorofor v
pracovním cyklu.

Graf Standard Curve (Graf standardních křivek) zobrazuje následující informace:

n Název každé křivky (fluorofor nebo cíl).

n Barvu každého fluoroforu nebo cíle.

n Účinnost reakce (E). Pomocí této statistiky můžete optimalizovat multiplexovou reakci a vyvážit
data pro standardní křivku.

Poznámka: Účinnost reakce popisuje, jaká část vašeho cíle se produkuje při každém cyklu
protokolu. 100% účinnost znamená, že každým cyklem svůj cíl zdvojnásobíte.

n Koeficient stanovení, R2 (zapsaný jako R^2). Pomocí této statistiky můžete určit, jak přesně
křivka popisuje data (její přesnost).

n Směrnice

n Úsek y
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Možnosti nabídky grafu Amplification (Amplifikace)
Kromě společných možností nabídky grafů po kliknutí pravým tlačítkemmyši (viz Společné položky
nabídky pro grafy po kliknutí pravým tlačítkemmyši na straně 178) obsahuje Tabulka 20 seznam
možností nabídky dostupných pouze v grafu Amplification (Amplifikace).

Poznámka: Graf Standard Curve (Graf standardních křivek) nabízí pouze společné možnosti
nabídky po kliknutí pravým tlačítkemmyši.

Možnosti nabídky Funkce

Show Threshold Values
(Zobrazit hodnoty prahů)

Zobrazí hodnotu prahu pro každou křivku amplifikace v grafu.

Trace Styles (Styly trasování) Otevře okno Trace Styles (Styly trasování) pro změny stylů
trasování na kartách Quantification (Kvantifikace) a Melt Curve
(Křivka tání).

Baseline Thresholds (Výchozí
prahy)

Otevře okno Baseline Thresholds (Výchozí prahy) po změnu
základní linie nebo prahů pro každý fluorofor (změny se zobrazí v
grafu Amplification (Amplifikace) na kartě Quantification
(Kvantifikace)).

Tabulka 20. Položky nabídky grafu Amplification (Amplifikace) po kliknutí pravým a levým
tlačítkem myši

Tabulka na kartě Quantification (Kvantifikace)
Tabulka 21 definuje data zobrazená v tabulce na kartě Quantification (Kvantifikace).

Informace Popis

Well (Jamka) Pozice jamek na destičce

Fluor (Fluorofor) Detekovaný fluorofor

Target (Cíl) Název cíle pro jamky načtené v nástroji Plate Editor (Editor
destiček)

Content (Obsah) Kombinace typu vzorku (povinný) a čísla replikace (volitelné)
načtených v nástroji Plate Editor (Editor destiček)

Tabulka 21. Obsah tabulky na kartě Quantification (Kvantifikace)
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Karta Quantification (Kvantifikace)

Informace Popis

Sample (Vzorek) Název vzorku v jamkách načtených v nástroji Plate Editor (Editor
destiček)

Cq Kvantifikační cyklus pro každou trasu

Tabulka 21. Obsah tabulky na kartě Quantification (Kvantifikace), pokračování

Změna cíle, obsahu nebo dat vzorků

Můžete měnit data ve sloupcích pro cíl, obsah a vzorek tak, že upravíte soubor destičky pomocí
nástroje Plate Editor (Editor destiček) i po provedení experimentu.

Jak změnit data ve sloupcích pro cíl, obsah a vzorek

u Pro otevření nástroje Plate Editor (Editor destiček) klikněte na Plate Setup (Nastavení destičky) a
vyberte View/Edit Plate (Zobrazit/upravit destičku).
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Karta Quantification Data (Kvantifikační data)
Karta Quantification Data (Kvantifikační data) zobrazuje data kvantifikační data shromážděná v každé
jamce. Software CFX Manager Dx zobrazuje data ve čtyřech různých pohledech tabulky:

n Results (Výsledky) – zobrazí tabulku dat. Toto je výchozí zobrazení.

n Standard Curve Results (Výsledky standardních křivek) – zobrazí tabulku dat standardní křivky.

n Plate (Destička) – zobrazí data v každé jamce jako mapu destičky.

n RFU – zobrazuje množství RFU v každé jamce pro každý cyklus.

Vyberte každou tabulku z rozevíracího seznamu, který se zobrazí pod kartou Quantification Data
(Kvantifikační data).

Tabulka Results (Výsledky)
Tabulka Results (Výsledky) obsahuje data pro každou jamku na destičce.

Poznámka: Všechny výpočty Std. Dev (Směrodatná odchylka) platí pro skupiny replikací
přiřazené jamkám v okně Plate Editor (Editor destiček). Výpočty zprůměrují hodnotu Cq pro
každou jamku ve skupině replikací.

Tabulka 22 definuje data, která se objeví v tabulce Results (Výsledky).

Informace Popis

Well (Jamka) Pozice jamek na destičce

Fluor (Fluorofor) Detekovaný fluorofor

Tabulka 22. Obsah tabulky Results (Výsledky)
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Informace Popis

Target (Cíl) Název cíle amplifikace (genu)

Content (Obsah) Typ vzorku a číslo replikace

Sample (Vzorek) Popis vzorku

Biological Set Name (Název
biologického souboru)

Název biologického souboru

Cq Kvantifikační cyklus

CqMean (Průměr Cq) Průměr kvantifikačního cyklu pro skupinu replikací

Cq Std. Dev (Směrodatná
odchylka Cq)

Směrodatná odchylka kvantifikačního cyklu pro skupinu replikací

Starting Quantity (SQ)
(Počáteční množství (SQ))

Odhad počátečního množství cíle

Log Starting Quantity (Záznam
počátečního množství)

Záznam počátečního množství

SQ Mean (Průměr SQ) Průměr počátečního množství

SQ Std. Dev (Směrodatná
odchylka SQ)

Směrodatná odchylka počátečního množství napříč replikacemi

Tabulka 22. Obsah tabulky Results (Výsledky), pokračování
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Tabulka Standard Curve Results (Výsledky standardních křivek)
Tabulka Standard Curve Results (Výsledky standardních křivek) zobrazuje vypočítané parametry
standardní křivky.

Tabulka 23 definuje data, která se zobrazí v tabulce Standard Curve Results (Výsledky standardních
křivek).

Informace Popis

Fluor (or Target) (Fluor (nebo
cíl))

Byl detekován fluorofor (nebo cíl)

Efficiency % (Účinnost %) Účinnost reakce

Slope (Sklon) Sklon standardní křivky

Y-intercept (Úsek y) Bod, ve kterém křivka protíná osu y

R^2 Koeficient stanovení

Tabulka 23. Obsah tabulky Standard Curve Results (Výsledky standardních křivek)
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Tabulka Plate (Destička)
Tabulka Plate (Destička) obsahuje mapu destiček podle dat vždy pro jeden fluorofor.

Pro zobrazení dat pro konkrétní fluorofor

u Klikněte na příslušnou kartu ve spodní části tabulky.

Tabulka RFU
Tabulka RFU obsahuje naměřené hodnoty relativních jednotek fluorescence (RFU) pro každou jamku
zjištěné při každém cyklu pracovního cyklu. Nahoře se v každém sloupci objeví číslo jamky a vlevo od
každého řádku je uvedeno číslo cyklu.
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Karta Melt Curve (Křivka tání)
Prohlášení o vyloučení odpovědnosti: Společnost Bio-Rad neposkytuje žádná práva pro použití
analýzy křivky tání při analýze tání s vysokým rozlišením v oblasti humánní nebo veterinární in vitro
diagnostiky. Kromě toho je povinností kupujícího získat všechna práva duševního vlastnictví, která
mohou být vyžadována pro konkrétní aplikace.

Pro barviva vázající DNA a nečitelné hybridizační sondy je fluorescence nejjasnější, když se dvě
vlákna DNA ochlazují. Proto když teplota při tání stoupá (Tm), fluorescence klesá konstantní rychlostí
(konstantní sklon). U Tm dochází k dramatickému snížení fluorescence se znatelnou změnou sklonu.
Rychlost této změny se stanoví vynesením negativní první regrese fluorescence oproti teplotě (-d
(RFU)/dT). Největší rychlost změny fluorescence má za následek viditelné vrcholy a představuje
hodnotu Tm komplexů dvouvláknové DNA.

Software CFX Manager Dx vykresluje data RFU shromážděná během křivky tání jako funkci teploty.
Aby bylo možné analyzovat data vrcholů tání, přiřazuje software každému vrcholu počáteční a
koncovou teplotu pohybem sloupce prahových hodnot. Dno plochy vrcholu je dáno polohou sloupce
prahu tání. Platný vrchol musí mít minimální výšku vzhledem ke vzdálenosti mezi sloupcem prahu a
výškou nejvyššího vrcholu.

Karta Melt Curve (Křivka tání) zobrazuje hodnotu Tm (teplota tání) amplifikovaných produktů PCR ve
čtyřech pohledech:

n Melt Curve (Křivka tání) – zobrazuje data v reálném čase pro každý fluorofor jako hodnoty RFU
vždy pro teplotu každé jamky.

n Melt Peak (Vrchol tání) – zobrazuje negativní regresi dat RFU vždy pro teplotu každé jamky.

n Well selector (Nástroj pro výběr jamky) – zobrazí jamky pro zobrazení nebo skrytí dat.

n Peak spreadsheet (Tabulka vrcholu) – zobrazí data shromážděná ve vybrané jamce.

Poznámka: Tabulka zobrazuje až dva vrcholy pro každou trasu. Chcete-li zobrazit více
vrcholů, klikněte na tlačítko na kartě Melt Curve Data (Data křivky tání).

200 | Systémy CFX96 Dx a CFX96 DeepWell Dx



Karta Melt Curve (Křivka tání)

Tabulka 24 na straně 201 definuje data, která se objeví v tabulce Melt Curve (Křivka tání).

Informace Popis

Well (Jamka) Pozice jamek na destičce

Fluor Detekovaný fluorofor

Content (Obsah) Kombinace typu vzorku a čísla replikátu

Sample (Vzorek) Název vzorku načtený v nástroji Plate Editor (Editor
destiček)

Melt Temp (Teplota tání) Teplota vrcholu tání pro každou jamku

Poznámka: V tabulce se zobrazují pouze dva nejvyšší
vrcholy.

Tabulka 24. Obsah tabulky křivky tání
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Úprava dat Melt Curve (Křivka tání)
Úprava dat Melt Curve (Křivka tání)

u Postupujte následovně:

n Klikněte a přetáhněte práh pruhů v grafu Melt Peak (Vrchol tání) a zahrňte nebo vylučte
vrcholy v analýze dat.

n Vyberte Positive (Pozitivní) v rozevírací nabídce, aby se zobrazila data tabulky Peaks
(Vrcholy) nad řádkemMelt Threshold (Práh tání), nebo vyberte Negative (Negativní), chcete-
li zobrazit tabulková data vrcholů pod hranicí limitu tání.

n Otevřete okno Trace Styles (Styly trasování) a změňte barvu tras v grafech Melt Curve
(Křivka tání) a Melt Peak (Vrchol tání).

n Vyberte číslo v nástroji pro výběr Step Number (Číslo kroku) a zobrazte data v křivce Melt
Curve (Křivka tání) v dalším kroku protokolu. Seznam obsahuje více než jeden krok, pokud
protokol obsahuje čtení destiček ve více než jednom kroku křivky tání.

n Vyberte jamky v selektoru jamek a zaměřte se na podmnožiny dat.

n Vyberte skupinu jamek pro zobrazení a analýzu podmnožiny jamek v destičce. V rozevírací
nabídce Well Group (Skupina destiček) v panelu nástrojů vyberte jednotlivé skupiny podle
názvu.
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Karta Melt Curve Data (Data křivky tání)
Karta Melt Curve Data (Data křivky tání) obsahuje data z karty Melt Curve (Křivka tání) v několika
tabulkách, které zahrnují všechny vrcholy tání pro každou trasu. Software CFX Manager Dx nabízí
čtyři možnosti tabulek pro zobrazení dat křivky tání:

n Melt Peaks (Vrcholy tání) – zobrazí všechna data, včetně všech vrcholů tání, pro každou trasu.
Toto je výchozí zobrazení.

n Plate (Destička) – zobrazí náhled dat a obsah každé jamky na destičce.

n RFU – zobrazí množství RFU při každé teplotě pro každou jamku.

n -d(RFU)/dT – zobrazí zápornou rychlost změny RFU během změn teploty (T). Toto je první
regresní graf pro každou jamku na destičce.

Vyberte každou tabulku z rozevíracího seznamu pod kartou Melt Curve Data (Data křivky tání).

Tabulka Melt Peaks (Vrcholy tání)
Tabulka Melt Peaks (Vrcholy tání) obsahuje všechna data o křivce tání.

Tabulka 25 na straně 204 definuje data, která se objevují v tabulce Melt Peaks (Vrcholy tání).
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Informace Popis

Well (Jamka) Pozice jamek na destičce

Fluor Detekovaný fluorofor

Content (Obsah) Typ vzorku uvedený v okně Plate Editor (Editor destiček)

Target (Cíl) Cíl amplifikace (gen)

Sample (Vzorek) Název vzorku uvedený v okně Plate Editor (Editor destiček)

Melt Temperature (Teplota tání) Teplota tání každého produktu, uvedená jako jeden vrchol
(nejvyšší) na řádek tabulky

Peak Height (Výška vrcholu) Výška vrcholu

Begin Temperature (Počáteční
teplota)

Teplota na začátku vrcholu

End Temperature (Koncová
teplota)

Teplota na konci vrcholu

Tabulka 25. Obsah tabulky Melt Peaks (Vrcholy tání)

Tabulka Plate (Destička)
Tabulka Plate (Destička) obsahuje data o křivce tání ve formátu destičky.

Poznámka: Pro úpravu vrcholu vyvolaného softwarem upravte řádek s prahem v grafu Melt Peak
(Vrchol tání) na kartě Melt Curve (Křivka tání).

Tabulka 26 na straně 205 definuje data, která se objeví v tabulce Plate (Destička).
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Informace Popis

Content (Obsah) Kombinace typu vzorku (povinný) a čísla replikace (volitelné)

Sample (Vzorek) Popis vzorku

Peak 1 (Vrchol 1) První vrchol tání (nejvyšší)

Peak 2 (Vrchol 2) Druhý (nižší) vrchol tání

Tabulka 26. Obsah tabulky Plate (Destička)

Tabulka RFU
Tabulka RFU obsahuje fluorescenci pro každou jamku při každém cyklu získanou v rámci křivky tání.

Tabulka 27 definuje data, která se zobrazí v tabulce RFU.

Informace Popis

Well number (A1, A2, A3, A4, A5) (Číslo
jamky (A1, A2, A3, A4, A5))

Pozice jamek na destičce pro založené jamky

Temperature (Teplota) Teplota tání amplifikovaného cíle,
zaznamenaná jako jedna jamka na jeden řádek
a několik jamek pro několik produktů ve stejné
jamce

Tabulka 27. Obsah tabulky RFU
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Tabulka -d(RFU)/dT
Tabulka -d(RFU)/dT obsahuje zápornou rychlost změny RFU během změn teploty (T).

Tabulka 28 definuje data, která se objeví v tabulce -d(RFU)/dT.

Informace Popis

Well number (A1, A2, A3, A4, A5) (Číslo
jamky (A1, A2, A3, A4, A5))

Pozice jamek na destičce pro založené jamky

Temperature -d(RFU)/dT (Teplota -d
(RFU)/dT)

Záporná rychlost změny RFU během změn teploty (T)

Tabulka 28. Obsah tabulky -d(RFU)/dT
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Karta End Point (Koncový bod)
Otevřete kartu End Point (Koncový bod) pro analýzu konečných relativních jednotek fluorescence
(RFU) pro jamky se vzorkem. Software porovnává úrovně RFU pro jamky s neznámými vzorky s
úrovněmi RFU pro jamky s negativními kontrolami a označí neznámý vzorek za pozitivní nebo
negativní. Pozitivní vzorky mají hodnotu RFU vyšší než průměrná hodnota RFU negativních kontrol
plus cut-off hodnota.

Pro analýzu dat koncových bodů musí destička obsahovat negativní kontroly, jinak software nemůže
provést označení. Spusťte jeden z těchto dvou typů protokolů:

n Spusťte protokol Quantification (Kvantifikace) – nastavte standardní protokol. Po dokončení cyklu
otevřete okno Data Analysis (Analýza dat), upravte nastavení analýzy dat na kartě Quantification
(Kvantifikace) a poté klikněte na kartu End Point (Koncový bod) pro výběr cyklu koncových bodů.

n Spusťte protokol End Point Only (Pouze koncový bod) – načtěte protokol End Point Only (Pouze
koncový bod) na kartě Plate (Destička) okna Run Setup (Nastavení cyklu), vyberte nebo vytvořte
destičku a spusťte cyklus

Karta End Point (Koncový bod) obsahuje průměrné hodnoty RFU, aby bylo možné stanovit, zda byl cíl
posledním (koncovým) cyklem amplifikován. Pomocí těchto dat určete, zda se ve vzorku nachází
konkrétní cílová sekvence (pozitivní). Pozitivní cíle mají vyšší hodnoty RFU než vámi definovaná cut-
off hodnota.
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Tip: Abyste vytvořili protokol koncového bodu, otevřete kartu Protocol (Protokol) (okno Run
Setup (Nastavení cyklu)) a vyberte možnosti Run > End Point Only Run (Cyklus > Cyklus jen s
koncovým bodem).

Po ukončení cyklu se datový soubor otevře na kartě End Point (Koncový bod) , která je tvořena
těmito částmi:

n Settings (Nastavení) – upraví nastavení analýzy dat.

n Results (Výsledky) – zobrazí výsledky ihned po úpravě nastavení.

n Well Selector (Nástroj pro výběr jamky) – vybere jamky s daty koncových bodů, které chcete
zobrazit.

n RFU spreadsheet (Tabulka RFU) – zobrazí koncové RFU shromážděné ve vybraných jamkách.

Data výsledků
Část Results (Výsledky) zobrazuje následující data:

n Lowest RFU value (Nejnižší hodnota RFU) – nejnižší hodnota RFU v datech

n Highest RFU value (Nejvyšší hodnota RFU) – nejvyšší hodnota RFU v datech

n Negative Control Average (Průměr negativních kontrol) – průměrná RFU pro jamky, které
obsahují negativní kontroly

n Cut Off Value (Cut Off hodnota) – vypočítá se přidáním tolerance (RFU nebo Percentage
(Procenta) rozsahu uvedeného v nastavení) a průměru negativních kontrol. Vzorky s RFU, které
jsou větší než mezní hodnota, se budou nazývat „Pozitivní“. Chcete-li nastavit hodnotu cutoff,
změňte RFU nebo Percentage of Range (Procento rozsahu)

Cut Off Value (Cut Off hodnota) se vypočte pomocí tohoto vzorce:

Cut Off hodnota = Průměr negativních kontrol + tolerance

Vyberte toleranci jednou z těchto metod:

n RFUs (výchozí) – vyberte tuto metodu pro použití absolutní hodnoty RFU pro toleranci. Minimální
hodnota tolerance RFU je 2. Maximální hodnota je absolutní hodnota nejvyšší hodnoty RFU
mínus absolutní hodnota nejnižší hodnoty RFU. Výchozí hodnota tolerance RFU je 10 %
celkového rozsahu RFU.

n Percent of Range (Procenta rozsahu) – vyberte tuto metodu pro použití procenta rozsahu RFU
pro toleranci. Minimální procento rozsahu je 1 %. Maximální procento rozsahu je 99 %. Výchozí
hodnota rozsahu je 10 %.
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Úprava analýzy dat koncových bodů
Úprava analýzy dat na kartě End Point (Koncový bod)

u Postupujte následovně:

n Z rozevíracího seznamu vyberte fluorofor.

n Vyberte hodnotu End Cycle to Average (Koncový bod k průměru), abyste nastavili počet
cyklů, pomocí kterých se vypočítá průměrný koncový bod RFU.

n Vyberte RFU pro zobrazení dat v jednotkách relativní fluorescence.

n Vyberte položku Percentage of Range (Procenta rozsahu) pro zobrazení dat jako procenta
rozsahu RFU.

n Vyberte jamky v selektoru jamek a zaměřte se na podmnožiny dat.

n Vyberte skupinu jamek pro zobrazení a analýzu podmnožiny jamek v destičce. V rozevírací
nabídce Well Group (Skupina destiček) v panelu nástrojů vyberte každou skupinu podle
názvu.

Tabulka RFU pro analýzu koncových bodů
Tabulka 29 definuje data, která se objevují v tabulce RFU na kartě End Point (Koncový bod).

Informace Popis

Well (Jamka) Pozice jamek na destičce

Fluor Detekovaný fluorofor

Content (Obsah) Kombinace typu vzorku a čísla replikace

End RFU (Koncové RFU) RFU v cyklu koncového bodu

Call (Označení) Pozitivní nebo negativní, kdy pozitivní vzorky mají hodnotu RFU vyšší než
průměrná RFU negativních kontrol plus cut-off hodnota

Sample (Vzorek) Název vzorku načtený v nástroji Plate Editor (Editor destiček)

Tabulka 29. Obsah tabulky End Point (Koncový bod)
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Karta Allelic Discrimination (Alelická diskriminace)
Karta Allelic Discrimination (Alelická diskriminace) přiřazuje genotypy jamkám s neznámými vzorky.
Použijte tyto údaje k identifikaci vzorků s různými genotypy, včetně alely 1, alely 2, heterozygotu, bez
signálu (žádná amplifikace) nebo neurčené.

Poznámka: Data pro alelickou diskriminaci musí pocházet z multiplexních cyklů s alespoň dvěma
fluorofory. Každý fluorofor identifikuje jednu alelu ve všech vzorcích.

Analýza alelické diskriminace vyžaduje následující minimální obsah jamek:

n Dva fluorofory v každé jamce

n Příklady NTC (no template control; kontrola bez templátu) pro optimalizovanou analýzu dat

Software CFX Manager Dx nabízí čtyři možnosti zobrazení alelických diskriminačních dat:

n Graf Allelic Discrimination (Alelická diskriminace) – zobrazuje data v grafu RFU pro alelu 1 / alelu
2. Každý bod grafu představuje data z obou fluoroforů v jedné jamce. Zaškrtnutím a zrušením
zaškrtnutí políčka Polar Coordinates (Polární souřadnice) můžete přepínat mezi kartézskými a
polárními souřadnicemi. Kartézské souřadnice představují RFU pro alelu 1 na ose x a RFU pro
alelu 2 na ose y. Polární souřadnice představují úhel na ose x a vzdálenost mezi počátkem a RFU
na ose y (medián všech NTC).
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n Well spreadsheet (Tabulka jamky) – zobrazuje alelická diskriminační data shromážděná v každé
jamce destičky.

n Well selector (Nástroj pro výběr jamky) – vybere jamky s alelickými daty, která chcete zobrazit.

n Selected Fluorophores panel (Panel vybraných fluoroforů) – změní popisky os x a y v grafu Allelic
Discrimination (Alelická diskriminace), analyzovaný cyklus a zda zobrazovat mapu signálů.

Úprava dat pro alelickou diskriminaci
Software automaticky přiřadí genotyp jamkám s neznámými vzorky na základě pozic NTC a úhlu a
vzdálenosti neznámých datových bodů z NTC.

Úprava dat alelické diskriminace

u Postupujte následovně:

n Chcete-li zobrazit polární souřadnice, zaškrtněte políčko v grafu Allelic Discrimination
(Alelická diskriminace).

n Chcete-li zobrazit další fluorofor, vyberte ho z rozevíracího seznamu na panelu Selected
Fluorophores (Vybrané fluorofory).

n Chcete-li změnit signál, přetáhněte ho přes datové body v grafu Allelic Discrimination
(Alelická diskriminace) a vyberte možnost v seznamu vybraných jamek:

o Allele 1 (Alela 1)

o Allele 2 (Alela 2)

o Heterozygote (Heterozygot)

o Undetermined (Neurčený)

o No Call (Bez signálu)

o Auto Call (Automatický signál)

Tip: Chcete-li se vrátit k výchozímu signálu, vyberte možnost Auto Call (Automatický
signál).
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Možnosti nabídky grafu
Kromě obecných možností nabídky po kliknutí pravým tlačítkemmyši pro grafy (viz část Společné
položky nabídky pro grafy po kliknutí pravým tlačítkemmyši na straně 178) uvádí Tabulka 30 možnosti
nabídky dostupné v grafu Allelic Discrimination (Alelická diskriminace).

Možnosti nabídky Funkce

Zoom (Lupa) Zaměří zobrazení grafu na zvolenou oblast (kliknutím a přetažením
kurzoru do grafu).

Tip: Pokud chcete obnovit přiblížení na zobrazení všech
datových bodů, klikněte pravým tlačítkem myši a vyberte
možnost Set Scale to Default (Nastavit měřítko na výchozí
nastavení).

Well (Jamka) Pro vybranou jamku jsou k dispozici následující možnosti: zobrazit
pouze tuto jamku, odstranit jamku ze zobrazení, nastavit barvu pro
tuto křivku nebo tuto jamku vyloučit z analýzy.

Selected Wells (Vybrané jamky) Pro vybrané jamky (vybrané kliknutím a přetažením kurzoru v
grafu) jsou k dispozici následující možnosti: zobrazit pouze tyto
jamky, odstranit jamky ze zobrazení, nastavit barvu pro tyto křivky
nebo tyto jamky vyloučit z analýzy.

Tabulka 30. Graf Allelic Discrimination (Alelická diskriminace) – možnosti nabídky po kliknutí
pravým nebo levým tlačítkem myši

Tabulka Allelic Discrimination (Alelická diskriminace)
Tabulka 31 definuje data, která se objevují v tabulce Allelic Discrimination (Alelická diskriminace).

Informace Popis

Well (Jamka) Pozice jamek na destičce

Sample (Vzorek) Popis názvu vzorku

Call (Signál) Určení alely, včetně automatické alely 1, alely 2, heterozygotů, bez
signálu nebo neurčené

Tabulka 31. Obsah tabulky Allelic Discrimination (Alelická diskriminace)
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Karta Allelic Discrimination (Alelická diskriminace)

Informace Popis

Type (Typ) Auto (Automaticky) nebo manuálně, popisuje, jak byl signál získán.
Automaticky označuje případ, kdy signál vybral software. Manuálně
označuje případ, kdy signál vybral uživatel.

RFU1 RFU pro alelu 1

RFU2 RFU pro alelu 2

Tabulka 31. Obsah tabulky Allelic Discrimination (Alelická diskriminace), pokračování
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Karta Custom Data View (Vlastní zobrazení dat)
Karta Custom Data View (Vlastní zobrazení dat) zobrazuje souběžně několik podoken v
přizpůsobitelném formátu.

Rozevírací seznam Load a Preset View (Načíst přednastavené zobrazení) nabízí výběr šablon
formátů zobrazení. Výchozí zobrazení nezávisí na analyzovaném souboru. Například pokud jsou
přítomna data Melt Curve (Křivka tání), objeví se výchozí zobrazení Amp+Melt (Amplifikace+tání).
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Vytvoření vlastního zobrazení dat
Jak vytvořit vlastní zobrazení dat

u Postupujte následovně:

n Z rozevíracího seznamu vyberte alternativní přednastavené zobrazení.

n Vyberte z rozevíracího seznamu nahoře v každém podokně jiný náhled grafu.

n Změňte počet řádků a sloupců na kartě.

n Změňte rozměry jednotlivého podokna. Přetáhněte sloupce na okraj každého podokna.

Pro uložení upravených hodnot jako přednastavené šablony klikněte na položku Save as Preset
(Uložit jako předvolbu). Pro výmaz, přejmenování nebo obnovu stávajících přednastavených náhledů
klikněte na položku Manage Presets (Spravovat předvolby).
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Karta QC (Kontrola kvality)
Karta QC (Kontrola kvality) vám umožňuje rychlý přístup ke kvalitě dat pracovního cyklu na základě
pravidel definovaných na kartě QC (Kontrola kvality).

Software CFX Manager Dx nabízí čtyři možnosti zobrazení dat QC (Kontrola kvality):

n Graf Amplification (Amplifikace) – zobrazí RFU pro každou jamku při každém cyklu. Každá
trasa v grafu představuje data z jednoho fluoroforu v jedné jamce.

n QC rules table (Tabulka pravidel kontroly kvality) – zobrazí dostupná pravidla QC (Kontrola
kvality) a nastavení definující každé pravidlo. Použitá pravidla QC (Kontrola kvality) jsou
označena zaškrtnutím.

n Well selector (Nástroj pro výběr jamky) – vybere jamky s daty o fluorescenci, které chcete
zobrazit.

n QC rule summary pane (Souhrnný panel pravidel QC) – zobrazí vybrané pravidlo QC
(Kontrola kvality) a zvýrazní jamky, které pravidlo nesplňují.

Změna kritérií QC (Kontrola kvality)
Jak změnit kritéria QC (Kontrola kvality)

u Vyberte nebo odznačte zaškrtávací políčko Use (Použít) pro pravidlo, které chcete podle situace
zahrnout nebo odejmout z položky QC (Kontrola kvality).
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Vyloučení jamek, které neprojdou testem QC (Kontrola kvality)
Software CFX Manager Dx zobrazuje sloupce, které nesplňují kritéria QC (Kontrola kvality), ve sloupci
Výsledky v tabulce zásad QC (Kontrola kvality) a v souhrnném podokně.

Vyloučení jamek, které nesplňují kritéria QC (Kontrola kvality)

u Vyberte možnost Exclude Wells (Vyloučit jamky) pro každou jamku, kterou chcete vyloučit.
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Karta Run Information (Informace o cyklu)
Karta Run Information (Informace o cyklu) zobrazuje protokol a další informace o každém cyklu. Tato
karta slouží k následujícím akcím:

n Zobrazení protokolu.

n Zadání nebo úprava poznámek o cyklu.

n Zadání nebo úprava ID nebo čárového kódu cyklu.

n Zobrazení událostí, ke kterým mohlo dojít během cyklu. Tyto zprávy mohou pomoci při řešení
problému.

Tip: Chcete-li kopírovat, exportovat nebo tisknout protokol, klikněte na něj pravým tlačítkemmyši.
Klepněte pravým tlačítkemmyši do podoken Notes (Poznámky), ID/Bar Code (ID/Čárový kód)
nebo Other (Jiné), chcete-li vyjmout, kopírovat, vložit, odstranit nebo vybrat text.
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Hlášení z analýzy dat

Hlášení z analýzy dat
Dialogové okno Report (Hlášení) zobrazí informace o aktuálním datovém souboru v okně Data
Analysis (Analýza dat). Chcete-li otevřít hlášení, zvolte Tools > Reports (Nástroje > Hlášení).

Okno Report (Hlášení) obsahuje následující části:

n Nabídka a panel nástrojů – poskytuje možnosti formátování, ukládání a tisku hlášení nebo
šablony.

n Seznammožností (levá horní strana dialogového okna) – poskytuje možnosti zobrazení v
hlášení.

n Podokno možností (vlevo dole v dialogovém okně) – zobrazuje textová pole, do kterých můžete
zadat informace o vybrané možnosti.

n Podokno náhledu (pravá strana dialogového okna) – zobrazuje náhled aktuálního hlášení.
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Kategorie hlášení z analýzy dat
Tabulka 32 obsahuje všechny dostupné možnosti pro hlášení z analýzy dat podle typu dat v okně Data
Analysis (Analýza dat).

Kategorie Možnost Popis

Header (Záhlaví)

Titul, podtitul a logo pro hlášení

Report Information (Informace o
hlášení)

Datum cyklu, uživatelské jméno, název
datového souboru, cesta k datovému
souboru a vybraná skupina jamek

Audit Information (Informace
pro audit)

Dodatečné informace požadované pro
audit, včetně podpisů

Notes (Poznámky) Poznámky k datovému hlášení

Run Setup (Nastavení cyklu)

Run Information (Informace o
cyklu)

Datum cyklu, uživatelské jméno, název
datového souboru, cesta k datovému
souboru a vybraná skupina jamek

Protocol (Protokol) Textové zobrazení kroků a možností
protokolu

Plate Display (Zobrazení
destiček)

Zobrazení informací o destičkách pro
každou jamku destičky

Quantification (Kvantifikace)

Analysis Settings (Nastavení
analýzy)

Číslo kroku sběru dat, režim analýzy a
výchozí metoda odečítání

Amplification Chart (Graf
amplifikace)

Graf amplifikace pro cykly zahrnující
kvantifikační data

Standard Curve Chart (Graf
standardních křivek)

Graf standardních křivek

Tabulka 32. Kategorie hlášení z analýzy dat v seznamu možností
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Kategorie Možnost Popis

Data Tabulka se seznamem dat pro každou
jamku

Gene Expression – Bar Chart (Exprese genu – sloupcový graf)

Analysis Settings (Nastavení
analýzy)

Režim analýzy, data grafu, možnost
úpravy měřítka a chyba grafu

Chart (Graf) Kopie sloupcového grafu

Target Names (Názvy cílů) Graf názvů cílů

Sample Names (Názvy vzorků) Graf názvů vzorků

Data Tabulka se seznamem dat pro každou
jamku

Target Stability (Cílová stabilita) Graf cílových hodnot stability

Gene Expression (Exprese genu) – clustergram a rozptylový graf

Analysis Settings (Nastavení
analýzy)

Nastavení pro každý typ grafu

Chart (Graf) Kopie grafu

Data Tabulka se seznamem dat pro každý cíl

Melt Curve (Křivka tání)

Analysis Settings (Nastavení
analýzy)

Nastavení čísla kroku tání a sloupce
prahu

Melt Curve Chart (Graf křivky
tání)

Graf křivky tání

Melt Peak Chart (Graf vrcholů
tání)

Graf vrcholů tání

Data Tabulka se seznamem dat pro každou
jamku

Allelic Discrimination (Alelická diskriminace)

Tabulka 32. Kategorie hlášení z analýzy dat v seznamu možností, pokračování
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Kategorie Možnost Popis

Analysis Settings (Nastavení
analýzy)

Zobrazí fluorofory, cyklus a mapu
jamek podle genotypu

Allelic Discrimination Chart
(Graf alelické diskriminace)

Kopie grafu alelické diskriminace

Data Tabulka se seznamem dat pro každou
jamku

End Point (Koncový bod)

Analysis Settings (Nastavení
analýzy)

Fluorofor, koncové cykly do průměru,
režim, nejnižší hodnota RFU, nejvyšší
hodnota RFU a cut-off hodnota

Data Tabulka se seznamem dat pro každou
jamku

QC Parameters (Parametry kontroly kvality)

Data Tabulka se seznamem parametrů pro
každé pravidlo QC (Kontrola kvality)

Tabulka 32. Kategorie hlášení z analýzy dat v seznamu možností, pokračování
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Hlášení z analýzy dat

Vytvoření hlášení z analýzy dat
Rozvržení sestavy můžete uložit jako šablonu, kterou můžete znovu použít pro podobná hlášení.

Vytvoření hlášení o analýze dat

1. Před vytvořením hlášení proveďte konečné úpravy obsahu jamky, vybraných jamek, grafů a
tabulek v okně Data Analysis (Analýza dat).

2. Vyberte položky Tools > Reports (Nástroje > Hlášení) na panelu nabídek Data Analysis (Analýza
dat) a otevřete dialogové okno Report (Hlášení).

3. Vyberte možnosti, které chcete do hlášení zahrnout. Hlášení se otevře s vybranými výchozími
možnostmi. Označte nebo odznačte zaškrtávací políčka pro změnu celých kategorií nebo
jednotlivých možností v kategorii.

Poznámka: Data, která se objeví v hlášení, závisí na aktuálních výběrech v záložkách Data
Analysis (Analýza dat). Například kvantifikační cyklus nemusí obsahovat standardní křivku, a
proto se tato data neobjeví v okně Data Analysis (Analýza dat) nebo v hlášení dat.

4. Změňte pořadí kategorií a položek v hlášení. Přetáhněte možnosti do relativní pozice. Položky lze
přeuspořádat pouze v rámci kategorií, do kterých patří.

5. (Volitelné) V podokně Report Options (Možnosti hlášení) zadejte informace relevantní pro
vybranou možnost:

n Vyberte podmnožinu informací, které se mají zobrazit v hlášení.

n Zvolte konkrétní nastavení pro vybranou možnost.

n Změňte text, který se má zobrazit pro vybranou možnost.

6. Klikněte na položku Update Report (Aktualizovat hlášení) pro aktualizaci Report Preview (Náhled
hlášení) se zohledněním všech změn.

7. Hlášení vytiskněte nebo uložte. Pro tisk aktuálního hlášení klikněte na tlačítko Print Report (Tisk
hlášení) na panelu nástrojů. Vyberte položky File > Save (Soubor > Uložit) pro uložení hlášení
jako PDF (Adobe Acrobat Reader soubor) a vyberte umístění, do kterého chcete soubor uložit.
Uložte hlášení s novým názvem nebo do nového umístění tak, že vyberete položky Select File >
Save As (Vybrat soubor > Uložit jako).

8. (Volitelné) Vytvořte šablonu hlášení s požadovanými informacemi. Pro uložení aktuálního
nastavení hlášení v šabloně vyberte Template > Save (Šablona > Uložit) nebo Save As (Uložit
jako). Poté při příští tvorbě nového hlášení načtěte šablonu hlášení.
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Vytvoření hlášení o skupinách jamek
Jak vytvořit hlášení o skupinách jamek

1. Vyberte Tools > Well Group Reports (Nástroje > Hlášení o skupinách jamek) v okně Data
Analysis (Analýza dat).

2. V dialogovém okněWell Groups Reports (Hlášení o skupinách jamek) vyberte skupiny jamek,
kroky amplifikace a kroky tání, které mají být v hlášení uvedeny.

3. Zadejte cestu nebo přejděte do cílové složky, do které má být hlášení uloženo.

4. (Volitelné) Vyberte položku Choose a Report Template (Vybrat šablonu hlášení) a přejděte do
složky se souborem šablony.

5. (Volitelné) Vyberte položku Open Destination Folder (Otevřít cílovou složku), otevře se složka a
zobrazí vygenerovaná hlášení.

6. Klikněte na položku Create Reports (Vytvořit hlášení).
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Kapitola 11 Analýza exprese genu
Při použití přesně kvalifikovaných kontrol ve svých reakcích můžete pomocí softwaru CFX Manager
Dx provádět cyklus exprese genu s cílem normalizovat relativní rozdíly cílové koncentrace mezi
vzorky. Obvykle se pro normalizaci úrovní exprese zájmového genu používají úrovně exprese pro
jeden nebo několik referenčních genů. Referenční geny berou v úvahu rozdíly v založení či jiné
odchylky v každém vzorku a jejich úrovně exprese by neměly být ve studovaném biologickém systému
ovlivněny.

Vyberte kartu Gene Expression (Exprese genu) v okně Data Analysis (Analýza dat) pro hodnocení
relativních rozdílů mezi reakcemi PCR ve dvou nebo více jamkách. Můžete například vyhodnotit
relativní počty virových genomů nebo relativní počty převáděných sekvencí v reakci PCR.
Nejběžnějším využitím pro studii exprese genu je srovnání koncentrace cDNA ve více než jedné
reakci pro odhad úrovní mediátorové RNA ve stabilním stavu.

Software vypočítá úroveň relativní exprese cíle s jedním z těchto scénářů:

n Úroveň relativní exprese cílové sekvence (cíl 1) vzhledem k jinému cíli (cíl 2); například množství
jednoho genu vzhledem k jinému genu se stejným zpracováním vzorku.

n Úroveň relativní exprese jedné cílové sekvence v jednom vzorku ve srovnání se stejným cílem s
jiným zpracováním vzorku; například relativní množství jednoho genu vzhledem k tomuto
samotnému genu za odlišných časových, geografických či vývojových podmínek.

Nastavení destičky pro analýzu exprese genu
Pro provedení analýzy exprese genu musí obsah jamek zahrnovat následující:

n Dva nebo více cílů – dva cíle, které představují různé amplifikované geny nebo sekvence ve
vzorcích.

n Jeden nebo více referenčních cílů – alespoň jeden cíl musí být referenčním cílem pro
normalizovanou expresi. Přiřaďte všechny referenční cíle v okně Experiment Settings (Nastavení
experimentu) pro analyzování dat v režimu normalizované exprese (ΔΔCq). Cykly, které
neobsahují referenční hodnotu, musí být analyzovány pomocí režimu relativní exprese (ΔCq).
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n Běžné vzorky – vaše reakce musí obsahovat běžné vzorky (minimálně dva požadované), aby
bylo možné zobrazit data zobrazená na kartě Gene Expression (Exprese genu). Tyto vzorky by
měly představovat různé způsoby léčby nebo stavů pro každou z vašich cílových sekvencí. V
okně Experiment Settings (Nastavení experimentu) přiřaďte kontrolní vzorek (volitelné). Pokud
není vybrána žádná kontrola, software použije jako kontrolu nejnižší hodnotu Cq.

Požadavky na nastavení exprese genu v nastavení Gene Expression (Exprese genu) v editoru Plate
Editor (Editor destiček) závisí na tom, zda jsou obsahy reakcí jednorázové PCR s jedním fluoroforem v
reakcích, nebo multiplexní PCR s více než jedním fluoroforem v reakcích.

Průvodce nastavením destičky
Jestliže nastavení destičky v datovém souboru neobsahuje informace nezbytné pro analýzu a je
vybrána karta Gene Expression (Exprese genu), bude prostor, ve kterém je obvykle umístěn
sloupcový graf, obsahovat pokyny pro zadávání těchto informací. Pro normalizovanou expresi genu
proveďte následující kroky:

1. Definujte názvy Target (Cíl) a Sample (Vzorek) jedním z následujících postupů:

n Plate Setup (Nastavení destičky) – otevře okno Plate Editor (Editor destiček).

n Replace Plate File (Nahradit soubor destičky) – otevře prohlížeč Select Plate (Vybrat
destičku), ve kterémmůžete přejít na dříve uložený soubor destičky, jímž chcete nahradit
aktuální rozložení destičky.

n Replace PrimePCR File (Nahradit soubor PrimePCR) – otevře dialogové okno Select
PrimePCR file (Vybrat soubor PrimePCR), ve kterémmůžete přejít na spouštěcí soubor
PrimePCR a použít jej na rozložení destičky.

2. Vyberte jeden nebo několik referenčních cílů a kontrolní vzorek v dialogovém okně Experiment
Settings (Nastavení experimentu).

Pokud rozložení destičky již obsahuje informace o cíli a vzorku, je nutný pouze druhý krok, jenž je
zvýrazněn oranžově. Tento krok je nutné provést před analýzou normalizované exprese genu.

Poznámka: Data pro graf „clustergram“ a rozptylový graf jsou zobrazena pouze tehdy,
pokud jsou splněny všechny požadavky na normalizovanou expresi genu uvedené v Plate
Setup (Nastavení destičky) pro analýzu exprese genu.
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Grafy exprese genu
Software CFX Manager Dx zobrazí data exprese genu v několika zobrazeních. Tabulka 33 obsahuje
seznammožností grafu, které jsou v softwaru k dispozici.

Tlačítko Název Funkce

Sloupcový graf Zobrazí data o normalizované expresi genu
ve formátu sloupcového grafu.

Graf „clustergram“ Zobrazí data o normalizované expresi v
hierarchii podle úrovně podobnosti exprese
pro různé cíle a vzorky.

Rozptylový graf Zobrazí normalizovanou expresi cílů pro
kontrolu ve srovnání s experimentálním
vzorkem.

Výsledky Obsahuje souhrn dat ze všech grafů.

Tabulka 33. Možnosti grafu exprese genu
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Sloupcový graf

Relativní exprese cílů je uvedena v těchto dvou zobrazeních:

n Graf exprese genu – zobrazí data PCR v reálném čase jako jednu z následujících možností:

o ΔΔCq – relativní normalizovaná exprese vypočtena pomocí kontrolních vzorků a referenčních cílů.

o ΔCq – relativní množství cílového genu ve vzorku vzhledem ke kontrolnímu vzorku.

n Tabulka – zobrazí tabulku dat exprese genu.

Tip: Klikněte pravým tlačítkemmyši na libovolný graf nebo tabulku možností. Vyberte
možnost View/Edit Plate (Zobrazit/Upravit destičku) z rozevírací nabídky Plate Setup
(Nastavení destičky), aby se otevřel editor Plate Editor (Editor destiček), a změňte obsah
jamky na destičce.

Tip: Pravým tlačítkemmyši vyberte položku Sort (Třídit), chcete-li uspořádat pořadí názvů
Target (Cíl) a Sample (Vzorek) v grafu.
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Sloupcový graf

Normalizovaná exprese genu

Pro normalizaci dat použijte jako normalizační faktor naměřenou úroveň exprese jednoho nebo
několika referenčních genů. Referenční geny jsou cíle, které nejsou ve studovaném biologickém
systému regulovány, například aktin,GAPDH nebo tubulin.

Jak nastavit analýzu normalizované exprese genu (ΔΔCq)

1. Otevřete datový soubor (koncovka .pcrd).

2. Zkontrolujte data na kartě Quantification (Kvantifikace) okna Data Analysis (Analýza dat).
Proveďte úpravy dat, například změnu prahu a režim analýzy.

3. Vyberte kartu Gene Expression (Exprese genu).

4. Na kartě Gene Expression (Exprese genu) klikněte na Experiment Settings (Nastavení
experimentu).

5. V dialogovém okně Experiment Settings (Nastavení experimentu) postupujte následovně:

a. Vyberte kartu Samples (Vzorky) a zvolte kontrolu. Když je kontrola přiřazena normalizuje software
Software CFX Manager Dx relativní množství pro všechny geny na množství kontroly, nastavené
na 1.

b. Vyberte kartu Target (Cíl) a zvolte referenční geny. Analýza exprese genu vyžaduje jednu
referenci mezi cíli ve vašem vzorku.

6. Vyberte možnost Normalized Expression (ΔΔCq (Normalizovaná exprese (ΔΔCq)), pokud již není
vybrána, a následně zobrazte úrovně exprese na kartě Gene Expression (Exprese genu).

Relativní množství

Už ze své povahy nejsou data o relativním množství (ΔCq) normalizována. Tato metoda se používá ke
kvantifikaci vzorků, jež nezahrnují žádné referenční geny (cíle). Když výzkumníci připravují svůj
cyklus, obvykle spoléhají na jeden z následujících předpokladů:

n Každý vzorek obsahuje stejné množství RNA nebo cDNA v každé jamce.

n Jakékoliv odchylky v množství založeného biologického vzorku budou normalizovány po cyklu
nějakou metodou analýzy dat mimo samotný software. Výzkumník se může například rozhodnout,
že hodnotu relativního množství vydělí normalizačním faktorem, případně hmotností nukleové
kyseliny založené pro každý vzorek nebo počtem buněk, ze kterých byla nukleová kyselina
izolována.
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Jak provést analýzu relativního množství (ΔCq)

u Na kartě Gene Expression (Exprese genu) vyberte z rozevíracího seznamu Mode (Režim) v
pravém podokně možnost Relative Quantity (ΔCq) (Relativní množství (ΔCq)).

Tip: Pro porovnání výsledků s daty z jiných cyklů exprese genu otevřete novou genovou
studii nebo přidejte datový soubor do stávající genové studie.

Řazení cílových hodnot a dat vzorků
Poznámka: Tato možnost je k dispozici pouze v grafu exprese genu.

Ve výchozím nastavení se seznamy Targets (Cíle) a Samples (Vzorky) zobrazují v abecedním pořadí.
Dialogové okno Sort (Řazení) slouží k řazení zobrazení v obráceném abecedním pořadí nebo k
ručnímu přesunutí výrazu na jinou pozici v seznamu.

Řazení cílů a vzorků

1. Z nabídky grafu po kliknutí pravým tlačítkemmyši klikněte na položku Sort (Řazení).

Zobrazí se dialogové okno Gene Expression Chart Sorting (Řazení dat grafu exprese genu).

2. V dialogovém okně klikněte na položku Z-A a seřadíte seznam v obráceném abecedním pořadí.

3. Chcete-li termín ručně přesunout, vyberte jej a klikněte na příslušné tlačítko mezi grafy:

n Kliknutím na šipku nahoru nebo dolů přesunete vybraný termín o jednu pozici.

n Kliknutím na šipku nahoru nebo dolů přesunete vybraný výraz na začátek nebo na konec
seznamu.

4. Kliknutím na tlačítko OK a uložte změny a vraťte se na kartu Gene Expression (Exprese genu).
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Úprava dat exprese genu
Po výběru režimu analýzy – normalizovaná exprese (∆∆Cq) nebo relativní množství (∆Cq), upravte
data, která vidíte na kartě Gene Expression (Exprese genu) změnou možností nastavení na pravé
straně grafu.

Tip: Výchozí možnosti dat Gene Expression (Exprese genu) nastavíte v dialogovém okně User
Preferences (Uživatelské předvolby) (viz Nastavení výchozích parametrů datového souboru exprese
genu na straně 73).

Data grafu

Nastavte hodnotu osy y na lineární měřítko, abyste umožnili možnosti dat grafu. Možnosti dat grafu
vám umožňují prezentovat data v grafu jednou z těchto možností:

n Relativní ke kontrole – graf dat s osou škálovanou od 0 do 1. Pokud přiřadíte kontrolu do cyklu,
vyberte tuto možnost pro rychlou vizualizaci upregulace a downregulace cíle.

n Relativní k nule – graf dat s počátkem na nule.

Kontrolní vzorek

Pomocí rozevírací nabídky kontrolních vzorků vyberte vzorek , který/která bude použit/a k normalizaci
relativního množství:

Nastavení grafu

Při označení zaškrtávacího políčka Show Chart Settings (Zobrazit nastavení grafu) se zobrazí
následující možnosti (popsané níže): X-Axis (Osa X), Y-Axis (Osa Y), Scaling (Rozsah), Error Type
(Typ chyby) a Chart Error Multiplier (Násobitel chyby v grafu).

Možnosti osy X

Volba osy x umožňuje vybrat data osy x grafu Gene Expression (Exprese genu):

n Cíl – zobrazuje názvy cílů na ose x.

n Vzorek – zobrazuje názvy vzorků na ose x.
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Možnosti osy Y

Možnosti osy Y vám umožňují zobrazit graf Gene Expression (Exprese genu) v jednom z těchto tří
měřítek:

n Linear (Lineární) – vyberte tuto možnost pro zobrazení lineárního měřítka.

Tip: Po nastavení osy Z na Linear (Lineární) je k dispozici rozevírací seznam Graph Data
(Data grafu), ze kterého lze vybrat sestavení grafu dat vzhledem ke kontrole nebo vzhledem
k nule.

n Log 2 – vyberte tuto možnost pro vyhodnocení vzorků napříč velkým dynamickým rozsahem.

n Log 10 – vyberte tuto možnost pro vyhodnocení vzorků napříč velmi velkým dynamickým
rozsahem.

Možnosti rozsahu

Vyberte Normalized Gene Expression (Normalizovaná exprese genu) (ΔΔCq) a nastavte pro položku
Control Sample (Kontrolní vzorek) možnost None (Žádná), aby se povolila možnost škálování v grafu
exprese genu. Vyberte jednu z těchto možností škálování pro výpočet a prezentaci svých dat
způsobem, který nejlépe vyhovuje vašemu návrhu běhu:

n Unscaled (Bez měřítka) – představuje normalizovanou expresi genu bez rozsahů.

n Highest (Nejvyšší) – rozsahy normalizované exprese genu pro každý cíl vydělením úrovně
exprese každého vzorku nejvyšší úrovně exprese ve všech vzorcích.

Tato volba škálování používá vzorec rozsahu na nejvyšší hodnotu.

n Lowest (Nejnižší) – rozsahy normalizované exprese genu pro každý cíl vydělením úrovně
exprese každého vzorku nejnižší úrovně exprese ve všech vzorcích.

Tato volba škálování používá vzorec rozsahu na nejnižší hodnotu.

n Average (Průměrná) – rozsahy normalizované exprese genu pro každý cíl vydělením úrovně
exprese každého vzorku geometrickým průměrem hladin exprese pro všechny vzorky.

Tato volba škálování používá vzorec rozsahu na průměrnou hodnotu.

Typ chyby

V grafu Gene Expression (Exprese genu) vyberte možnost výpočtu typu chyby (chybové úsečky):

n Standard error of the mean (Standardní chyba průměru) (výchozí)

n Standard deviation (Směrodatná odchylka)
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Násobitel chybové úsečky v grafu

V grafu Gene Expression (Exprese genu) vyberte násobitel chybových úseček. Vyberte jedno z těchto
celých čísel:
+/− 1 (výchozí), 2, nebo 3. Typ násobitele se změní, když vyberete typ chyby:

n SEMs (Hodnoty SEM) pro standardní chybu průměru

n Std Devs (Směrodatné odchylky) pro směrodatné odchylky

Nastavení experimentu
Tip: Toto dialogové okno je také dostupné v nástroji Plate Editor (Editor destiček). Více informací
naleznete v části Změna nastavení experimentu na straně 133.

V dialogovém okně Experiment Settings (Nastavení experimentu) můžete zobrazit nebo změnit
seznam cílů nebo vzorků, vybrat referenční geny, vybrat kontroly nebo nastavit analýzu Gene
Expression Analysis (Analýza exprese genu) skupiny, kterou chcete analyzovat, pokud do jamek byly
přidány názvy biologického souboru.

Otevření dialogového okna Experiment Settings (Nastavení experimentu)

u Na kartě Bar Chart (Sloupcový graf) klikněte v dolní části pravého podokna na položku
Experiment Settings (Nastavení experimentu).

Zobrazí se dialogové okno Experiment Settings (Nastavení experimentu), které zobrazuje kartu
Targets (Cíle).
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Úprava nastavení Targets (Cíle)

u Na kartě Targets (Cíle) postupujte následovně:

n Chcete-li vybrat cíl jako referenční cíl pro analýzu dat exprese genu, vyberte jeho název ve
sloupci Reference.

n Chcete-li změnit barvu cíle, klikněte na jeho buňku ve sloupci Color (Barva) a změňte barvu v
zobrazeném dialogovém okně Color (Barva).

Změna barvy se objeví v grafech Gene Expression (Exprese genu).

n Chcete-li použít dříve určenou hodnotu účinnosti, zrušte zaškrtnutí políčka cíle ve sloupci
Auto Efficiency (Automatická účinnost) a zadejte číslo pro procento účinnosti cíle.

Software vypočítá relativní účinnost pro cíl pomocí funkce Auto Efficiency (Automatická
účinnost), pokud data pro cíl obsahují standardní křivku.

Úprava nastavení položky Sample (Vzorek)

u Na kartě Samples (Vzorky) postupujte následovně:

n Chcete-li vybrat vzorek jako kontrolu analýzy dat exprese genu, vyberte jeho název ve
sloupci Control (Kontrola).

n Chcete-li změnit barvu vzorku skupiny, klikněte na její buňku ve sloupci Color (Barva) a
změňte barvu v zobrazeném dialogovém okně Color (Barva).

Změna barvy se projeví v grafech Gene Expression (Exprese genu).

n Chcete-li zobrazit vzorek v grafech Gene Expression (Exprese genu), vyberte příslušnou
položku ve sloupci Show Chart (Zobrazit graf).

n Chcete-li odstranit vzorek z grafů Gene Expression (Exprese genu), odstraňte příslušnou
položku ve sloupci Show Chart (Zobrazit graf).

Tip: Data vzorku skupiny zůstanou v tabulce Results (Výsledky).
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Změna výběru Biological Set Analysis Options (Možnosti analýzy biologických souborů)

u Pokud jste přiřadili jednu nebo více biologických souborů do jamek na destičce (viz Přiřazení
biologických souborů jamkám na straně 126), zobrazí se seznammožností Biological Set Analysis
Options (Možnosti analýzy biologických souborů) v dialogovém okně Experiment Settings
(Nastavení experimentu), což vám umožní podle potřeby změnit nastavení.

n Target vs. Sample (Cíl oproti vzorku) – ve výpočtech exprese genu se používá pouze
název vzorku v jamce.

n Target vs. Biological Set (Cíl oproti biologickému souboru) – ve výpočtech se používá
pouze název biologického souboru.

n Target vs. Sample_Biological Set (Cíl oproti vzorku_biologickému souboru) – název
vzorku a název biologického souboru jsou kombinovány, aby se ve výpočtech použil jediný
název.

n T arget vs. Biological Set_Sample (Cíl oproti biologickému souboru_vzorku) – název
biologického souboru a název vzorku jsou kombinovány, aby se ve výpočtech použil jediný
název.

Vyloučení typu vzorku z výpočtů analýzy

u Zaškrtněte políčko v dolní části dialogového okna Experiment Settings (Nastavení experimentu).

Poznámka: To vylučuje kontroly nebo standardy z analýzy exprese genu.

Hodnota stability cíle
Hodnoty stability cíle jsou vypočteny vždy, když je použit více než jeden referenční gen. Software CFX
Manager Dx vypočítává dva parametry kvality pro referenční geny:

n Coefficient Variance (Rozptyl koeficientu) (CV) relativních množství normalizovaného
referenčního genu. Nižší hodnota CV znamená větší stabilitu.

n M Value (M hodnota) (M), což je míra stability exprese referenčního genu.

Doporučené hodnoty CV a M jsou zobrazeny v dolní části dialogového okna Stability Value (Hodnota
stability).

Návod k použití | 235



Kapitola 11 Analýza exprese genu

Zobrazení hodnoty stability cíle

u Na kartě Gene Expression Bar Chart (Sloupcový graf exprese genu) klikněte v dolní části pravého
podokna na položku Target Stability Value (Hodnota stability cíle).

Otevře se dialogové okno Stability Value (Hodnota stability).

Možnosti nabídky po kliknutí pravým tlačítkem myši
Klikněte pravým tlačítkemmyši na graf exprese genu v Tabulka 34.

Položka Funkce

Copy (Kopírovat) Zkopíruje graf do schránky.

Save Image As (Uložit obrázek
jako)

Uloží graf jako soubor obrázku. Nastavte rozlišení a rozměry
obrázku a potom vyberte typ souboru (PNG, GIF, JPG, TIF nebo
BMP).

Page Setup (Nastavení
stránky)

Vybere nastavení stránky pro tisk.

Print (Tisk) Vytiskne graf.

Set Scale to Default (Nastavit
měřítko na výchozí)

Show All (Zobrazit vše) zobrazí všechna data v sloupcovém grafu.
Scroll Bar (Posuvník) zobrazí posuvník, pokud je v rámečku grafu
zobrazeno příliš mnoho vzorků a zároveň je zachována minimální
šířka pruhu.

Chart Options (Možnosti grafu) Otevře okno Chart Options (Možnosti grafu) pro úpravu grafu.

Sort (Řazení) Seřadí vzorky nebo cíle, které se objeví na ose x grafu.

Use Corrected Std Devs
(Použít korigovanou std. odch.)

Vypočítá chybové pruhy pomocí vzorce korigované standardní
odchylky.

Use Solid Bar Colors (Použít
barvou vyplněné pruhy)

Zobrazuje v grafu vyplněné pruhy.

X–Axis Labels (Popisky osy x) Zobrazí popisky na ose x vodorovně nebo šikmo.

Tabulka 34. Položky nabídky exprese genu po kliknutí pravým tlačítkem myši
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Tabulka dat
Tabulka 35 definuje data zobrazená v datové tabulce Gene Expression (Exprese genu).

Poznámka: Hodnoty v tabulce se počítají na základě typu grafu a předvoleb vybraných v panelu
napravo.

Informace Popis

Target (Cíl) Název cíle (amplifikovaného genu) vybraného v okně Experiment
Settings (Nastavení experimentu).

Sample (Vzorek) Název vzorku v okně Experiment Settings (Nastavení experimentu).

Ctrl Název kontroly v okně Experiment Settings (Nastavení
experimentu).

Relativní množství nebo
Exprese

Relativní množství (ΔCq) nebo normalizovaná exprese genu
(ΔΔCq), v závislosti na vybraném režimu.

SEM (nebo SD) relativního
množství nebo exprese

Standardní chyba průměru (SEM) nebo směrodatná odchylka (SD)
relativního množství nebo normalizované exprese v závislosti na
zvolené možnosti.

SEM (nebo SD) opraveného
relativního množství nebo
exprese

Výpočet opravené hodnoty SEM nebo SD relativního množství
nebo normalizované exprese v závislosti na zvolené možnosti.

Průměr Cq Průměr kvantifikačního cyklu.

SEM (nebo SD) Cq SEM nebo SD kvantifikačního cyklu v závislosti na zvolené
možnosti.

Tabulka 35. Popis informací v tabulce na kartě Graphing (Grafy)Bar Chart (Sloupcový graf)
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Možnost Show Details (Zobrazit podrobnosti)
Tabulka 36 definuje data zobrazená při výběru možnosti Show Details (Zobrazit podrobnosti) z
nabídky pravého tlačítka tabulky sloupcového grafu.

Informace Popis

Datový soubor Údaje o fluorescenci jednoho fluoroforu v datovém souboru

Relativní množství Vypočtené relativní množství vzorků

SD relativního množství Výpočet směrodatné odchylky relativního množství

SD korigovaného relativního
množství

Výpočet směrodatné odchylky korigovaného relativního množství

SEM relativního množství Standardní chyba průměru výpočtu relativního množství

SEM korigovaného relativního
množství

Vypočtená standardní chyba průměru korigovaného relativního
množství

Relativní množství (lg) Log2 relativní veličiny, která se používá pro statistickou analýzu

SD RQ(lg) Směrodatná odchylka relativního množství (log2)

SEM exprese (lg) Standardní chyba průměru exprese (log2)

Exprese bez měřítka Vypočtená exprese bez měřítka

SD exprese bez měřítka Vypočtená směrodatná odchylka exprese bez měřítka

SD korigované exprese bez
měřítka

Výpočet směrodatné odchylky korigované exprese bez měřítka

SEM exprese bez měřítka Vypočtená standardní chyba průměru exprese bez měřítka

SEM korigované exprese bez
měřítka

Vypočtená standardní chyba průměru korigované exprese bez
měřítka

Exprese bez měřítka (lg) Log2 exprese bez měřítka

SD exprese bez měřítka (lg) Směrodatná odchylka exprese bez měřítka (log2)

SEM exprese bez měřítka (lg) Standardní chyba průměru exprese bez měřítka (log2)

Tabulka 36. Informace v tabulce sloupcového grafu s vybranými údaji Show Details (Zobrazit
podrobnosti)
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Informace Popis

Exprese Normalizovaná exprese genu

SD korigované exprese Vypočtená směrodatná odchylka

SEM exprese Standardní chyba průměru

SEM korigované exprese Vypočtená standardní chyba průměru

Exprese (lg) Log2 exprese (normalizované exprese), která se používá pro
statistickou analýzu

SD exprese (lg) Směrodatná odchylka exprese (log2)

SEM exprese (lg) Standardní chyba průměru exprese (log2)

Průměr Cq Průměr kvantifikačního cyklu

Cq SD Směrodatná odchylka kvantifikačního cyklu

Cq SEM Standardní chyba průměru kvantifikačního cyklu

Tabulka 36. Informace v tabulce sloupcového grafu s vybranými údaji Show Details (Zobrazit
podrobnosti), pokračování
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Graf „clustergram“
Graf „clustergram“ zobrazuje data v hierarchii vycházející ze stupně podobnosti exprese pro různé cíle
a vzorky.

Poznámka: Chcete-li zobrazit jiný datový graf než relativní expresi pro sloupcový graf, musíte
zvolit referenční cíl.

Obraz grafu „clustergram“ ukazuje relativní expresi vzorku nebo cíle takto:

n Upregulace (červeně) – vyšší exprese

n Downregulace (zeleně nebo modře) – nižší exprese

n Bez regulace (černě)

n Není vypočítána žádná hodnota (černě s bílým X)

Čím je barevný odstín světlejší, tím je rozdíl relativní exprese větší. Pokud nelze vypočítat žádnou
normalizovanou hodnotu Cq, bude čtverec černý s bílým X.

Na vnějších okrajích datového grafu je dendrogram, který znázorňuje shlukovou hierarchii. Cíle nebo
vzorky s podobnými vzory exprese budou mít napojené linky, zatímco odlišné vzory budou dále od
sebe.

Settings (Nastavení)
Můžete nastavit následující možnosti:

n Cluster By (Shluk) – vyberte z Targets (Cíle), Samples (Vzorky), Both (Oba) nebo None (Žádný).

n Size (Velikost) – upraví velikost obrazu a změní stupeň zvětšení grafu.

n Split Out Replicates (Rozdělit replikáty) – zobrazí hodnoty jednotlivých replikátů.

Tip: Můžete změnit barevné schéma pro clustergram a rozptýlený graf z výchozí červené/zelené na
červenou/modrou výběrem této možnosti z nabídky pod pravým tlačítkemmyši v kterémkoliv z těchto
grafů.

Možnosti nabídky po kliknutí pravým tlačítkem myši
Možnosti nabídky po kliknutí pravým tlačítkemmyši pro graf „clustergram“ jsou stejné jako v případě
sloupcového grafu. Pro dostupné možnosti viz Tabulka 34 na straně 236. Kromě toho vyberte Color
Scheme (Barevné schéma), pokud chcete změnit expresi downregulace v grafu z výchozí
červené/zelené na červenou/modrou.
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Tabulka dat
Tabulka zobrazuje hodnoty cílové, vzorové a normalizované exprese. Pro zahrnutí do grafu nebo
vyloučení z grafu klikněte na zaškrtávací políčko vedle cíle.
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Rozptylový graf
Rozptylový graf zobrazí normalizovanou expresi cílů pro kontrolu ve srovnání s experimentálním vzorkem.
Křivky grafu označují práh regulace. Datové body mezi křivkami ukazují, že rozdíl v expresi pro daný cíl (gen)
je mezi vzorky zanedbatelný. Datové body mimo křivky překračují práh regulace a mohly by být předmětem
zájmu.

Obrázek grafu ukazuje následující změny v expresi cíle na základě prahu regulace:

n Upregulace (červený kroužek) – relativně vyšší exprese

n Downregulace (zelený nebo modrý kroužek) – relativně nižší exprese

n Bez změny (černý kroužek)

Klikněte a přetáhněte libovolnou křivku prahu pro úpravu prahu regulace.

Nastavení
Můžete nastavit následující možnosti:

n Kontrolní vzorek

n Experimentální vzorek

n Práh regulace. Když budete zvyšovat nebo snižovat hodnotu regulace, budou se podle toho
pohybovat prahové křivky v grafu.

Možnosti nabídky po kliknutí pravým tlačítkem myši
Možnosti nabídky po kliknutí pravým tlačítkemmyši pro rozptylový graf jsou stejné jako v případě
sloupcového grafu. Pro dostupné možnosti viz Tabulka 34 na straně 236. Vedle toho vyberte možnost
Symbol, pokud chcete změnit symbol používaný v grafu z výchozího kroužku na jeden z následujících:

n Trojúhelník

n Kříž

n Čtverec

n Kosočtverec
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Tabulka dat
Tabulka zobrazuje hodnoty pro cíl a normalizovanou expresi pro kontrolní a experimentální vzorky.
Současně ukazuje, zda jsou cíle regulovány nahoru nebo dolů ve srovnání s prahem regulace.
Klikněte na zaškrtávací políčko vedle cíle, abyste jej zahrnuli nebo vyloučili z grafu.
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Výsledků
Karta Results (Výsledky) obsahuje tabulku, která sumarizuje data ze všech grafů. Tabulka 37 definuje
data, která se zobrazí v tabulce Results (Výsledky).

Informace Popis

Target (Cíl) Název cíle (amplifikovaného genu)

Sample (Vzorek) Název vzorku

Mean Cq (Průměr Cq) Průměr kvantifikačního cyklu

Mean Efficiency Corrected Cq
(Průměr korigované účinnosti
Cq)

Průměr kvantifikačního cyklu po úpravě účinnosti reakce

Normalized Expression
(Normalizovaná exprese)

Cílová exprese normalizovaná na referenční cíl (ΔΔCq)

Relative Normalized
Expression (Relativní
normalizovaná exprese)

Normalizovaná exprese ve vztahu ke kontrolnímu vzorku; nazývá
se také Fold Change (Násobek exprese)

Regulation (Regulace) Změna exprese ve vztahu k kontrolnímu vzorku

Compared to Regulation
Threshold (Porovnání s prahem
regulace)

Up nebo downregulace experimentálního vzorku na základě
nastavení prahu

Tabulka 37. Informace na kartě Results (Výsledky)

Poznámka: Data pro replikáty se nacházejí pouze v tabulkách s kartami analýzy dat, ve kterých
byly vybrány rozdělené replikáty Split Out Replicates (Rozdělit replikáty) (tj. Clustergram (Graf
„clustergram“)). Může existovat nesoulad mezi daty exprese genu v tabulkách analýzy genové
exprese, pokud vyberete jako kontrolní vzorek v sloupcovém grafu „none (žádný)“.
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Genová studie
Vytvořte genovou studii pro porovnání dat exprese genu z jednoho nebo několika PCR experimentů v
reálném čase pomocí kalibrátoru mezi cykly s cílem provést normalizaci mezi experimenty. Genovou
studii vytvoříte tak, že do genové studie přidáte data z jednoho nebo několika datových souborů
(koncovka .pcrd). Software je sdruží do jednoho souboru (koncovka .mgxd).

Poznámka: Maximální počet vzorků, které můžete v genové studii analyzovat, je omezen
velikostí RAM paměti a virtuální paměti počítače.

Kalibrace mezi cykly
V každé genové studii se automaticky provádí kalibrace mezi cykly pro každý cíl, aby se normalizovaly
nesrovnalosti mezi cíli testovanými v oddělených cyklech PCR v reálném čase (tj. různé .pcrd soubory
PCR generované různými destičkami).

Aby software rozpoznal vzorek jako kalibrátor mezi cykly, musí sdílet stejný název cíle, název vzorku
a, je-li použit, název biologického souboru napříč všemi porovnávanými destičkami.

Poznámka: V genové studii musí být přítomen alespoň jeden vzorek kalibrátoru mezi cykly pro
provedení kalibrace mezi cykly. Cíle bez vhodných vzorků kalibrátoru mezi cykly budou
zpracovány bez korekce v genové studii (nedoporučeno).

Kalibrátory mezi cykly lze aplikovat dvěma způsoby:

n Na každý cíl – různé PCR primery mohou mít různé účinnosti. Ve výchozím nastavení je
kalibrátor mezi cykly aplikován na všechny jamky na stejné destičce, které mají stejný cílový
název, například Cq vytvořený stejným testem.

n Celá studie – jeden kalibrátor mezi cykly je vybrán uživatelem a aplikován na celou genovou
studii.

Dialogové okno Gene Study (Genová studie)
Dialogové okno Gene Study (Genová studie) obsahuje dvě karty:

n Karta Study Setup (Nastavení studie) – spravuje cykly v genové studii.

Důležité: Přidáním nebo odstraněním datových souborů z genové studie se nemění data v
původním souboru.

n Karta Study Analysis (Analýza studie) – zobrazí data exprese genu pro kombinované cykly.

Karta Study Setup (Nastavení studie)
Tabulka 38 definuje data, která se objeví na kartě Study Setup (Nastavení studie).
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Název sloupce Popis

File Name (Název souboru) Název spouštěcího datového souboru (koncovka .pcrd)

File Folder (Složka souboru) Adresář, ve kterém je uložen datový soubor pro každý cyklus genové
studie

Date Created (Datum
vytvoření)

Datum shromáždění dat cyklu

Well Group Name (Název
skupiny jamek)

Název skupiny jamek vybrané při přidání souboru do genové studie

Tip: Pro analýzu jedné skupiny jamek v genové studii musíte
vybrat příslušnou skupinu jamek v okně Data Analysis (Analýza
dat) ještě před importem datového souboru do genové studie.

Step (Krok) Krok protokolu, jenž zahrnuje čtení destičky s cílem shromáždit data
PCR v reálném čase

Run Type (Typ cyklu) Cyklus definovaný uživatelem nebo PrimePCR

Protocol Edited (Editovaný
protokol)

Je-li zvolena tato možnost, znamená to, že protokol použitý pro cyklus
PrimePCR byl upraven

View Plate (Zobrazit
destičku)

Otevře mapu destiček s destičkou s daty v každém cyklu zařazeném
do genové studie

Tabulka 38. Karta Study Setup (Nastavení studie) v dialogovém okně Gene Study (Genová
studie)

Příprava genové studie
Jak připravit genovou studii

1. Před importem dat do genové studie postupujte v okně Data Analysis (Analýza dat) následovně:

n Ujistěte se, že vzorky se stejným obsahemmají stejný název. V genové studii software
předpokládá, že jamky se stejným názvem cíle nebo vzorku obsahují stejné vzorky.

n Upravte základní linii a práh (Cq) na kartě Quantification (Kvantifikace) pro optimalizaci dat v
každém cyklu.

n Vyberte skupinu jamek, kterou chcete zařadit do genové studie.

Aby bylo možné v genové studii zobrazit data z jedné skupiny jamek, musí být tato skupina
vybrána před importem datového souboru.

Karta Study Setup (Nastavení studie) obsahuje seznam všech cyklů v genové studii.

2. V dialogovém okně Gene Study (Genová studie) vyberte kartu Study Setup (Nastavení studie).
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3. Klikněte na položku Add Data Files (Přidat datové soubory) pro výběr souboru z okna prohlížeče.

Tip: Pro rychlé přidání cyklů do genové studie přetáhněte datové soubory (koncovka .pcrd)
do dialogového okna Study Setup (Nastavení studie).

4. Software CFX Manager Dx automaticky provádí analýzu genové studie v průběhu přidávání
datových souborů. Vyberte kartu Study Analysis (Analýza studie) pro zobrazení výsledků.

Jak odstranit cykly z genové studie

u Vyberte v seznamu jeden nebo více souborů a klikněte na položku Remove (Odstranit).

Jak přidat poznámky do genové studie

u Zadejte poznámky k souborům a analýze do textového rámečku Notes (Poznámky).

Karta Study Analysis (Analýza studie)
Karta Study Analysis (Analýza studie) obsahuje data ze všech cyklů genové studie. Možnosti analýzy
dat exprese genu jsou stejné jako možnosti pro jeden datový soubor, s následující výjimkou:

n V případě sloupcových grafů se po kliknutí na možnost Inter-run Calibration (Kalibrace mezi
cykly) objeví hodnoty kalibrace mezi cykly (jsou-li vypočítány).

Poznámka: Jako kalibrátor mezi cykly lze použít pouze následující typy vzorků:

o Neznámý

o Standardní

o Pozitivní kontrola

Jako kalibrátor mezi cykly nelze použít tyto typy vzorků: negativní kontrola, kontrola bez templátu
(NTC) a kontrola bez reverzní transkriptázy (NRT).
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Vytvoření hlášení o genové studii
Jak vytvořit hlášení o genové studii

1. Před tvorbou hlášení upravte podle potřeby data a grafy hlášení o genové studii.

2. Otevřete dialogové okno Report (Hlášení) zvolením položek Tools > Reports (Nástroje > Hlášení)
v nabídce Gene Study (Genová studie).

3. Vyberte možnosti, které chcete do hlášení zahrnout. Hlášení se otevře s vybranými výchozími
možnostmi. Vyberte nebo odznačte zaškrtávací políčka pro změnu celých kategorií nebo
jednotlivých možností v kategorii.

Kategorie hlášení o genové studii na straně 249 obsahuje seznam dostupných možností zobrazení.

4. Změňte pořadí kategorií a položek v hlášení. Přetáhněte možnosti do požadované pozice.
Položky lze přeuspořádat pouze v rámci kategorií, do kterých patří.

5. Klikněte na položku Update Report (Aktualizovat hlášení) pro aktualizaci Report Preview (Náhled
hlášení) se zohledněním všech změn.

6. Hlášení vytiskněte nebo uložte. Pro tisk aktuálního hlášení klikněte na tlačítko Print Report (Tisk
hlášení) na panelu nástrojů. Vyberte položky File > Save (Soubor > Uložit) pro uložení hlášení
jako PDF (Adobe Acrobat Reader file) (PDF (soubor Adobe Acrobat Reader)) a vyberte umístění,
do kterého se soubor uloží. Uložte hlášení s novým názvem nebo do nového umístění zvolením
položek File > Save As (Soubor > Uložit jako).

7. (Volitelné) Vytvořte šablonu hlášení s požadovanými informacemi. Pro uložení aktuálního
nastavení hlášení v šabloně vyberte Template > Save (Šablona > Uložit) nebo Save As (Uložit
jako). Když pak chcete vytvořit nové hlášení, načtěte šablonu hlášení.
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Kategorie hlášení o genové studii
Dialogové okno Gene Study Report (Hlášení o genové studii) slouží k uspořádání údajů o genové
studii do sestavy. Tabulka 39 obsahuje všechny dostupné možnosti pro hlášení z genové studie.

Kategorie Možnost Popis

Záhlaví

Titul, podtitul a logo pro hlášení

Report Information (Informace o
hlášení)

Datum, jméno uživatele, název datového
souboru, cesta k datovému souboru a
vybraná skupina jamek

Gene Study File List (Seznam
souborů genové studie)

Seznam všech datových souborů v genové
studii.

Notes (Poznámky) Poznámky k datovému hlášení

Study Analysis: Bar Chart (Analýza studie: Sloupcový graf)

Analysis Settings (Nastavení
analýzy)

Seznam vybraných parametrů analýzy

Chart (Graf) Sloupcový graf exprese genu zobrazující data

Target Names (Názvy cílů) Seznam cílů v genové studii.

Sample Names (Názvy vzorků) Seznam vzorků v genové studii.

Data Tabulka, která zobrazuje data

Target Stability (Cílová stabilita) Data o cílové stabilitě

Inter-run Calibration (Kalibrace
mezi cykly)

Data z kalibrace mezi cykly

Study Analysis: Clustergram and Scatter Plot(Analýza studie: Clustergram, rozptylový
graf, vulkánový graf, clustergram a rozptylový graf teplotní mapy)

Analysis Settings (Nastavení
analýzy)

Nastavení pro každý typ grafu

Chart (Graf) Graf exprese genu zobrazující data

Data Tabulka se seznamem dat pro každý cíl

Tabulka 39. Kategorie hlášení pro genovou studii
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Příloha A Výpočty pro analýzu dat
CFXManager Dx automaticky vypočítá vzorce a zobrazí výsledky na kartách Data Analysis (Analýza
dat). Příloha podrobně vysvětluje, jak software CFX Manager Dx vzorce počítá.

Účinnost reakce
Důkazy prokazují, že použití přesného měřítka účinnosti pro každou sadu primeru a sondy vám dá při
analýze dat exprese genu přesnější výsledky. Výchozí hodnota účinnosti použitá ve výpočtech
exprese genu je 100 %. Pro hodnocení účinnosti reakce vygenerujte standardní křivku pomocí série
ředění reprezentativního vzorku napříč příslušným dynamickým rozsahem a poté zaznamenejte
účinnost pro následnou analýzu exprese genu. Jestliže váš cyklus zahrnuje standardní křivku, pak
software automaticky vypočítá účinnost a zobrazí ji pod možností Standard Curve (Standardní křivka)
na kartě Quantification (Kvantifikace), když je zaškrtnuta možnost Auto Efficiency (Automatická
účinnost) na kartě Targets (Cíle) v okně Experiment Settings (Nastavení experimentu).

Účinnost (E) ve vzorcích účinnosti odkazuje na „účinnost“ popsanou Pfafflem (2001) a
Vandesompelem a kol. (2002). V těchto publikacích odpovídá hodnota účinnosti 2 (dokonalé zdvojení
při každém cyklu) v tomto softwaru 100% účinnosti. Máte možnost přeměnit své výpočty účinnosti na
výpočty použité softwarem, a to na základě následujících matematických vztahů:

n E = (% účinnosti * 0,01) + 1

n % účinnosti = (E – 1) * 100

Relativní množství
Vzorec pro relativní množství (ΔCq) pro každý vzorek (GOI) je:

Poznámka: Tento vzorec se používá pro výpočet relativního množství, pokud není definován
žádný kontrolní vzorek.
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Kde:

n E = účinnost sady primeru a sondy. Účinnost se vypočítá podle vzorce
(% účinnost * 0,01) + 1, kde 100% účinnost = 2

n C q (min) = průměr Cq pro vzorek s nejnižší průměrnou hodnotou Cq pro GOI

n C q (vzorek) = průměr Cq pro vzorek

n GOI = zájmový gen (jeden cíl)

Relativní množství při výběru kontroly
Je-li přiřazen kontrolní vzorek, vypočítá se relativní množství (RQ) pro libovolný vzorek se zájmovým
genem (GOI) tímto vzorcem:

Kde:

n E = účinnost sady primeru a sondy. Účinnost se vypočítá podle vzorce
(% účinnost * 0,01) + 1, kde 100% účinnost = 2

n Cq (kontrola) = průměr Cq pro kontrolní vzorek

n Cq (vzorek) = průměr Cq pro všechny vzorky s GOI

n GOI = zájmový gen (jeden cíl)

Směrodatná odchylka relativního množství
Výpočet směrodatné odchylky relativního množství je

Kde:

n SD relativního množství = směrodatná odchylka relativního množství

n SD CqGOI vzorek = směrodatná odchylka Cq pro vzorek(GOI)

n Relativní množství = relativní množství vzorku

n E = účinnost sady primeru a sondy. Účinnost se vypočítá podle vzorce
(% účinnost * 0,01) + 1, kde 100% účinnost = 2

n GOI = zájmový gen (jeden cíl)
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Korigovaná účinnost Cq (CqE)
Vzorec pro korigovanou účinnost Cq je

Kde:

n E = účinnost

Průměrná korigovaná účinnost Cq (MCqE)
Vzorec pro průměrnou korigovanou účinnost Cq je

Kde:

n CqE = korigovaná účinnost Cq

n n = počet replikátů

Faktor normalizace
Jmenovatel rovnice normalizované exprese je definován jako normalizační faktor. Faktor normalizace
je geometrický průměr relativních množství všech referenčních cílů (genů) pro daný vzorek, jak je
popsáno v tomto vzorci:

Kde:

n RQ = relativní množství

n n = počet referenčních cílů

n GOI = zájmový gen (jeden cíl)
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Normalizovaná exprese
Normalizovaná exprese (ΔΔCq) je relativní množství vašeho cíle (genu) normalizovaného na množství
referenčních cílů (genů nebo sekvencí) ve vašem biologickém systému. Chcete-li vybrat referenční
cíle, otevřete okno Experiment Settings (Nastavení experimentu) a klikněte na referenční sloupec pro
každý cíl, který slouží jako referenční gen.

Vzorec pro normalizovanou expresi, který používá výpočet relativního množství (RQ), je

Kde:

n RQ = relativní množství vzorku

n Ref = referenční cíl v cyklu, který obsahuje jeden nebo více referenčních cílů v každém vzorku

n GOI = zájmový gen (jeden cíl)

Za předpokladu, že referenční cíle v biologickém systému nemění hladinu exprese, bude výpočet
normalizované exprese zohledňovat rozdíly v zátěži nebo změny počtu buněk, které jsou
reprezentovány v každém vzorku.

Normalizovaná exprese při výběru kontroly
Když vyberete kontrolní vzorek v okně Experiment Settings (Nastavení experimentu), software
nastaví úroveň exprese kontrolního vzorku na 1. V tomto případě software normalizuje relativní
množství veškeré exprese cíle (genu) podle množství kontroly (hodnota 1). Pokud je zvolena kontrola,
odpovídá tato normalizovaná exprese analýze normalizované exprese bez úpravy měřítka.

Poznámka: Tomu se také říká relativní normalizovaná exprese (RNE) nebo násobek exprese.
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Směrodatná odchylka pro normalizovanou expresi
Úprava rozsahu hodnoty normalizované exprese se provádí tak, že se směrodatná odchylka
normalizované exprese vydělí hodnotou normalizované exprese pro nejvyšší nebo nejnižší úroveň
exprese podle toho, kterou možnost úpravy rozsahu si zvolíte. Vzorec pro směrodatnou odchylku (SD)
normalizačního faktoru je

Kde:

n RQ = relativní množství vzorku

n SD = směrodatná odchylka

n NF = faktor normalizace

n Ref = referenční cíl

n n = počet referenčních cílů

Když je přiřazen kontrolní vzorek, nemusíte tuto funkci úpravy rozsahu směrodatné odchylky
provádět, jak je znázorněno v následujícím vzorci:

Kde:

n NE = normalizovaná exprese

n RQ = relativní množství vzorku

n SD = směrodatná odchylka

n GOI = zájmový gen (jeden cíl)
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Normalizovaná exprese upravená podle nejvyšší úroveň
exprese

Když cyklus nezahrnuje kontroly, stanovte rozsah normalizované exprese (NE) pro každý cíl (gen) tak,
že vydělíte úroveň exprese každého vzorku nejvyšší úrovní exprese ve všech vzorcích. Software
stanoví nejvyšší úroveň exprese na hodnotu 1 a upraví rozsah všech úrovní exprese vzorku. Vzorec
pro nejvyšší rozsah je

Kde:

n GOI = zájmový gen (cíl)

Normalizovaná exprese upravená podle nejnižší úrovně
exprese

Když cyklus nezahrnuje kontroly, stanovte rozsah normalizované exprese (NE) pro každý cíl (gen) tak,
že vydělíte úroveň exprese každého vzorku nejnižší úrovní exprese ve všech vzorcích. Software
stanoví nejnižší úroveň exprese na hodnotu 1 a upraví rozsah všech úrovní exprese vzorku. Vzorec
pro nejnižší rozsah je

Kde:

n GOI = zájmový gen (cíl)
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Normalizovaná exprese upravená podle průměrné úrovně
exprese

Když cyklus nezahrnuje kontroly, stanovte rozsah normalizované exprese (NE) pro každý cíl (gen) tak,
že vydělíte úroveň exprese každého vzorku geometrickým průměrem úrovní exprese ve všech
vzorcích. Software stanoví průměrnou úroveň exprese na hodnotu 1 a upraví rozsah všech úrovní
exprese vzorku. Vzorec pro průměrný rozsah je

Kde:

n GOI = zájmový gen (cíl)

n GM = geometrický průměr normalizované exprese všech vzorků

Směrodatná odchylka pro normalizovanou expresi s
upraveným rozsahem

Opětovná úprava měřítka hodnoty normalizované exprese (NE), jejíž měřítko již bylo upraveno, se
provádí tak, že se směrodatná odchylka (SD) normalizované exprese vydělí hodnotou normalizované
exprese pro nejvyšší (MAX) nebo nejnižší (MIN) úroveň exprese, podle toho, kterou možnost úpravy
měřítka si zvolíte.

Poznámka: Když je přiřazen kontrolní vzorek, nemusíte tuto funkci opětovné úpravy měřítka
podle směrodatné odchylky provádět.

Výpočet podle tohoto vzorce je

Kde:

n NE = normalizovaná exprese

n SD = směrodatná odchylka

n GOI = zájmový gen (cíl)

n MAX = nejvyšší úroveň exprese

n MIN = nejnižší úroveň exprese
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Regulace
Regulace je měřítkem zvýšení nebo snížení exprese cíle pro experimentální vs. kontrolní vzorek a
stanoví se následovně:

Pokud platí, že exprese (experimentální) > exprese (kontrolní):

Pokud platí, že exprese (experimentální) < exprese (kontrolní):

Poznámka: Pro sloupcový graf vychází exprese buď z relativního množství, nebo z
normalizované exprese v závislosti na vybraném režimu (viz Sloupcový graf na straně 228). Pro
rozptylový graf a graf „clustergram“ se regulace vždy vypočítá z normalizované exprese.
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Vzorce pro korigované hodnoty

Vzorce pro korigované hodnoty
Rozdíl mezi korigovanými a nekorigovanými hodnotami je vidět pouze tehdy, pokud je v rámci cyklu
PCR v reálném čase vytvořena standardní křivka. Software používá k určení šíření chyb tři rovnice:

n Standardní chyba

n Standardní chyba normalizované exprese

n Standardní chyba pro normalizovaný sledovaný gen (cíl)

Vzorec pro standardní chybu je

Kde:

n n = počet referenčních cílů (genů)

n SD = směrodatná odchylka

Standardní chyba pro faktor normalizace ve vzorci normalizované exprese je

Kde:

n n = počet referenčních cílů

n SE = standardní chyba

n NF = faktor normalizace

n RQ = relativní množství

Standardní chyba pro vzorec normalizovaného sledovaného genu (GOI) je

Kde:

n SE = standardní chyba

n GOI = zájmový gen (jeden cíl)

n NF = faktor normalizace

n n = počet referenčních cílů
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Příloha B Správa uživatelů a rolí CFX Manager
Dx

V softwaru CFX Manager Dx můžete vytvářet uživatele a přiřazovat jim role. Role omezují přístup k
funkcím softwaru CFX Manager Dx. Uživateli lze přiřadit vždy jen jednu roli. Správce softwaru CFX
Manager Dx ale může roli uživatele kdykoliv změnit.

Tip: Pro použití softwaru CFX Manager Dx není nutné vytvářet uživatele. Pokud uživatele
nevytvoříte, budou veškeré činnosti vykonávány přes výchozí uživatelský účet admin.

Důležité: Uživatel admin je výchozí účet správce, přes který se zpočátku přihlašujete do softwaru
CFX Manager Dx. Doporučujeme vám pro správu softwaru CFX Manager Dx vytvořit
samostatného uživatele. Tomuto uživateli přiřaďte roli správce a provádějte přes něj všechny
správcovské úkony.

Důležité: Software CFX Manager Dx nemá funkci přerušení relace uživatele v případě neaktivity.
Proto vám doporučujeme, abyste provedli zabezpečovací opatření, která vám nabízí systém
Windows, nebo řešení třetích stran (například použijte spořič obrazovky s požadovaným
přihlášením).

Správa uživatelů
Ve standardním vydání softwaru Software CFX Manager Dx mohou mít uživatelské účty jakékoli
jméno nebo heslo.

Každému uživateli přiřaďte roli tím, že ji vyberete ze seznamu rolí v okně User Administration (Správa
uživatelů). V tomto příkladu má uživatel Host přidáno právo ukládat soubory.

Přidávání a odstraňování uživatelů
Poznámka: Přidávat a odstraňovat uživatele může pouze správce CFX Manager Dx.
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Jak přidat uživatelský účet do softwaru CFX Manager Dx

1. V okně Home (Domů) vyberte možnost User > User Administration (Uživatel > Správa uživatelů).

Otevře se dialogové okno User Administration (Správa uživatelů).

2. Na panelu Manage Users (Spravovat uživatele) zadejte uživatelské jméno uživatele.

3. V možnosti Role (Role) vyberte roli uživatele.

Role omezují práva uživatele. Výchozí nastavení je Principal (Vedoucí).

Tip: Práva pro každou roli můžete měnit. Změna práv role ovlivní všechny uživatele, kterým
je daná role přiřazena. Více informací naleznete v části Správa práv rolí na straně 263.

4. (Volitelné) Zadejte Full Name (Celé jméno) a Password (Heslo) uživatele.

5. Kliknutím na OK otevřete dialogové okno a potvrdíte, že chcete obecné okno zavřít.

6. Kliknutím na Yes (Ano) dialogové okno i obecné okno zavřete.
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Správa uživatelů

Jak odstranit uživatele

1. V podokně Manage Users (Spravovat uživatele) vyberte možnost Remove (Odstranit) pro
každého uživatele, kterého chcete odstranit.

2. Kliknutím na OK otevřete dialogové okno a potvrdíte, že chcete obecné okno zavřít.

3. Kliknutím na Yes (Ano) dialogové okno i obecné okno zavřete.

Poznámka: Seznam uživatelů softwaru musí vždy obsahovat jednoho správce.

Správa práv rolí
Software CFX Manager Dx obsahuje tyto čtyři role:

n Administrator (Správce – vyžadováno) – správci mají všechna práva a tato práva nemůžete
měnit. Správci mohou také přidávat a odstraňovat uživatele a měnit práva pro každou roli.

Poznámka: Práva pro jednotlivé role mohou měnit právě jen správci.

n Principal (Vedoucí) – ve výchozím nastavení má vedoucí všechna práva

n Operator (Operátor) – ve výchozím nastavení využívá operátor všechna práva kromě
přeskakování cyklů

n Guest (Host) – ve výchozím nastavení může host pouze číst soubory

Důležité: Změna práv pro konkrétní roli má vliv na všechny uživatele, kterým je tato role
přiřazena. Není možné přizpůsobit roli pro konkrétního uživatele. Při změně práv jednotlivých rolí
postupujte opatrně.

Jak stanovit práva pro každou roli

1. V okně Home (Domů) vyberte možnost User > User Administration (Uživatel > Správa uživatelů).

2. V podokně Manage Rights (Spravovat práva) postupujte následovně:

n Chcete-li odstranit právo z role, odznačte příslušné zaškrtávací políčko.

n Chcete-li přidat právo do role, označte příslušné zaškrtávací políčko.

3. Kliknutím na OK otevřete dialogové okno a potvrdíte, že chcete obecné okno zavřít.

4. Kliknutím na Yes (Ano) dialogové okno i obecné okno zavřete.

Jak resetovat všechna práva pro všechny role

u V dialogovém okně User Administration (Správa uživatelů) klikněte na Restore Default Rights
(Obnovit výchozí práva).
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Přihlášení do softwaru CFX Manager Dx
Software CFX Manager Dx spravuje, kdo se přihlásí do softwaru pomocí dialogového okna Login
(Přihlášení). Když spustíte software, CFX Manager Dx automaticky zobrazí dialogové okno Login
(Přihlášení), když jsou v okně User Administration (Správa uživatelů) uvedeni dva nebo více uživatelů.

CFX Manager Dx zobrazuje jméno přihlášeného uživatele v horní části okna Home (Domů).

Přihlášení do CFX Manager Dx

1. V dialogovém okně Login (Přihlášení) vyberte své jméno z rozevíracího seznamu User Name
(Uživatelské jméno).

2. Zadejte své heslo.

3. Klepnutím na tlačítko OK zavřete dialogové okno Login (Přihlášení) a otevřete software.

Změna uživatelů
Můžete změnit uživatele, když je spuštěn software.

Přepínání uživatelů

1. V okně Home (Domů) vyberte možnosti User > Select User (Uživatel > Vybrat uživatele) a
otevřete tak dialogové okno Login (Přihlášení).

2. V rozevíracím seznamu vyberte položku User Name (Uživatelské jméno).

3. Zadejte heslo nového uživatele.

4. Klepnutím na tlačítko OK zavřete dialogové okno Login (Přihlášení) a otevřete software.
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Přihlášení do softwaru CFX Manager Dx

Změna hesla uživatele
Uživatelé CFX Manager Dx mohou kdykoliv své heslo změnit.

Jak změnit heslo uživatele

1. V okně Home (Domů) vyberte možnosti User > Change Password (Uživatel > Změnit heslo).
Otevře se dialogové okno Change Password (Změnit heslo).

2. Do pole Old Password (Staré heslo) zadejte své současné heslo.

3. Do pole New Password (Nové heslo) zadejte nové heslo a zopakujte jej v kolonce Confirm New
Password (Potvrdit nové heslo).

4. Změnu potvrdíte kliknutím na OK.

Zobrazení role a práv uživatele
Tip: Uživatelé, kterým byla přiřazena role Principal (Vedoucí), Operator (Operátor) nebo Guest
(Host), mohou zobrazit pouze své uživatelské předvolby, práva a role.

Zobrazení aktuální role a práv uživatele

u V okně Home (Domů) vyberte možnost User > User Administration (Uživatel > Správa uživatelů).

Chcete-li upravit uživatelská nastavení, práva a role uvedené v okně User Administration (Správa
uživatelů), obraťte se na správce CFX Manager Dx.
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Příloha C Integrace LIMS
Můžete konfigurovat software CFX Manager Dx pro použití se systémem pro správu laboratorních
informací (LIMS). Pro integraci LIMS vyžaduje software CFX Manager Dx informace o nastavení
destičky generované platformou LIMS (a soubor LIMS *.plrn), soubor protokolu vytvořený pomocí
Software CFX Manager Dx (*.prcl), definované umístění exportu dat a definovaný formát exportu.

Po dokončení cyklu vygeneruje CFX Manager Dx soubor dat (.pcrd) a uloží jej do definované složky
pro export dat. CFX Manager Dx může také vytvořit datový soubor kompatibilní s LIMS ve formátu .csv
a uložit jej na stejné místo.

Vytvoření datových souborů kompatibilních s LIMS
Tato příloha vysvětluje, jak nastavit software CFX Manager Dx pro vytvoření, uložení a export
datových souborů kompatibilních s LIMS.

Nastavení možností složky LIMS a exportu dat
Ve výchozím nastavení software CFX Manager Dx uloží protokoly, soubory a soubory exportu dat
LIMS do této složky:
_ C:\Users\Public\Documents\Bio-Rad\CFX_Dx\LIMS

Můžete CFX Manager Dx nakonfigurovat tak, že uloží soubory do jiné složky, a současně můžete
měnit možnosti exportu pro data LIMS.

Jak nastavit možnosti složky LIMS a exportu dat

1. V okně Home (Domů) vyberte položky Tools > Options (Nástroje > Možnosti).

2. V dialogovém okně Options (Možnosti) vyberte položku Data Export Settings (Nastavení exportu
dat).
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3. (Volitelné) Vyberte možnost Automatically export LIMS data at end of run (Automaticky
exportovat data LIMS na konci cyklu).

Software automaticky provede export dat LIMS po každém cyklu a uloží je do stanoveného
umístění.

4. Chcete-li změnit výchozí možnosti exportu dat LIMS, klikněte na položku LIMS Data Export
Settings (Nastavení exportu dat LIMS).

Důležité: Zpět do softwaru CFX Manager Dx lze importovat pouze data LIMS exportovaná
jako soubor .csv.

5. V dialogovém okně LIMS Data Export Format Settings (Nastavení formátu pro export dat LIMS)
vyberte požadované možnosti exportu a klikněte na OK.

6. V dialogovém okně Options (Možnosti) najděte a vyberte výchozí složku, do které chcete uložit
datové soubory LIMS. Pro každý typ souboru můžete vybrat jiné umístění:

n Protokol

n Soubor LIMS

n Export dat

7. Kliknutím na OK uložíte změny a zavřete dialogové okno Options (Možnosti).

Tvorba protokolu LIMS
Chcete-li spustit cyklus LIMS, vytvořte soubor protokolu file CFX Manager Dx (*.prcl) a uložte jej do
určeného umístění složky protokolu LIMS.

Další informace naleznete v Kapitola 6, Vytváření protokolů.
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Vytvoření datových souborů kompatibilních s LIMS

Vytvoření souboru LIMS
Soubor LIMS (*.plrn) obsahuje podrobnosti o nastavení destičky a název souboru protokolu. Soubor je
vygenerován vaším interním LIMS. Software CFX Manager Dx používá soubor LIMS k tvorbě souboru
destičky, který bude použit se souborem protokolu.

Software CFX Manager Dx obsahuje soubory šablony pro import destiček, které můžete upravovat,
abyste vytvořili vlastní soubory destiček LIMS.

Tip: Tento úkol by měl vykonávat specialista na LIMS.

Jak vytvořit soubor LIMS

1. V okně Home (Domů) vyberte položky View > Show > LIMS File Folder (Náhled > Zobrazit >
Složka souboru LIMS).

2. Otevřete složku LIMS Templates (Šablony LIMS) a vyberte soubor .csv pro import do vašeho
interního LIMS.

3. Pomocí LIMS upravte šablonu tak, že vyplníte požadovaná pole uvedená v Tabulka 40.

4. Uložte šablonu se souborovou koncovkou .plrn do složky pro soubory LIMS.

Důležité: Software CFX Manager Dx otevírá pouze soubory .plrn. Abyste mohli provést
cyklus LIMS, musíte soubor .csv uložit jako .plrn.

Sloupec Řádek Popis Obsah Účel

A 1 Záhlaví destičky Neupravovat Předdefinováno

A,B,C 2 Pole/data/pokyn Neupravovat Předdefinováno

B 3 Verze Neupravovat Předdefinováno

Tabulka 40. Definice obsahu LIMS souboru .csv
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Sloupec Řádek Popis Obsah Účel

B 4 Velikost destičky Neupravovat Předdefinováno

B 5 Typ destičky Zadejte „BRWhite“ 
(„BR bílá“), „BR
Clear“ („BR čirá“)
nebo jiný
kalibrovaný typ
destičky

Vyžadováno

B 6 Režim skenování Zadejte „SYBR/FAM
Only:“ („Pouze
SYBR/FAM“), „All
Channels“ 
(„Všechny kanály“)
nebo „FRET“

Vyžadováno

Tabulka 40. Definice obsahu LIMS souboru .csv, pokračování
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Sloupec Řádek Popis Obsah Účel

B 7 Jednotky Zadejte jedno z
následujících: „copy
number“ („číslo
kopie“), „fold
dilution“ („ředění
násobku“),
„micromoles“ 
(„mikromoly“),
„nanomoles“ 
(„nanomoly“),
„picomoles“ 
(„pikomoly“),
„femtomoles“ 
(„femtomoly“),
„attomoles“ 
(„attomoly“),
„milligrams“ 
(„miligramy“),
„micrograms“ 
(„mikrogramy“),
„nanograms“ 
(„nanogramy“),
„picograms“ 
(„pikogramy“),
„femtograms“ 
(„femtogramy“),
„attograms“ 
(„attogramy“) nebo
„percent“ 
(„procenta“)

Vyžadováno

B 8 ID cyklu Zadejte krátký popis
nebo čárový kód s
identifikací tohoto
cyklu (maximálně 30
znaků, čárky nejsou
povoleny)

Volitelné

Tabulka 40. Definice obsahu LIMS souboru .csv, pokračování
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Sloupec Řádek Popis Obsah Účel

B 9 Poznámka k cyklu Zadejte popis cyklu Volitelné

B 10 Protokol cyklu Zadejte přesný
název souboru
protokolu.

Vyžadováno

A 11 Datový soubor Zadejte název
datového souboru

Volitelné

A 12–15 TBD/prázdné Neupravovat Předdefinováno

A 16 Data destičky Neupravovat Předdefinováno

Tabulka 40. Definice obsahu LIMS souboru .csv, pokračování
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Sloupec Řádek Popis Obsah Účel

A 17–113 Pozice jamky Neupravovat Předdefinováno

B–G Barv. kanál1, barv.
kanál2, barv.
kanál3, barv.
kanál4, barv.
kanál5, FRET

Pro každý použitý
kanál zadejte název
jednoho
kalibrovaného
barviva (například
„FAM“)

Vyžadováno

H Typ vzorku Zadejte jeden z
následujících typů
vzorku: „Unknown“ 
(„Neznámý“),
„Standard“ 
(„Standardní“),
„Positive Control“ 
(„Pozitivní kontrola“),
„Negative Control“ 
(„Negativní
kontrola“), „NTC“ 
nebo „NRT“

Vyžadováno

I Název vzorku Zadejte název
vzorku

Volitelné

J–O Cíl kanál1, cíl
kanál2, cíl kanál3,
cíl kanál4, cíl
kanál5, cíl FRET,

Zadejte název cíle
pro každý použitý
kanál

Volitelné

Tabulka 40. Definice obsahu LIMS souboru .csv, pokračování
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Sloupec Řádek Popis Obsah Účel

P Název biologického
souboru

Zadejte název
biologického
souboru

Volitelné

Q Replikace Zadejte kladné celé
číslo pro každý
soubor replikace.
Hodnota nesmí být
nulová.

Volitelné

R–W Množství kanál1,
množství kanál2,
množství kanál3,
množství kanál4,
množství kanál5,
množství FRET

Zadejte hodnoty
množství pro každý
standard. Zadejte
koncentraci v
decimální podobě.

Vyžadováno pro
všechny standardy

X Poznámka k jamce Zadejte poznámku k
jamce (maximálně
20 znaků)

Volitelné

Y–AD Barva jamky kanál1,
barva jamky kanál2,
barva jamky kanál3,
barva jamky kanál4,
barva jamky kanál5,
barva jamky FRET

Zadejte uživatelem
definovanou barvu
stylu trasování v
decimálním formátu
32bitového celého
čísla (argb)

Volitelné

Tabulka 40. Definice obsahu LIMS souboru .csv, pokračování
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Spuštění cyklu LIMS
Spuštění cyklu LIMS

1. Chcete-li otevřít soubor LIMS .plrn, postupujte následovně:

n V okně Home (Domů) vyberte položky View > Show > LIMS File Folder (Náhled > Zobrazit >
Složka souboru LIMS) a otevřete cílový soubor .plrn.

n V okně Home (Domů) vyberte položky File > Open > LIMS File (Soubor > Otevřít > Soubor
LIMS) a otevřete cílový soubor .plrn.

Soubor se otevře na kartě Start Run (Spustit cyklus) v průvodci Run Setup (Nastavení cyklu). Na
kartě Start Run (Spustit cyklus) se zobrazují informace o experimentu, který se má spustit.
Zobrazuje také připojený blok nebo bloky přístroje, na kterých můžete experiment spustit.

2. Na kartě Start Run (Spustit cyklus) vyberte přístroj a klepněte na položku Start Run (Spustit
cyklus).
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Export dat do LIMS
Po ukončení cyklu software CFX Manager Dx vygeneruje datový soubor (.pcrd) a uloží jej do
definované složky pro export dat.

Jak exportovat datový soubor do LIMS

u Otevřete soubor .pcrd a vyberte Export > Export to LIMS Folder (Exportovat > Export do složky
LIMS).

Tip: Pokud v okně LIMS Options (Možnosti LIMS) vyberete možnost Automatically Export Data
after Run (Automaticky exportovat data po cyklu), vytvoří software CFX Manager Dx datový
soubor kompatibilní s LIMS ve formátu .csv a uloží jej do stejné složky.
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Příloha D Poradce při potížích s připojením k
softwaru CFX Manager Dx

Protokol aplikací
Před spuštěním nového cyklu zahájí systémy CFX96 a CFX96 DeepWell vlastní diagnostický test,
aby se ověřilo, zda pracují v rámci specifikací. Software zaznamenává výsledky tohoto testu do
souboru Run Log (Protokol o cyklu) a Application Log (Protokol aplikací). Pokud zaznamenáte
problém pro jeden nebo více experimentů, otevřete protokoly cyklu a aplikací, abyste zjistili, kdy
problém začal.

Software CFX Manager Dx sleduje informace o stavu přístroje během cyklu v protokolu aplikací. Tyto
protokoly použijte ke sledování událostí, které se vyskytují na přístrojích a v softwaru a při řešení
problémů.

Otevření protokolu aplikací

u V okně Home (Domů) vyberte View > Application Log (Zobrazit > Protokol aplikací).
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Poradce při potížích
Problémy s komunikací softwaru a přístrojů lze obvykle vyřešit restartováním počítače a systému.
Před restartováním nezapomeňte uložit všechny probíhající práce.

Poznámka: Ověřte, zda má počítač dostatek paměti RAM a volné místo na disku. Minimální
velikost paměti RAM je 4 GB a minimální místo na pevném disku je 128 GB.

Výpadek napájení
Při výpadku napájení se přístroj a počítač vypnou. Pokud je výpadek napájení krátký, přístroj obnoví
provoz protokolu, ale protokol aplikací zaznamená výpadek napájení. V závislosti na nastavení
počítače a době, kdy je napájení přerušeno, se přístroj a software pokusí pokračovat v provozu v
závislosti na kroku protokolu:

n Pokud je protokol v kroku bez čtení destičky, protokol pokračuje v provozu, jakmile se znovu
obnoví napájení přístroje.

n Pokud je protokol v kroku s načtením destičky, přístroj čeká, až software restartuje a obnoví
komunikaci, aby shromáždil data. V této situaci protokol pokračuje pouze v případě, že počítač
není vypnut. Při opětovném spuštění počítače a softwaru protokol pokračuje.

Vyjmutí vzorků z reakčního modulu během výpadku napájení

Uzamčené motorizované víko můžete otevřít v reakčním modulu, abyste odebrali vzorky během
výpadku napájení.

Vyjmutí uzamčené destičky

1. Zatlačte na aretační lištu, abyste odstranili reakční modul z termocykleru C1000 Dx.

2. Opatrně postavte reakční modul na stůl nebo laboratorní stůl.
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3. Umístěte modul tak, aby přední část modulu přesahovala 5 centimetrů (2 palce) nad okraj.

4. Imbusovým klíčem odstraňte dva velké šrouby pod přední hranou reakčního modulu (pod
tlačítkem pro otevření víka).

Měli byste slyšet uvolnění zajišťovací západky z modulu.

Důležité: Neodstraňujte dva malé šrouby na předním hraně modulu.

5. Otevřete víko reakčního modulu. Všimněte si, že západka (tmavý plast) již není připojena.
Vyjměte vzorky z bloku.
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6. Vraťte zpět zajišťovací západku a zajistěte ji velkými šrouby a znovu sestavte reakční modul s
otevřeným víkem.

Načtení souborů do počítače se softwarem CFX Manager Dx
Můžete najít data a soubory protokolů umístěné v přístroji a přenést je na pevný disk připojeného
počítače.

Poznámka: Všechny soubory ve složce s daty shromážděnými v reálném čase v základně
přístroje se načtou do počítače.

Jak načíst soubory z přístroje

1. V podokně Detected Instruments (Detekované nástroje) v okně Home (Domů) klikněte pravým
tlačítkemmyši na cílový přístroj a vyberte jednu z následujících možností:

n Retrieve Log Files (Načíst soubory protokolů)

n Retrieve Data Files (Načíst datové soubory)

2. Vyberte umístění složky pro uložení načtených souborů.

3. Klikněte na OK.

Manuální instalace softwaru CFX Manager Dx
Jak manuálně nainstalovat software Software CFX Manager Dx

1. V případě potřeby odpojte od počítače všechny připojené přístroje.

Najděte a odpojte USB kabel přístroje z počítače se softwarem CFXManager Dx. Konec
zapojený do přístroje můžete ponechat na místě.

2. Přihlaste se k počítači se softwarem CFXManager Dx s oprávněními administrátora.

3. Vložte CD se softwarem.
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4. V Průzkumníkovi Windows přejděte na CD, klikněte pravým tlačítkemmyši na ikonu CD se
softwarem a vyberte položku Explore (Prozkoumat). Otevře se okno s CD.

5. Dvakrát klikněte na složku CFX_Manager, aby se otevřela, a následně dvakrát klikněte na soubor
setup.exe pro spuštění průvodce instalací softwaru.

6. Postupujte podle pokynů průvodce, nainstalujte software a klikněte na Finish (Dokončit).

Přeinstalování ovladačů
Přeinstalování ovladačů přístroje

u Pro přeinstalování ovladačů vyberte v položky Tools > Reinstall Instrument Drivers (Nástroje >
Znovu instalovat ovladače přístroje).

Poznámka: Pokud máte po přeinstalování ovladačů a kontrole připojení USB problémy se
softwarem komunikujícím se systémem v reálném čase, obraťte se na technickou podporu
společnosti Bio-Rad.
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Informace o autorských právech Minpack (1999), University of Chicago. Veškerá práva
vyhrazena

Další distribuce a použití ve zdrojové a binární podobě, s úpravami nebo bez úprav, jsou povoleny za
předpokladu, že jsou splněny následující podmínky:

1. Součástí dále distribuovaného zdrojového kódu musí být výše uvedené informace o autorských
právech, tento seznam podmínek a následující upozornění.

2. Součástí dále distribuované binární formy musí být výše uvedené informace o autorských
právech, tento seznam podmínek a následující upozornění v dokumentaci a/nebo jiných
materiálech poskytovaných současně s distribucí.

3. Dokumentace pro koncového uživatele, která součástí případné distribuce, musí obsahovat
následující informaci:

„Tento produkt obsahuje software vyvinutý University of Chicago, provozovatelem národní laboratoře
v Argonne.“
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